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Foreword 

Hi.  A few words before you start reading the User Guide will explain the framework that is 
Enigma 

Enigma is not like other application development tools.  The inputs are the results of 
Analysis and Design.  There is very little programming involved.  Instead Enigma software 
use these to construct the programs that become your application. 

Construction of an application using Enigma is very different to the construction you may 
expect.  Enigma programs are constructed as “black boxes”.  Each program has one 
purpose.  Each program will take inputs and produce outputs and in the main these should 
be accepted as what that particular program does.  If a similar set of inputs should produce 
some different outputs then Enigma expects a different program; a different “black box”. 

Enigma takes a simplistic view of the application you will create.  The Analysis has to break 
down the user requirement so that it can be defined in terms understood by Enigma.  
Usually this follows the way the user sees the requirement.  Analyse without thought as to 
how the technical parts of the application will be done.  They are a different problem which 
Enigma will solve with a bit of help from you. 

Enigma is designed for use in an Internet (or Internet like) environment.  In that 
environment it is desirable to keep the communication between the Client and the Server 
short, and to the point.  The Client/Server relationship exists within one program at a time; 
so small, and to the point, programs are desirable. This is one reason why programs are 
“black boxes” and are repeated as required.  This approach keeps the programs simple and 
incurs no cost since one, or another, will be loaded into the client.  Even if the programs are 
nearly identical; the cost of using each one does not vary. 

The one to one relationship used by the Internet between Client and Server is carried 
forward in Enigma to the relationship between the Net System and the Core System.  The 
Net System contains all the Client/Server programs.  The Core System contains the 
Technical requirement for use by the whole Net System.  When a Net System program 
wants technical assistance, the Core System is called, provides what is necessary, and then 
ceases to operate. 

Creating the Core System revolves around a correct database design.  Strict normalisation is 
required to allow Enigma to generate the database maintenance and interrogation required 
by a Net program.  The requirement is defined within the Information (Transactions) that 
move between the Net System and the Core System.  Core System generation takes the 
Information and the database design, and then melds the two to satisfy the Net program’s 
request. 

Enigma is different.  The User Guide explains the mechanics of using Enigma.  This foreword 
has outlined the environment in which the mechanics operate and a more detailed 
description is included at the end of the User Guide. 

Parametric Systems trusts that you will enjoy this view of a different application 
development world, as much as it has been enjoyable creating it for you. 

Regards, 
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Foreword to Enigma-2020 

The Enigma-2020 upgrade is a major revision of the ENIGMA application. 

None of the original Enigma facilities have been removed and most are accessible from the 
new interface screen.  Those that are not, are available by accessing the original menu. 

The main change made in Enigma-2020 is the hierarchy of application definition.   

The original Enigma creates an Application and then defines the detail in a “bottom up” 
approach. Thus the Data was defined before placing it into Transactions which  were the 
assembled into Programs.   

Enigma-2020 creates an application and then defines the detail in a “top down” approach.  
Thus the Programs are defined and then the Actions needed are specified and the Data 
required for each Action is selected or defined. 

Actions have been introduced as a new concept.  Actions incorporate the original 
Transactions but have selections that better describe the consequence of using the Action.  
Thus there is a “Logic” action which applies a Business Rule and incorporates the original 
Enigma “Load” transaction. 

Some of the original Enigma screens have had Actions incorporated into the display and /or 
input fields.  This manual has not been updated to show the changed screens.  They do not 
affect the notes explaining the function.   

Another major change is that Business Rules have been automated.  The Rule is defined in 
one Program using a “Rules” action while the use of the Rule is specified by the “Logic” 
action already mentioned. 

Also added to the main Enigma-2020 interface is a help facility.  Double click on any field, or 
control, and on some headings, to get a description to assist you. 

All ENIGMA applications, programs, actions and data are specified using the main Enigma-
2020 interface.  This is done using many assumptions.  Only the major requirements are 
entered into this interface.  There is a “ribbon” style menu across the top which allows 
access to original Enigma facilities where these assumptions can be altered to suit your 
requirements. 

This User Guide has been upgraded to include details on the new interface and to include 
the access paths from the “ribbon” menu. 

 

Regards, 
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Part One – ENIGMA 

INTRODUCTION 
 

This manual covers the Definition of an Application1 using Enigma.  It also includes notes on 
the Enigma-2020 upgrade. 

It is split into several Parts: 

• This Part covers a general introduction to Enigma and the processes that  must be 
done to create an Application 

• Parts Two and Seven cover the operation of Enigma.  Part Two is basic and 
introduces the Quick Start Guide and Part Seven has more depth since the manual is 
almost complete 

• Part Three is the Quick Start Guide which gives you enough information to produce a 
simple Application 

• Part Three A contains notes on the new Enigma-2020 screen formats and data entry 
requirements 

• Part Four covers the operation of a Program within an Application and provides 
details on replication 

• Part Five introduces the Complex Enigma facilities: List, Tables, Logic, etc. 
• Part Six covers Custom Code; the way of adding more to the Application than 

Enigma can currently generate 
• Part Eight covers the reports that can be run to monitor and check the Enigma 

generation of Database queries and the Application structure. 

Later versions of the manual may reorganise these Parts and/or expand them. 

There is also a set of Appendices.  These explain what Enigma generates when certain 
actions are taken while defining an Application.  These have been placed in Appendices so 
that the explanation does not intrude on the instruction being given in Parts One to Seven. 

• Appendix 1 gives more detail on the values that can be changed in Enigma within the 
Add Application or Modify Application 

• Appendix 2 details the result of Adding a new Application and explains the content 
and function placed into the New Application folders 

• Appendix 3 covers the other standard programs that are generated as a result of 
Data Definition 

• Appendices 4 and 5 reproduce two large tables covering Data and Transactions.  
They are included so that they may be printed easily for reference. 

• Appendix 6 contains samples of the reports covered in Part Eight 
• Appendix 7 details how to create a Desktop Shortcut for your Application 
• Appendix 8 explains the ranking of List records 
• Appendix 9 provides more details on Business Rules application in Enigma-2020 
• Appendix 10 discusses in more detail the interconnection of the Net System, the Core 

System and the Core database 

Within this should be all the information you need to use Enigma.  However before you 
begin you should get a clear idea of how the New Application will be structured and how it 
will be created.  The diagram illustrates the structure and the overview covers the creation. 

 
1 Application is used to denote a Web Browser application that can be accessed via a URL if deployed 
into the Web environment.  The Application can also be run locally from the desktop using the 

“Localhost” facilities. 



Version: 1.6 P a g e  | 15  Released: 19th April 2020 

A Superscript “#” indicates that there is a cross-reference following. 

Words contained within braces “{}” and in Italic form should be replaced by the value 
appropriate to your New Application. 

 

OVERVIEW 
Defining a New Application requires several steps to be taken in sequence.  The information 
provided by each step is used in successive steps to control the development of the New 
Application.  It is not always obvious how this information is used later in the sequence.  
This overview tries to clarify the relationship, and information transfer, between the steps. 

Original Enigma Hierarchy 
• Application Definition – This sets up the basic structure of the New Application in its 

own Folder within the development environment.  Included are – 
o .vbhtml pre-requisite libraries and code, 
o Database creation – including pre-requisite Database Tables for Screens, 

Menus and Internal Security control, 
o Basic Menu entries for the New Application, 
o Basic Authorisation Levels (Security levels) for the New Application, 
o Screen Formatting (CSS) controls for the New Application, 
o Basic Images for screen displays for the New Application, 
o Common Code generation for use throughout the New Application; 

 
• Data Definition – which is the basic requirement used to detail the Information held 

by the New Application.  Also created are the Database Tables and Maintenance 
Programs in the New Application for any Data that is defined as being selected from 
a list of alternatives (Selection Lists) or chosen from an Option Group; 
 

• Transaction Definition – Aggregates Data into Information (i.e. related groups) and 
defines the direction in which the Information will flow; 
 

• Program Definition –  
o Aggregates the relevant Transactions into a defined sequence for a Program,  
o Defines the default Type for the program,  
o Allows constant value information to be defined, 
o Allows definition of SQL Predicates and Values to control record selection; 
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Enigma-2020 Hierarchy 
• Application definition (see above); 
• Program Definition (see above except that the Transaction aggregation is done when 

the Actions are defined); 
• Action Definitions which create the required Transactions to perform  the Action; 

• Data Definition (see above); 

Common Hierarchy 
The following are common to both original and 2020 Enigma.  Access when using Enigma-
2020 is from the “ribbon” menu. 

• Screen Definition – Creates the User Interface for each Program using the sequence 
of Transaction Definitions to –  

o locate Data for Display, or Input/Change,  from each Transaction/Data 
definition, 

o add Text to explain the screen requirements, notes, etc., 
o add Control Buttons to signify required actions to be taken, 
o define the content of a Form (the Data and Control values) that will be 

passed to the Server for processing, 
o the Size and default Location of the Screen when it is displayed; 

 
• Net Code Generation – Which uses the – 

o Data Definitions, 
o Transaction Definitions, and  
o Screen Definition 

to Create the Specific Code required for a Net Program; 
 

• Code Review – which allows the Generated Code to have any Custom Code added to 
the Specific Code; 
 

• Program Creation – which  
o amalgamates the Generated and Custom Code with the Common Code (that 

is used in all Programs) and adds the Program to the New Application, 
o allows the Creation of the necessary Menu entries in the New Application 

Database to access the Program from the New Application Menu (if 
applicable), 

o adds the Screen controls to the New Application Database; 
 

• Database Definition – which allows the Core System Database Tables to be 
documented in Enigma; 
 

• Database Creation – which uses the Database Definition to construct the Schemas 
for the Database and executes them to create the Core System Database;  
 

• Core Program: Generation – Which uses the – 
o Data Definitions, 
o Transaction Definitions, and 
o Table Definitions 

to Create the Specific Code required for the Core Program including – 
o SQL to maintain the Core System Database, 
o SQL to interrogate the Core System Database, and 
o Validation that the Data presented is “fit for purpose” 
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by using the Transaction Definitions and Core System Database Definition to control 
the generation;  
 

• Code Review – which allows the Generated Core Code to have any Custom Code 
added; 
 

• Core Program Creation – which amalgamates the Generated Code into the Core 
System modules and adds them to the Default Program Library. 
 

There is no requirement to follow the steps for any one Program from start to finish and 
then repeat the steps for another Program.  For example: many Data Definitions can be 
specified before any Transactions are defined.  On the other hand, if it is realised that some 
Data is missing at the Screen Definition stage, then the Data can be defined and added to a 
Transaction and it will then be available to the Screen Definition. 

Thus the use of Enigma is quite free form.  All that is required is that everything needed to 
generate a Program be in place before Generation is commenced.  Even if this is not the 
case the deficiency can rectified and the Generation redone.  This becomes particularly 
important if the results of testing the New Application programs show unexpected results. 

Enigma-2020 perpetuates this flexibility and also allows changes to Data, Actions and 
Programs. 

With this in mind the rest of this manual specifies the scope within which Enigma generation 
of an Application can be done. 

  



Version: 1.6 P a g e  | 18  Released: 19th April 2020 

Part Two – THE APPLICATION MODEL 

Enigma is used to create Applications that have a specific architecture; as shown in the 
Diagram.  The structure may be run using the desktop or over the Internet.  There are 
various parts of the structure that are important to documenting Application creation using 
Enigma. 

 

GLOSSARY 
Application –  The complete collection of Programs defined to specify the Application 

using Enigma 

Net System –  The complete collection of Programs defined via Enigma that contain a 
User Interface 

Net Program –  One Program in the Net System 

Core Program –  The single Program that interacts with the Core Database 

Core Database – The database containing all of the Data being manipulated and maintained 
by the Application; effectively the Application database 

Net Database –  The database containing all of the Data used within Net System that is not 
Core database data.  This database may also facilitate communication 
between the Net System and the Core System 

User Interface –  The means for interaction between a User and the Net System. 

 

ARCHITECTURE 
 

Operation of the Application is controlled by the Net System.  Each of the three Users will 
interact with a copy of a Net Program.  The Net Program will interface with the Core System 
when directed by the User.  Each Net Program will initiate a copy of the Core System (Core 
Program) specifically to process the Data provided by a Net Program against the Core 
Database. 

Once the Core Program completes whatever process is required by the Net Program, the 
Core Program is terminated and the results notified to the Net Program and hence to the 
User. 
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Part Three – QUICK START GUIDE 

CREATING A SIMPLE APPLICATION 
 

1. Before you begin 
Before you begin to work with Enigma, it is a good idea to have the Application Analysis, 
Application Design and Database Design documented.  Alternatively, Enigma can be used to 
progressively document your new Application.  Either way, successful use of Enigma 
requires a clear comprehension of the Application you are going to create. 

If Enigma is going to be used to document the new Application then – 

• Use  
o Data Definition, and, 
o Transaction Definition  

to document the Application Analysis. 
• Use  

o Program Definition, and,  
o Screen Mapping  

to document the Application Design. 
• Use 

o Table Definition 
to document the Core Database Design 

2a Add the Application (Enigma-2020) 
Start Enigma.  The following screen is displayed.. 

 

 

Enter the Application Name or use the  control to display a list of applications already 

defined to Enigma.  Select from the list or use the  control to record a new Application. 
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For a new Application complete the Short Name and select the logs ( / ) that are 
required.   

 

Use the second control to record the new Application.  For an already defined Application 
these details will be displayed.  NOTE that the Short Name cannot be changed after it is 
recorded. 

Access to the Program line will become available. 

To commence a different Application the Alter   control can be used. 

2b Add the Application (original Enigma) 
Start Enigma. Select “Add Application” from the Applications dropdown menu. 

 

The following screen is displayed. 

All these settings are assumed by Enigma-2020.  Select Customise Application from the 
ribbon menu to alter these settings for your application if the assumptions are unsuitable. 
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Add  
• an Application Name for your Application, and, 
• a Short (one word) Name for the Application2 

Accept the rest of the default settings or refer to #Appendix 1 – Add Application & Modify 
Application for details of the setting values. 

Click on Record to – 

• Create the Folder to hold your Application in C:\EnigmaSystems\  
• Define pre-requisite folders and code for Web Browser operation, 

 
2 This name will be used for Folders, Programs and Databases within your new Application. 
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• Create the Net System Database – including the pre-requisite Database Tables for 
Screens, Menus and Security control in Folder     
 C:\EnigmaSystems\{ShortName}\App_Data\ 

• Populate the Application with – 
o a Basic Menu structure, 
o a Basic Security structure, 
o CSS definitions for Screens, Menus, and List Tables, 
o Maintenance Programs for – 

▪ Screen Definition (refer to #   
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▪ Embellishment for details 
▪ Menu Definitions refer to # New Application Menu for details, 
▪ Security defaults: (refer to # 3 The Access Levels program) for 

details. 

When the Menu redisplays select your Application to continue the Application definition.   

3a Enigma-2020 sequence 

Start a program 
Select an existing Program or Add a new Program to the Application. 

 

The existing details required for the program will be displayed or new Programs details can 
be entered. 

 

If the existing details need to be altered the  control can be used to clear or change the 

details.  To commence a different Program the Alter   control can be used. 

Start an Action 

Access to the Action selection will become available and (for 
existing programs) the Actions already attached to the Program will display. 

 

A new Action can be selected and added to the list of Actions or one of the Actions in the list 
can be selected.  In either case the screen will be formatted to allow entry or selection of 
the details of the Data required for the Action. 

Details on the screen formats are in Part 3a. 

Data that is required for an Action can either be selected from the Data already attached to 
the Application or can be defined. 

3b Define new Data for the Application - Enigma-2020 
New Data can be entered into the Content or Returns (or similar depending of the action) 
Requirement.  The new Dataname should be typed in and the control used to confirm the 

name.  

The entered User Data name will display  
and the Database name can then be selected or entered 

 
Use the controls as previously described.  The list will show previously defined Database 
names. 
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The screen that is displayed is the equivalent of the “#Detailed Data Definition” screen in the 
original Enigma.  Complete the Definition for the Data and then use the Accept control to 

record the definition or the  control to clear the data.  For a new Data definition this 
control will also delete any reference to the new data in the Application. 

The Data structure created by Enigma-2020 is the same as for the original Enigma.  Please 
refer to #4 The Data Structure (Data Definition) for more details. 

3c Define the Data in the Application (original Enigma) 

 

Select Data & Transactions from the Net Definition drop down menu.  The definition screen 
displays:  
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Data is defined in the right-hand List.  Select (click on) an entry in the list to display the 
basic detail (as shown). 

Use  

• “New” (not shown – default) to get blank fields for a new Data Definition 
• “Record” (not shown) to add the new Data Definition 
• “Update” to record changes to the displayed detail 
• “Expand” to access the detailed Data Definition 
• “Delete” to remove the Data Definition from the Application 
• “Clear” to blank the displayed details. 

The GoTo Control 
Keying Character(s) in the “GoTo” field will reset the list to the “Net Name” starting with, or 
starting with the next available, character to that keyed.  (The keyed character is not 
displayed).  The number of characters that have been indexed are shown between square 
brackets:  e.g. [2].  Selection of an indexed entry or pressing the Escape key will restart the 
indexing from the first character.   

Data Entry Rules 
“Caption” – Optional DEFAULT value that can be changed during Screen definition (if 
required). 

“Net Name” – Mandatory name for this data.  Must be unique. 

“Core Name” – Optional name for the Data on the Core System Database.  Not necessarily 
unique: i.e. more than ONE Net Name can refer to the same Core Name.  This is discussed 
in #4 The Data Structure (Data Definition) 

When either “Record” or “Expand” is clicked the “Detailed Data Definition” screen displays. 
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Detailed Data Definition 
 

 

This screen allows many variations of information to be entered to define the Data.  The 
simple (single value) definitions cover – 

• “Net Caption” – defaults to the “Caption” in the Data List.  Changes will update the 
“Caption” value. 

• “Net Name” – Defaults to “Net Name” in the Data List.  Changes will update the “Net 
Name” value. 

• “Caption Size” – A calculated value that allows the “Net Caption” to display.  
Measured in Pixels.  Adjust as necessary.  Get a wrapped caption if the size is too 
small and the Caption contains one or more spaces.  DO NOT wrap if the caption is 
to be displayed above the Data.  This can be adjusted when the Screen is mapped. 

• “Display Size” – The DEFAULT space in Characters to be allowed for input or display 
of this Data in a Screen definition.  Can be changed during the “Screen Mapping” 
process. 

• “Stored Size” – The default number of Characters to be stored in the Core Database 
for this Data.  Note: Data that is derived from a drop-down selection list is stored in 
the Core Database as the code for the selected value and should have an 
appropriate size entered.   Data input exceeding this size will create an Error 
displayed to the User.  The Core database will not accept oversize data. 

• “Decimals” – The number of Decimal places to be allowed in a Numeric data type. 
• “Tool Tip” – A default message to be displayed if the Cursor hovers over this Data.  

Can be changed to suit the screen during the “Screen Mapping”.  Not available for 
Images. 

• “Description” – A definition of what the Data represents.  It is particularly important 
to document the abbreviated values used in Selection lists since they will be 
displayed later when control of the SQL statements is defined. 

• “Display Example” – The default way the Data will be displayed during Screen 
Mapping.  Can be changed during the “Screen Mapping” process. 

Various Drop Down lists require selections.  Some of these alter the “Detailed Data 
Definition” screen display and the “Display Example”. 
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Reserved Words 
There are very few within Enigma.  However, some have had to be defined to cause 
creation special constructions for the data.  These are – 

• List – A keyword to cause generation of a dump of the content in selected columns 
from a single data base table.  “List” has to be entered as both the Net Data Name 
and the Core Data Name when defining this column.  The Caption for the column can 
be any suitable text. 

• Score – A percentage evaluation of how well the selected record matches the search 
criteria used to locate the record.  Records are sorted by descending value of Score.  
“Score” has to be entered as both the Net Data Name and the Core Data Name when 
defining this column.  The Caption for the column can be any suitable text. 

• Count – The number of records having the same value in a field within the records 
selected by the search criteria.  Expressed as a number.  (Not yet implemented.) 

• Chart – The number of records having the same value in a field within the records 
selected by the search criteria.  Shown as a horizontal bar chart.  (Not yet 
implemented.) 

• Age – Shown as years|months|days of a recorded date relative to the current date.  
(Not yet implemented.) 

• TRecd – Control field used in the Log database tables to link related records together 
by the time the transaction was processed. 

• {Table3}Conn and {Table}Disc – Used in Link tables to show the timestamp when 
the Link was Connected or Disconnected. 

The details on the implementation of these constructs are covered within the #4 Detailed 
Column Formatting section.  They will be implemented progressively.  Check in the Revision 
List to see which have become available. 

  

 
3 {Table} = Table name in the Database design. 
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Table 1 – List of Data Types and consequences 

Selection Value Consequence 

HTML Type Checkbox Changes the Display Example 

  Suppresses the “Selection List” definition 

 Image Changes the Display Example 

  Linked to an Input Type of Picture 

  Allows the Image Detail properties to be defined 

 Input Default HTML format 

 Radio Button Allows Yes/No selection of “Core Process Request”  

  Requires the definition of an “Option Name” 

  Definition creates a Program in the Application 
Library to maintain the Option List4 

  Definition creates a Table in the Application 
database to hold the Option List alternatives 

  Definition creates an entry in the Application Menu 
to access the maintenance. 

Image Detail Type Allows the type of Image access to be specified 

 Location Depending upon the Type the Folder and File where 
the mage is located can be specified 

 Alternate Specifies a text to be displayed if the Image cannot 
be locate when the Application is running 

Core Process 
Request 

Yes Causes Core processing to be requested whenever 
the Radio Button alternatives are changed 

 No The Radio Button value can be recorded on the Core 
Database 

Data Type Counter Considered to be an Integer.  This Data will be used 
to provide a unique Key value for the Core System 
Database records. 

 Date (American) American format Date always displayed as 
mm/dd/yyyy.  Always stored as String with format 
yyyymmdd.  Validated to have valid Days and 
Months. 

  Always formatted as three fields with fixed, display 
only, “/” separator characters 

  Auto formatted so that entry of mm/dd/yy (or 
variations e.g. m/d/y) into the Month field will be 
split into three fields. 

 
4 The Options have to be entered into the Net Application using the New Application Menu selection 

that is available after the data is recorded.  
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Selection Value Consequence 

Data Type (cont.)  Entry of yy will default to 19yy if yy is greater than 
current year and 20yy otherwise.  Entry of yyyy is 
not reformatted.  Entry of yyy is invalid. 

  Allows the definition of “Date Edit” alternatives. 

 Date (European) European format Date always displayed as 
dd/mm/yyyy.  Always stored as String with format 
yyyymmdd.  Validated to have valid Days and 
Months. 

  Always formatted as three fields with fixed, display 
only, “/” separator characters 

  Auto formatted so that entry of dd/mm/yy (or 
variations e.g. d/m/y) into the Days field will be split 
into three fields. 

  Entry of yy will default to 19yy if yy is greater than 
current year and 20yy otherwise.  Entry of yyyy is 
not reformatted. Entry of yyy is invalid 

  Allows the definition of “Date Edit” alternatives. 

 email Edited text string – must contain @ and at least one 
full stop  

 Integer A number with no decimal places.  Do not confuse 
with Counter 

 Lowercase Input Data is always converted into lowercase 
characters. 

 Numeric A number with specified decimal places. 

 Password Protected alpha-numeric characters.  NO special 
characters allowed.   

 Picture Defines a Static or Selected Image area 

  Linked to the HTML Type of Image 

 Phrase String data that will be formatted to have a leading 
UPPER case character as the first character 

 String Data containing any character – NOT reformatted 

 Text String data that may occupy several lines within a 
Data field. 

 Time Not available at present 

 Timestamp A Core System generated DateTime value as 
yyyymmddhhmmssff in String format 

 UPPER CASE Input data is always converted into Uppercase 
characters 
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Selection Value Consequence 

Data Type (cont.) Upper Lead Input data is converted into a Leading Uppercase 
format that allows for typical name prefixes such as 
Mc, O’, Hyphenated names. 

Date Edit Partial OK? No. Date cannot contain zero for Days and/or 
Months. 

  Yes. Date can contain zero for Days and/or Months.  
No other Date validation is done. 

 Historic OK? Yes. Date can be before the current date: e.g. a 
Date of Birth. 

  No. Date cannot be before the current date: e.g. an 
Appointment Date. 

 Future OK? Yes. Date can be after the current date: e.g. 
Appointment Date. 

  No. Date cannot be after the current date: e.g. Date 
of Birth. 

Request 
Comparator 

SQL Conditions 
 
=, >, <, >=, 
<=, <> 

The type of comparison to be used if this Data is 
included in a Request (“Req”) transaction.  Can be 
modified when the Transaction is defined.  Contains 
all SQL condition values and most SQL predicate 
values.  Used to control the access of data from the 
Core Database. 

 IN Data must equal one of a list of values 

 LIKE Data must contain the string of characters 

 BETWEEN Data value must be >= lower value and <= higher 
value 

 PARTDATE If the Date can be a Partial Date and the Date 
supplied is a Partial Date then the comparison will be 
extended to include all possible Dates.  See Partial 
OK? Above. 

Data Selected? No The “Selection List” fields remain suppressed 

 Yes Requires a “Selection List” name to be defined 

  If the “Selection List” does not already exist, 
definition of the list creates a Program in the New 
Application Library to maintain the Selection List5 

  If the “Selection List” does not already exist, 
definition of the list creates a Table in the New 
Application Database to hold the Selection List 
alternatives 

 
5 The Selection alternatives have to be entered into the Net Application using the New Application 

Menu selection that is available after the data is recorded. 
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Selection Value Consequence 

Data Selected? 
(cont.) 

 If the “Selection List” does not already exist, 
definition creates an entry in the New Application 
Menu to access the maintenance. 

  The Net Data is linked to the list. 

  Default value.  Caption shown for the Data: can 
have two words 

Caption Location Before Caption shown in front of the Data 

 After Caption shown after the Data.   

 Above Caption shown above the Data.  Caption and Data 
are aligned to the left margin. 

Input Status Display Only Data that is displayed to the User but cannot be 
changed and will not be sent to the Core System 

 Input Display Data that has been previously input by the User and 
cannot be changed during this later processing but 
may be sent to the Core System 

 Mandatory Data that must have an input before the Screen will 
be processed. Will be validated and/or formatted 
according to the “Data Type”. 

 Never Input Data that exists in the Core System but is never 
displayed to the User.  It may be made available to 
the Net System. 

 Optional Data that may be entered by the User.  Will be 
validated and/or formatted according to the “Data 
Type” if entered. 

 Password Alphanumeric characters only. No Special characters 
or punctuation is allowed.  Alphabetic characters are 
converted to upper case.  Data input is masked. 

 Sent Only Data that exists in the Net System but is never 
displayed to the User.   

Initial Value No Logic value stored as “N” - False 

 Null Initial value in the Core Database 

 Space Initial value in the Core Database 

 Yes Logic value stored as “Y” - True 

 Zero Initial value in the Core Database 

Data Formatting 
Enigma formats data in different ways depending upon the HTML Input that is selected. 

• Input is a normal Caption and Data area on the screen.  The data may or may not be 
sent to the Core System depending on the Input Status that is selected.  The data 
may also be formatted according to the Data Type selected.  
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o Input Selection Lists format as a Dropdown list when value selection is 
allowed.  However, when the Selection List is protected the display is reset to 
a normal, “readonly”, input data area. 

• Checkbox is also a normal Caption and Data area on the screen.  However the value 
of the Data will be True or False (Checked or Not Checked). 

• Radio Button and Image are quite different and require more detailed explanation.  

Option Groups 
Option Groups are formed when data is defined to be “Radio Button”. 

 

The Display Example shows the basic organisation of the Option Group.  It can be controlled 
as follows – 

• The colour coding applied due to the Input Status is shown in the Caption for an 
Option Group rather than in the Data area 

• The format of the options is controlled by the Display Size allocated to the Option 
Group.  If the Display Size is made smaller, then the options will show less in each 
row and more rows will be created.  A larger Display Size will display more in each 
row and perhaps less rows 

 

Screen Mapping an Option Group is a matter of trial and error mainly because the format of 
the Option Buttons is dependent upon the size of the text entered for each option.  The text 
will always display after the Option Button and it is the width allowed for the control that 
determines how many options are shown in each row.  To get the most controllable results 
the text for all options in the Option Group should be approximately the same length. 



Version: 1.6 P a g e  | 33  Released: 19th April 2020 

Image Display 
Display of Images within Application screens is defined by selection of an HTML Input type 
of “Image”.   These Images are all sourced from within the Application or within the 
computer where the application is installed and will always display the same Image 
whenever they are displayed.  In the example note the wrapped Net Caption caused by the 
low Caption Size value. 

 

The screen will then allow the Image Details to be defined – 

• Type is a dropdown list that allows the nature of the Image to be selected – 

 

o File indicates that this will be a file located a specified location.  The file is 
always displayed from that location whenever the Image is included in a 
mapped screen. 

o Fixed indicates that it will be a file located within the Application’s “Images” 
folder.  The file is always displayed from the Images folder whenever the 
Image is included in a mapped screen. 

o Locate indicates that this will be an Image that a User can Browse to locate.  
Once located it will always display the same Image until it is changed by a 
User. 

• Location specifies the Image file to be accessed and displayed for File and Fixed 
selections.  The rules are – 

o For File – 
▪ If the location is contained within the Application folder then 

specifying {Folder Path\File Name.ext} is sufficient 
▪ If the location is within the computer where the application will be run 

then the full path starting from the root drive should be specified: i.e. 
{C:\....\Folder Path\File Name.ext} is required 

o For Fixed – 
▪ The location will always be {Images\File Name.ext}  

o For Locate – 
▪  The Location is not specified and an ellipsis {(…)} should be entered 

to indicate to the User to browse for the Image file. 
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• Alternate specifies a text to be displayed if the Image cannot be located when the 
Application runs. 

An HTML Type of Image will always have a Data Type of Picture and vice-versa.  The size of 
the Image in the Display Example is fixed, but the Display Size can be altered and will be 
the default when the screen is mapped.  The height of the mapped Image can be adjusted 
during the mapping process. 

Image Types of Fixed and File will always have an Input Type of Display Only.  The Located 
Images always have an Input Type of Optional. 

4a Define the Actions in the Program – Enigma-2020 
Adding Actions to a Program is the Enigma-2020 replacement for adding Transactions.  
Refer to #Start an Action. 

Actions create Transactions as shown in this table. 

Action Transaction 1 
(defined as Content) 

Transaction 2 (defined 
as Control or Result) 

Cancel Delete (DEL) Result (RES) 

Change Modify (MOD) Result (RES) 

Display Local (LOCL) Request (REQ) 

Export Export (EXPT) Result (RES) 

Find Initial (INIT) Not Required 

Import Import (IMPT) Request (REQ) 

Logic Load (LOAD) Not Required 

Provide Provide (PROV) Request (REQ) 

Record Add (ADD) Result (RES) 

Rules Tabulate (TABL) Not Required 

Show List (LIST) Request (REQ) 

Enigma-2020 - Table 2 – List of Actions and Corresponding Transactions 

The following notes on the Transactions apply to Enigma-2020. Particularly – 

▪ #5 Transaction content 
▪ #Data Selection and 
▪ #6 Adding Data to the Transactions 

should be understood. 
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4b Define the Transactions in the Application (original Enigma) 
Transactions are the Information (i.e. collections of Data) that will be processed by the 
Application.  They are defined on the left side of the screen. 

 

Definition of transactions is similar to the definition of Data but a lot simpler.  Select (click 
on) an entry in the list to display the basic detail (as shown). 

Use  

• “New” (not shown - default) to get blank fields for a new Transaction Definition 
• “Record” (not shown) to add the new Transaction Definition 
• “Update” to record changes to the displayed detail 
• “Delete” to remove the Data Definition from the Application 
• “Clear” to blank out the displayed details. 

Data Entry Rules 
All fields must be entered. 

• “Name” – The identifier given to the transaction or (preferably) to a group of 
Transactions.  Giving the same Name to a group will ensure that they display 
together in the Transactions list 

• “Type” – A selection from the range of alternative Transactions supported by 
Enigma. 

• “Repeats” – Indicates if the Data in the Transaction is one set, or a repeating set, of 
Data. 

The Transaction Types define the operation of the Transaction within your Application.  
There are 15 alternatives.  Many Transactions have a “direction” where they send, or 
receive, data relative to the Core System or relative to an External Program.  Otherwise the 
Transaction is internal to the Net System.  Transactions control the operation of the Core 
System and they require careful consideration.  First a table and then notes on each 
transaction. 
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Type Value Direction Purpose Followed By 

Add Add Net-to-Core Add NEW Data to the Core System 
Database 

Res 

Del Delete Net-to-Core Delete Data from the Core System 
Database 

Res 

Enq Enquiry Net-to-Core Enquire for Data from the Core System 
Database.  Identical to “Req” below 

Prov or List 

Expt External 
Access 

Net-to-
Program 

Provide Data to an External Program 
and Start its operation NOT 
IMPLEMENTED AT PRESENT  

Impt or Add, 
Mod, Del or 
End Program 

Init Initiate  Get Data input from the User for use in 
the next Program 

Next Program 

Impt External 
Access 

Program-to-
Net 

Get Data provided by an External 
Program NOT IMPLEMENTED AT 
PRESENT  

Add, Mod, Del 
or End Program 

List List Core-to-Net Get repetitive Data from the Core 
Database 

Nothing or Req 

Load Load  Load “Tabl” data from the Net 
Database for internal use by the Net 
System 

Nothing 

Locl Local  Display Data that is already known6 to 
the Net System 

Nothing 

Mod Modify Net-to-Core Change Data on the Core Database Res 

Proc Process Net-to-Core Get the Core Program to execute some 
Process based upon the supplied Data.  
NOT IMPLEMENTED AT PRESENT. 

Res 

Prov Provide Core-to-Net Get Data provided by the Core Program 
for use by the Net Program 

Add, Mod, Del 
or Expt 

Res Result Core-to-Net Result of the Core Program process End Program or 
Error Display 

Req Request Net-to-Core Request for Data to be supplied from 
the Core Database.  

Prov or List 

Tabl Tabulate  Record Data for use by the “Load” 
transaction 

End Program 

Table 3 - List of Transaction Types  

  

 
6 The concept of data being “known” to the Net Application is covered in the section #USING A 
PROGRAM (What Happens to the Values) 
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5 Transaction content 
Transactions fall into several classes: Transactions that Add information, Transactions that 
Change recorded information, Transactions that Retrieve Information, Transactions that 
Display information to the user, Transactions that invoke Third Party programs and 
Transactions that supply Logical Control for a program. 

In Enigma-2020 the Transactions are implemented as Actions.  Each Action will implement 
one, or two, Transactions, as noted below. 

 The first two classes are further refined by the mode in which the Core database is used: 
refer to #7 Core Database Operation for more detail on these modes, including the 
specific requirements for History mode.  At this point, details of the required content for 
these Transaction classes, almost irrespective of the Database mode, are of importance  

The ADD Class (ADD) 
The ADD Transaction operates using the Content of a Record Action in Enigma-2020. 

When records are added to the Core database then there will be a mixture of key values 
supplied.  Some may be already known, and some may require generation, by the Core 
System: #see - Notes on Database Design for details on Key creation.  Where a Transaction 
is defining completely new information7 it will be an ADD transaction.  If the content of the 
transaction is adding information to a recorded collection of information8 it will be an ADD 
transaction.  However these two are different in their requirement. 

In the former case the ADD Transaction will specify perhaps two keys: one to identify a 
family and one to identify the first person to be included in the family.  Both of the keys 
would be empty, zero or null so that the Core System will create unique values. 

In the latter case the key for the family would be specified so that the transaction content 
(an additional person) can be attached to the correct family.  However the key for the 
second person would be empty, zero or null to allow the Core System to create a unique 
value for the additional person. 

The content of the ADD transaction would be different in each case.  For the former case 
the Transaction should contain the Family details (whatever they are) along with details of 
the first person.  In the latter case the Transaction should only contain details of the second 
person.  These are matters for the initial Application Design to consider. 

So for the ADD case the rules are – 

• If the information is new to the Database, leave the key data without any content; 
• If the information is new to the Database BUT should be added to an existing 

collection, specify the key to the collection and leave the key to the new information 
without any content. 

The database mode has no effect on this transaction class. 

The Change Class (MOD) 
The MOD Transaction operates using the Content of a Change Action in Enigma-2020. 

Changing information within the database can take two forms: modification of the data (a 
MOD transaction) or removal of the data (a DEL transaction).  The database mode of 
operation affects the processing of both of these transaction types. 

 
7 For Example: Commencing a record to identify a family. 
8 For Example: A Child being added to an existing Family of persons. 
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MOD transactions alter existing information.   Consequently they require all the details being 
altered to be supplied, as well as all the key values to identify the records where the 
alterations should occur.    

Where the database mode is a Snapshot, these changes are applied and destroy any 
existing content in the Database.  Existing content that is NOT changed is retained in its 
unmodified form. 

Where the database mode is History, all previous content has to be retained and the 
modification needs to create a new record containing any unaltered content along with the 
altered content.  Hence, History mode treats MOD transactions as if they are ADD 
transactions.  Existing content that is NOT changed is retained in its unmodified form in the 
new record.   

Again, Application Design is of importance.  Also, be aware that irrespective of the database 
mode, the supply of empty content will remove the existing content and replace it with the 
empty content. 

The Change Class (DEL) 
The DEL Transaction operates using the Content of a Remove Action in Enigma-2020. 

DEL transactions are simpler.  All that they contain are the values identifying the content to 
be removed from the database.  This can create unintended consequences depending on 
the database content at the time the DEL transaction is applied. 

Consider the records for an Agent who is Agent for two different families.  There would be 
one Agent record and two family records in a normalised database.  Deletion of the Agent 
record would leave both families without an Agent.  That may be correct!   

Deletion of the Agent so that they are no longer Agent for one family may also be correct, 
but would be different in its effect on the database content.  The Agent record would remain 
and only its connection to one family would be removed. 

For a Snapshot database mode the DEL rules are – 

• If only the key to a record is supplied then ALL references to records using that key 
value will be removed: i.e. the record and all connections to other records will be 
removed; 

• If the key value for a record and the key value for a connected record are supplied, 
then the connection containing both key values will be removed and the other 
records retained; 

• If a key value for a record and a non-key value are supplied then ALL records 
containing both values will be removed. 

When considering History mode the DEL transaction processing becomes simpler.  History 
does not allow ANY records to be deleted from the database.  So a DEL transaction has to 
disconnect any connected records.  The disconnection is done using an ADD transaction to 
include a disconnection timestamp in the last of the relevant connection records. 

Again there is a difference depending upon the values supplied in the DEL transaction.  
Where the supplied values identify one connection, then that connection is disconnected. 

Where the supplied value identifies only one part of a connection, then ALL connections 
containing that part value are disconnected. 

The Retrieve Class (INIT) 
The INIT Transaction operates using the Content of a Find Action in Enigma-2020. 
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Often within an Application there will be series of programs required to process a function 
within the application.  For example: there may be a need to search for a person and if they 
already are recorded with the database update their details and, if not known, record their 
details.   

The INIT transaction allows the Initial search to be started through a screen the starts with 
no data and accepts whatever the user enters.  The user entries can then control the next 
program that does the search. 

The Retrieve Class (REQ)  
The REQ Transaction operates using the Control for a Provide or List Action in Enigma-2020. 

The search program transaction sequence would commence with a REQ transaction.  This 
passes the data entered in the INIT transaction to Request whatever details are held on the 
database so that they can be displayed to the user.  This usually results in a list of details 
being returned from the Database.  From this the user can then decide if a set of details 
should be updated (MOD) or created (ADD). 

Both MOD and ADD may require much more data to be available that can be conveniently 
shown in a list.  Again a REQ Transaction would request all of the relevant data, blank or 
otherwise, to allow the user to input or change the data. 

The difference between INIT and REQ is that REQ uses data that has already been 
Retrieved or Created at some point during the sequence of Programs.  INIT gets data direct 
from the user. 

The Retrieve Class (ENQ) 
The ENQ Transaction is not specifically implemented in Enigma-2020. 

The Enquiry Transaction ENQ is functionally the same as the Request Transaction.  The 
distinction is made so that it can become more obvious that an enquiry is being done rather 
than a Request which would normally involve later Transactions being sent to the Database.  
With Enquiry the Data would normally be Provided and then discarded when the user had 
gained the required information. 

The Display Class (PROV) 
The PROV Transaction operates using the Content of a Provide Action in Enigma-2020. 

The consequence of making a Request for data from the Core Database can result in one 
set of data being retrieved or more than one set of data being retrieved.  A Provide (PROV) 
transaction handles one set of information to provide the detail that can be displayed in one 
Form for the user to inspect, change or enter new information 

A Provide transaction is applicable if the application expects one set of related data to be 
available from the database.  An error will be reported if the Request results in more than 
one set of data. 

More than one Request/Provide transaction pair can be defined for one Form.  This can 
overcome the restriction that no Transaction can contain more than one instance of a Core 
Data Name: see #Data Definition. 

The Display Class (LIST) 
The LIST Transaction operates using the Content of a Show Action in Enigma-2020. 

Where a Request transaction is intended to retrieve more than one set of related data then 
a LIST Transaction should follow the Request.  The LIST Transaction allows for more than 
one set of data to be retrieved and displayed in a table for the user to judge what should 
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happen next.  The user’s selection of a record from the List can control the navigation within 
the Application.  This will be covered later: see #The List Transaction. 

The Display Class (LOCL) 
The LOCL Transaction operates using the Content of a Display Action in Enigma-2020. 

At times it is useful to be able to show the user what is controlling the Request for data in a 
list.  Typically this is the information contained in the Request. 

Because this data is already known within the Application the content can be shown to the 
User.  The data is considered to be Local data and is shown through a LOCL Transaction.  
Typically this transaction will be in its own form and have control Buttons to effect the 
Navigation. 

The Display Class (RES) 
The RES Transaction operates using the Returns from a Record, Change or Remove Action 
in Enigma-2020. 

Interaction between the User and the Database is always done in using a send/receive pair 
of transactions.  The Result of processing the sent transaction is shown in the RES 
Transaction content. 

There may be NO content required in some Result Transactions but the transaction has to 
exist so that any errors located when processing the sent transaction can be reported.  More 
often the Result transaction will contain any new key values created when adding new data 
to the Database. 

Third Party Program Class (EXPT ) 
Use of this transaction is planned but not yet implemented. 

Third Party Program Class (IMPT) 
Use of this transaction is planned but not yet implemented. 

The Logical Control Class (TABL) 
The TABL Transaction operates using the Content of a Rules Action in Enigma-2020. 

Logic to be applied at the Client level is defined in Enigma by documenting two dimensional 
Decision Tables.  These are defined using the TABL transaction which will contain all the 
data names required to specify one row in the Table.  The database table created to hold 
the data values is located in the Net Database and takes its name from the Transaction 
Name. 

Where more than two dimensions are required to define the logic, Decision Tables can be 
nested so that one provides a path to whichever Decision Table is applicable to define the 
second and third dimensions.  Thus for three dimensional logic, there would be three TABL 
transactions required. 

TABL is covered in more detail later: see #2 The Tabulate (TABL) Transaction. 

The Logical Control Class (LOAD) 
The LOAD Transaction operates using the Content of a Logic Action in Enigma-2020. 

Programs access the Decision Table and the values to be used to control the decision logic 
by use of the LOAD transaction.  This transaction must specify all the data names used in 
the TABL transaction to specify the decision values.  The Transaction Name must be the 
same as the name used for the TABL Transaction. 
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A Program can contain many LOAD Transactions if necessary to control the Logic to be 
applied. 

Use of the loaded Decision Table is covered later: see #The LOAD Transaction. 

Data Selection 
The following notes apply to selection of Data for inclusion in the Content for Enigma-2020. 

The Data included in a Transaction needs to be selected carefully.  The Transaction, and its 
content, and the sequence of Transactions, effectively define the processing to be done by 
the new Application. 

For most transactions the consequence of the transaction is apparent by having data 
displayed to the user.  If it is expected to be displayed and is missing the transaction needs 
to be amended. 

For each of the Add and Change classes the Transaction determines how the Core System 
will change the Core database.  The actual change is very difficult to monitor directly.  
Instead Enigma uses reports to detail the effect of each transaction on the Database: refer 
#Check Add Records – Enigma-2020 

Select Bench Test Operation > Update > Record to access the report. 

The Application must be selected before the report will display.  The following notes apply. 

Check Add Records, etc.  Also note that although History Mode alters the MOD and DEL 
transactions to process them as ADD this is not reflected in the reports. 

There is a more detailed explanation of the use of the transactions in #3 The Transaction 
Structure. 

6 Adding Data to the Transactions (original Enigma) 
The Transactions on the Left and the Data on the right should be merged to give the 
Transactions a content that will be sent to the Core System or received from the Core 
System or stored in the Net System or retrieved from the Net System or accepted direct 
from the user as indicated in the preceding notes.. 

Select a Transaction (click on the row).  An “Include” button will display in one of the centre 
columns.  Which is displayed depends upon the “Type” of the Transaction. 

Now select the Data that should be included in the Transaction.  “Include” buttons will be 
displayed in both centre columns.  The Data can be added to the appropriate Transaction. 
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Once the Data is included in a Transaction, it can be manipulated by highlighting a row and 
then using the displayed controls. 

Use – 

• “Delete” to remove ALL data from the Transaction 
• “Exclude” to remove the highlighted data from the Transaction 
• “Update” to record a change to the displayed selection list 
• “Clear” to remove the Transaction details from the Display 
• “˄” to move the highlighted Data up the transaction sequence 
• “˅” to move the highlighted Data down the transaction sequence 

Changes to the Transaction content, or Data sequence, record immediately.  Exit by using 
“Clear” or by selecting another Transaction to define, or change. 

7a Defining a Program – Enigma-2020 
Refer to #Start a program for the Enigma-2020 process. 

7b Defining a Program (original Enigma) 
 

 

Select “Program Transactions” from the Main Menu.  The Program definition screen will be 
displayed. 
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By selecting the New button a Program can be defined. 

Enter – 

• A “Name” for the program.  Program Names cannot contain spaces 
• The “Screen Title” to be shown to the User when the Program is accessed 
• The “Program Type” for the Program 
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The available Program Types are – 

• “Default” (D) – The Program operates when the Application is started.  There can be 
only one Default Program. 

• “Menu Choice” (C) – The Program is chosen from the Application Menu.  Definition of 
the Menu entry is done when the first program generation is done 

• “Sub-Program” (S) – The Screen for the Program displays as directed by the 
Application Navigation.  It replaces the preceding Screen in the Navigation 
sequence9. 

• “Internal Frame” (F) – The screen displays within the preceding Screen in the 

Navigation sequence. 

If a Program is selected then Use – 

• “Update” to change or correct the Information 
• “Delete” to remove the Program.  Delete is subject to any Transactions included in 

the Program being excluded beforehand. 

Once a Program is defined it can have the sequence of Transactions to be exercised by the 
Program included in it.  Alternatively, if there are already Transactions included in the 
Program, selection of the Program will display the Transactions. 

 

 

In the screen-shot the Person_Del program has been selected.  It should have the Person-
Res Transaction added to the sequence.  That has been selected from the right-hand list. 

Use –  

• “Include” to place the selected Transaction at the end of the list, 
• “Replace” to a replace a selected Transaction included in the Program by the one 

selected on the right. 

When Transactions in the Program are selected various controls display. 

Use – 

 
9 Navigation Sequence is the sequence in which programs will be made available to the User 

depending upon the Menu selection, the Record selection from generated Lists, the Quantity of 
Records available in a generated List or the User selection of Button controls on a screen.  Any of 

these can determine the next program. 
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• “Delete” to remove ALL the Transactions from the Program 
• “Exclude” to remove the highlighted Transaction from the program 
• “˄” to move the highlighted Transaction up the transaction sequence 
• “˅” to move the highlighted Transaction down the transaction sequence 
• “Clear” to remove the Program from the central Display 
• “Static Values” to allow the association of specific values to Data within the  

transaction.  This is only shown if ADD, MOD or DEL Transactions are selected 
• “Search Using” to allow the association of specific search conditions and values to 

Data within the transaction.  This is only shown if REQ Transactions are selected 

#Selection List Sources (Static Values) and #List Selection (Search Using) are documented in 
Part Five – COMPLEX FACILITIES.   

Where the User Interface for a Program should display the same data (for example: names) 
but show different information (i.e. names for different people) then more than one 
REQ/PROV pair of transactions can be included in the Transactions included in a Program.  
This is necessary because no transaction can contain more than one instance of a Data 
element: see #Data Definition. 

8a Defining the User Interface (Enigma-2020) 
With Enigma-2020 use Design > User Interface > Current Program to access the 
mapping process for a Program in an Application already selected in Enigma-2020 or 
Design > User Interface > Select Program to access the list of Programs defined for 
the Application. 

All of the following instructions apply. 

8b Defining the User Interface (original Enigma) 
The User Interface is defined by selecting Map Screen Content from the Menu. 

 

This selection allows – 

• the Data in the Transactions to be placed on the Screen, 
• Text to be defined and displayed, 
• Controls to be placed on the screen, 
• the size and location of the Form(s) to be defined, and, 
• the size and location of the Screen to be defined. 

The interface is large and seems fairly complex until some familiarity with it is obtained. 



Version: 1.6 P a g e  | 46  Released: 19th April 2020 

 

The Initial display shows a list of the defined Programs on the right.  Selection of a Program 
will display an edited list of the Transactions defined in the Program.  If some Screen 
Mapping has been done the currently mapped screen will also be displayed within the “grid”. 

Programs 
The selected Program (Login) displays a complex situation so that the various parts can be 
explained.  The Program Name becomes a title on the right.  The list can be redisplayed by 
selecting either the Program Name or the “PROGRAM” title. 
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Transactions 
Selecting a Transaction will – 

• highlight the associated form by using a black dashed line 
• list the Data defined for the Transaction 
• list the Text defined for the screen and for the Transaction  

• display various controls. 

 

 

Fixed Texts 
A list of Fixed Texts is displayed in the bottom right corner.  These do NOT include the 
“Captions” shown on the screen. 

Selection of “Enter New Text String” will provide a blank text area on the screen in the top 
left corner and an empty Sub-Screen for entry of the required Text and to control the Text 
location. 

Enough of any pre-entered Texts are displayed in the list to allow the details for that text to 
be altered.  Selection will display the current “Text Location & Definition” screen. 
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Use – 
• “Text Width” / “Height” to control the size and format of the Text area; 
• “Top” / “Left” to locate the text on the screen (default values are 10 / 10) OR Drag 

and Drop to move the text to its location; 
• “Alignment” to format the text within the Text Area.  Available values are – 

o Left – Text is Justified on the Left boundary of the Text area, 
o Centre – Centre the Text between the Left and Right boundaries of the Text 

area, 
o Right - Text is Justified on the Right boundary of the Text area, 
o Justified – Text is spread between the Left and Right boundaries so both 

boundaries are justified; 
• “Border” draws a line around the Text of the thickness specified.  Default 0 draws a 

border of zero thickness and will over-ride any settings defined for “Text” or 
“Outline” Embellishments; refer - #Appendix 1 – Add Application & Modify 
Application; 

• “Text Bold” / “Italic” / “Points” control the whole of the Text formatting; 

• “Padding” shifts the Leftmost character to the right relative to the Left boundary; 
• “Background” places a solid Background behind the Text.  It defaults to the screen 

colour; 
• “Text String” contains the Text you want to display on the screen. Typed characters 

are displayed here and in the screen format.  Formatting within the text can be done 
by using HTML formatting conventions – 

o <strong> ……. </strong> = bold characters 
o <b> …………. </b> = bold characters  
o <br /> = carriage return, line feed 
o <a> …….. </a> = anchor statement 
o <i> …….. </i> = italic characters 
o <u> ……..</u> = underline 

 
If the “Text String” is left blank then a “Box Outline” embellishment will be drawn.  
Otherwise the “Text String” is embellished as a specified for “Text”. 

Use – 

• “Record” to save the entered settings; 
• “Remove” to discard the entered settings and/or to remove the Text from the 

screen; 
• “Cancel” to discard any changed settings and reset the screen as it was before this 

Text was selected. 
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Transaction Data 
The list of Data that is displayed contains all the Data required for transmission to the Core 
System or provided to the Program by the Core System.   

 

Not all of the Data needs to be shown on the screen.   

Inclusion in the List follows several rules – 

• Data with a default “Input Status” definition of “Never Input” will not be included in 
the list; 

• Data defined with “Display” (Disp.) = “N” in the “Core-to-Net” Transaction definition 
will not be included; 

• Data defined with “Send” = “Y” in the “Net-to-Core” Transaction definition will be 
included even if excluded by the preceding rules. 

Alongside each Data Name is a brief statement of how the Transaction definitions attached 
to the Program will cause Enigma will treat the data – 

Statement Core-to-Net Transaction Net-to-Core Transaction 

Disp/Send Data supplied and Displayed Data Displayed and Sent 

Hide/Send Data Supplied and NOT Displayed Data Sent 

Disp Only Data Supplied and Displayed Data Displayed and NOT Sent 

Disp Only Data NOT Supplied Data Displayed and NOT Sent 

Stored Data Supplied and NOT Displayed Data NOT Sent 

Stored Data Supplied and NOT Displayed Data Disposition Unspecified 

Disp/Unkn Data Supplied and Displayed Data Disposition Unspecified 

   

Data Names in italics are displayed on the screen but are NOT sent into the Core System.  
In this case the rekeyed password would be compared to the original in the Net Program 
using Custom code (Refer to #CUSTOM CODE IN THE NET SYSTEM (1 Javascript)) and 
not sent to the Database. 
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Data Mapping 
Selection of a Data entry from the “SELECT TRANSACTION DATA” list will display the “Data 
Location & Format” form where the Data can be tailored to suit this specific screen.  

 

 

The initial values in this screen reflect the default Data Definition for the Data.  Any changes 
made here will ONLY be valid for this Data in this Screen. 

Use – 

• “Caption Size” to move the start of the Data area left or right to make the Screen 
format align.  The screen map reflects any change. 

• “Data Size” to adjust the Data area size.  The screen map reflects any change.  This 
does NOT change the number of characters that can be entered into the field.  That 
value is fixed by the default Data Definition (refer to #Data Formatting). 

• “Top” / “Left” to position the Caption and Data area on the screen OR drag and drop 
the Caption and the Data to the desired location.  The screen map reflects any 
change. 

• “Multi-Line?” (Yes/No) to allow an increase the height of the Data area.  Setting to 
“Yes” creates a “Textarea” HTML control which can used for entry/display of long, or 
multi-line, data strings.  The area will be embellished as specified for “Input”, 
“Select” or “Textarea” as appropriate. 

• “Height” defaults to the setting defined in “Add Application”.  Adjust for multi-line 
Data.  The screen map reflects any change. 

• “Caption Location” can be changed to suit the current screen requirements.  The 
screen map reflects any change. 

o “Before” – Caption shown in front of the Data 
o “After” – Caption shown after the Data 
o “Above” – Caption shown above the Data.  Caption and Data are aligned to 

the left margin and the height is increased.  Note that the Caption and the 
Field will display according to the length of each. 

• “Input Status” to change the display and accessibility for the data.  The screen map 
reflects any change  which only applies to this data on this screen –  

o Display Only – Data that is displayed to the User but cannot be changed and 
will not be sent to the Core System.  Virtually a “Text” area but sourced from 
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the Core database or from inclusion in a program processed prior to this 
program. 

o Input Display – Data that is displayed to the User but cannot be changed and 
will be sent to the Core System.  Usually sourced from inclusion in a program 
processed prior to this program. 

o Mandatory – Data that must have an input before the Screen will be 
processed. Will be validated and/or formatted according to the “Data Type”. 

o Never Input – Data is not displayed on the screen but can be processed 
through Enigma.  Useful for making “record identifiers” (Key Values) available 
within, or between, programs. 

o Optional – Data that may have an input before the Screen will be processed. 
If entered, it will be validated and/or formatted according to the “Data Type”. 

o Password – Mandatory Alphanumeric characters only. No punctuation is 
allowed.  Alphabetic characters are converted to upper case. 

o Send Only – Data included on the screen layout but hidden when the screen 
is generated into the program.  Useful to contain “flags” or “status indicators” 
that should be available throughout a sequence of programs. 

• “Alignment” to format Data within the Data Area.  Available values are – 
o Left – Data is Justified on the Left boundary of the Data area 
o Centre – Centre the Data between the Left and Right boundaries of the Data 

area 
o Right –  Data is Justified on the Right boundary of the Data area 

•  “Caption” to alter the Caption displayed for this Data.  This only applies to this Data 
in this Screen display.  The screen map reflects any change. 

• “ToolTip” to alter the text displayed if the User hovers over the Data area on the 
screen.  This only applies to this Screen display. 

• “AutoComplete?” to activate the Browser’s AutoComplete function (if any).  By 
default ALL Forms are created with AutoComplete set to OFF.  This can be 
overridden by setting individual Input fields to ON.  The setting will only apply to the 
field within the Form being formatted. 

Checkbox, Date and Radio Buttons have some entries that are restricted in the “Data 
Location & Format” screen.  The restrictions cannot be changed. AutoComplete will only be 
available for Input data fields. 

Use – 

• “Record” to save the entered settings 
• “Remove” to discard the entered settings and to remove the Data from the screen 
• “Cancel” to discard any changed settings and leave the screen as it was before this 

Data was selected. 
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Image Mapping 
Selection of an Image entry from the “SELECT TRANSACTION DATA” list will display the 
“Image Location & Format” form where the Image can be tailored to suit this specific 
screen.  

 

Most of the details on this screen will be familiar.  The differences are in the Image Controls 
which are interlocked so as to provide a coherent definition.  Any can be changed and the 
locked values will change at the same time. 

• Input Status displays the whole range that can be selected.  However only Display 
Only and Optional are the valid selections that are cross-linked to Image Type. 

• Any change to Image Type will set the Input Status appropriately.  It will also reset 
the Source to the basic starting format required for a definition of the Image Type 
selected. 

• If the Caption Size is reduced so that the Caption will not fit within the length and 
the caption contains two or more words, the Caption will wrap onto two or more 
lines. 

• The Alternate (Text) shown is the default text.  It can be changed to any other text if 
that will be more suitable. 

The mapped Image for the File and Fixed types is – 
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The mapped Image for the Locate type is - 

 

The User of the Application can use the Browse button to locate the Image they want to 
display.  The Locate Image screen will be displayed. 

 

 

The Browse button gives access to the directories in the environment on which the 
Application is being run.  The files that are displayed are limited to Picture type files. 

 



Version: 1.6 P a g e  | 54  Released: 19th April 2020 

Open the required file.  The full path and file name will be shown alongside the Browse 
button.  Then use the Retrieve button to display the file within the size that has been 
specified on the screen where the Browse was initiated. 

 

The Confirm File button confirms that the file has been moved into the ~/Images folder and 
then sets the Application to retrieve this file whenever the screen is displayed and then 
returns to the screen in the Application where the Browse was initiated.   

The Restart Button removes the Picture from the Images folder.   

Cancel returns to the screen in the Application where the Browse was initiated  

Navigation Controls 
The “Screen”, “Form” and “Button” controls, access other forms that allow these parts of the 
User Interface to be manipulated. 

Button displays a Sub-Screen that allows the Button to be selected or a New Button to be 
defined.  This list is specific to the Form associated with the Transaction that has been 
selected. 

 

Selection of an entry on the list displays a Screen that allows the function and consequence 
of using the Button to be defined. 
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Buttons are one of the ways of controlling the Application.  Buttons are the most prevalent 
of the Navigation controls.  Various paths between Programs and through the Application 
are controlled by their settings.  The basics are familiar.  

Use – 
• “Button Width”, “Height”, “Top”, “Left” and “ToolTip” as previously described; 
• “Function” to specify the basic consequences when the Button is used in the 

Application.  The colour of the Button, Default caption  and the Navigation controls 
are changed depending upon the Function selection; 

• “Caption” – Change to suit the User Interface.  Changes for this Button will be 
retained until the Function is reselected; 

• “Transfer To” allows selection of the next Program to be activated after any other 
processing required by the Button selection has been completed.  The Programs 
available for selection are those defined in “Program Transactions”; 

• “Ext. Program” allows selection of a Program external to the New Application to be 
activated after any other processing required by the Button selection has been 
completed.  The External Programs available for selection are those defined in “Data 
& Transactions” where the Program name is the Transaction Name and the 
Transaction Type is “EXPT”.  External access is still under development. 

• “Return to Parent Program” ends the Program after any other processing required by 
the Button selection has been completed; 

• “Return to Parent Program on return from Transfer” allows a return from the next 
Program to by-pass this Program on return.  The by-pass will continue until a 
Program is accessed that has this control set to “No” or the Menu is accessed; 

• “Cancel any Auto Return thru the Parent Program” will over-ride the “Return to 
Parent Program on return from Transfer” setting for the Parent Program.  This allows 
the specified action to be suppressed if necessary. 
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Diagram 1 – Return actions depending upon Button settings  

 

Forms 

A Form is a part of the screen that will be transferred to the Server whenever a Button 
inside the Form is activated.  Transmission can also be activated by other displayed 
elements on the Screen which will be covered later; refer - #List Selection.  Use the “Form” 
Button to display a Sub-Screen. 

This allows the familiar “Width”, “Height”, “Top” and “Left” values to be set for the Form.  
The name allocated to the form defaults to the name of the Transaction selected to be 
mapped. 

 

Menu 

Program One 

Program Two 

Program Three 

Button Two 
Access Program And Skip 
on Return  
 

Button One 
Return to Menu 
 

Button One 
Return to Menu 
 Button Two 

Access Program And Skip 
on Return 
 

Button One 
Cancel Skip and 
Return to Program2 
 
Button Two 
Return to Menu 
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The Initial display of the Form can also be suppressed by setting “Display Form” to “No”.  
This is done for the “Password-Mod” form in the Login example since the form is only 
required if the current password has expired.  When the display is suppressed then ALL the 
Text, Data and Buttons within the screen boundary are suppressed. 

Screen 
Each program has one Screen or “User Interface”.  It can be set by selecting the “Screen” 
control.  A Sub-Screen is displayed to allow the Screen to be defined and the current Screen 
dimensions are shown by a Red dashed line. 

 

This allows the familiar “Width”, “Height”, “Top” and “Left” values to be set for the Screen.  
It also allows a border to be set for the screen (if desired). 

Use – 

• “Border Type” to select between “Dashed”, “Dotted”, “Double”, “Solid”, etc. as 
desired. 

• “Border” to define the weight of the border.  Zero causes no border to be displayed.  
The border displays as specified for the “Box Outline” embellishment. 

Screens cannot be deleted once defined, and the new Application Program cannot be 
created until a Screen and at least one Form is defined.  The “Centre” control will set the 
“Top” and “Left” controls so that the screen displays in the centre (both vertically and 
horizontally) of the available Screen mapping area which was set when the Application was 
Added to ENIGMA for definition. 

Drag and Drop 
Any of the Data, Button or Text fields can be moved using a Drag and Drop process.  There 
are some restrictions which will be covered later. 

The Drag and Drop process within Enigma is not the common Drag and Drop that you may 
be familiar with.  The process starts when the cursor is placed within a field and the field is 
“clicked”.  The field is now attached to the cursor, which is reset to the common “move” 
cursor, and the field will move wherever the cursor moves. 

Once moved to a desirable location, click the field again to release the Drag and Drop 
process.  The screen format is automatically updated with the new field location.  

When the screen format is displayed by selecting a Program or a Transaction, any field can 
be dragged.  If the Data, Button or Text formatting screens are displayed, Drag and Drop 
can only affect the field relevant to the display.  The new location will be recorded when the 
field is dropped and will be inserted into the formatting screen. 
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9 Net Program Creation  
Creation of a Net Program requires two basic steps.  Other functions can be done but are 
not necessary for a “Quick Start”. 

The first step is to Extract all the code that uses the definitions that have been entered into 
Enigma. 

The second step is to add fixed code to the extracted code so that the Net Program can be 
created and filed into the new Application library. 

There is an optional step that can be executed between these two.  It is only necessary if 
the Net Program requires some “Custom Code” to add non-standard functions.  This will be 
covered in #CUSTOM CODE IN THE NET SYSTEM. 

Generate Program – Enigma-2020 
With Enigma-2020 use Generation > Program > Current Program to access the 
process for a Program in an Application already selected in Enigma-2020 or Generation > 
Program > Select Program to access the list of Programs defined for the Application or 
use Generation > U/I to generate all the programs in the Application. 

All of the following instructions apply. 

Generate Program (original Enigma) 
Select “Extract Templates > Program” from the “ Generate Net” drop down menu. 

 

A list of the Net Programs which are currently defined in Enigma for the New Application and 
also have valid Screen and Form definitions will be shown. 
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If the program requires regeneration the entry in the list will be highlighted.  Regeneration 
is required if the Screen, Form or Custom Code for the Program have been accessed since 
the last generation of the program. 

Select a Program and then confirm extraction by selecting the “Extract Templates” button.  
When the extraction is complete a message box is shown. 

If “Extract Templates > Application”  is selected from the Menu then every eligible Net 
Program defined in Enigma for the New Application will be extracted. 

Two warnings may be shown when Programs are generated.  They indicate that there may 
be a problem with the program definition – 

• WARNING: No Data found or Too Much Data found for {Transaction:Type}: Count = 
{Amount Found} 

 
• WARNING: Button Count {Amount Found} may be incorrect for Program {Program 

Name}. No Buttons OR Too Many Buttons in Program: 
 
Note these for later consideration and then Click on OK to continue the Program generation. 
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Create Program – Enigma-2020 
With Enigma-2020 use Installation > U/I > Select Program to access the list of 
Programs defined for the Application or use Installation > U/I > All Programs to install 
all of the User Programs in the Application. 

All of the following instructions apply. 

Create Program (original Enigma) 
Select “Create .vbhtml > Program” from the “Generate Net” drop down menu. 

 

A list of Net Programs that have been generated will be displayed. 

 

| 

 

Select the Program to recreate and then select the “Create Program” button.  When the 
generation is complete a message box is shown. 

If “Create ,vbhtml > Application”  is selected from the Menu then every generated Net 
Program for the Application will be created. 

Menu Creation 
When creating a program there may be a need to create the access to the program from the 
Application Menu.  This is controlled by the “Type” shown alongside the Program in the 
Programs list. 
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This code affects the Program Code creation process –  

• “C” – Menu Choice programs will cause the process to check the New Application 
Menu to see if an entry has been recorded.  If there is no entry, then processing will 
be done to create an entry.  Otherwise that processing is by-passed.  Menu Choice 
programs should always be generated individually for the first time to allow the 
Application Menu to be created. 

• “D” – Default program (there can only be one in an Application) will be attached to 
the menu screen process therefore being activated when the Application is started.  
These format centrally and “hang” from the top of the Menu frame. 

• “F” and “S” – Internal Frames and Sub-Programs are expected to be called from a 
preceding program and they do not affect the Application Menu. 

• All programs create entries in the Application Screens table. 

Setting the New Application Menu Entry 
Where a Menu Entry is required, each of the three available Menu levels will be shown in 
sequence to allow the Menu Choice to be entered.  The highest level is the Menu Bar across 
the top of the screen.  Each available choice generates a Dropdown list and the screen 
below shows the initially available selections; 

 

Where there is no suitable Dropdown selection to have the program added to the available 
Dropdown entries, a new Dropdown entry can be specified (as shown below).  Otherwise, 
select the required Dropdown entry. 
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The Entry should be a number which will place the new selection in an appropriate place in 
the Menu Entries list.  If the Entry number is already used, all Entries will be moved down 
(or across) the list to allow the new Entry to be inserted. 

The Record button becomes available when the Menu Text is entered.  Click Record to add 
the new selection. 

NOTE: There are no facilities in Enigma to edit the New Application’s Menu Entries.  Any 
editing has to be done in the New Application using the predefined entry in the “System” 
dropdown menu. 

 

The New Entry is added to the Menu Bar list and can now be selected from the list.  The 
selections available in the Dropdown (currently none) are shown 

 

 

along with a “New” button shown at the bottom of the screen. 
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In a three level menu structure the Dropdown from the Menu Bar can either – 

• Access a Program, or, 
• Access a Group of Programs individually defined at the third level. 

The “New” button allows insertion of a Dropdown Entry which will allow access to the third 
level.  Clicking on “New” results in a message from the program.  

 

Appropriate entries should be made to define this Menu Entry.  The Record button becomes 
available once the Menu Text contains typed details. 

 

Since the Menu Entry is to access a Selection Group the Dropdown list is redisplayed with 
the new entry included.  Selections that access Selection Groups always have “-->” added to 
the typed Menu Text. 

Whether or not this is a new Menu Entry, selection of a Selection Group will show the 
current entries in the Selection Group – 

 

If access to the third menu level is not required, then enter the menu details  
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and click “Record”.  The Menu Text is now attached to the program and the program will 
operate whenever the Menu Text is selected. 

10a Database Program Definition – Enigma-2020 
With Enigma-2020 use Design > Database to access the list of DataBase Tables defined 
for the Application. All of the following instructions apply.  

10b Core Program Definition (original Enigma) 
There is only one definition required for the Core (Database) Program.  The Database has to 
be defined to Enigma.  This Database will be created in the C:\ Enigma Systems\{Short 
Name}\Data\ folder 

Select “Table Definition” from the “Core Definition” drop down menu. 

 

A screen allowing definition of a Table is displayed. 

 

This operates very similarly to the Program definition already described. 

Use the left-hand “New” button to enter the Name of a new Table and the Table Type.   
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A Data Table contains Rows of related data.  A Link Table allows the recording of “One to 
Many” or “Many to Many” relationships between Data Tables.  These relationships are not 
specified to Enigma.  The relationship exists because the same data is included in more than 
one Table and thus the value in the data can be used to relate the rows.  Any data that 
depends for its meaning on both link values can be included in a Link Table. 

If an existing Table Name is selected, then the Data included in the Table will be shown in 
the centre column. 

 

Selection of an entry in the list allows changes to the Database Table definition to be made. 
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Set –  

• P. Key to Yes to define this data as a Primary Key or Part of a Primary Key 
• Create to Yes to instruct the Core System to create an Integer Key value (Counter) in 

this Data whenever a “New” record is added to the Database Table. 

Use – 

• Delete to remove the Table completely from the Core Definition, 
• Exclude to remove the highlighted Data from the Database table definition, 
• Update to change either, or both of, the P. Key and Create settings, and 
• Use the “˅” and “˄” to change the order of the Data in the list. 

The Data list on the right can be used to add or maintain the Data entries.  Mainly it is used 
to select Data for inclusion in a table.  Select Data from the right-hand column to be 
included into the table.  The Data is listed by Core Data Name and the entry in the Table is 
also defined by Core Data Name. 

Notes on Database Design 
When the Core program generates, the generation expects the Database to be a 
“Normalised” database.   

The basic rules are – 

• Primary Keys must make a record in the Table unique.  The key may be one data 
value or a combination of data values.  It should be the minimum quantity of Core 
Data required to define a unique record; 

• Core Data should only be included in one Table unless it is used within a Key; 
• Core Data should only exist once in any record.  If the Core Data may repeat, it 

should be included in a different Table so that the repetition creates multiple 
records; 
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• If the Key is a numeric counter (Data Type = “Counter”) then the table definition 
should show that the Key value should be created - 

➢ To get a Key value created supply it to the Core program as a zero or null 
value; 

➢ Once created, the new value will be applied to ALL records created as a result 
of a Transaction, or sequence of Transactions; 

➢ There is no predictable hierarchy within the Tables, and no need for a 
predictable hierarchy controlling where a new Key will be initially applied; 

➢ Where a record is to be added to the database that is an addition to an 
existing collection (e.g. recording a new child into an existing family), then 
the existing key should be supplied and the key for the addition should be 
zero or null; 

Following these design rules will allow the Core Generation process to minimise the Custom 
Code intervention required to make the Application operate correctly.  (There was more 
discussion on this when #Notes on Database Design was considered.)  To date there has 
been no requirement to create Custom Code. 

11a Core Database Creation – Enigma-2020 
With Enigma-2020 use Generation > Tables > Select Table to access the list of 
Database Tables defined for the Application or use Generation > Tables > All Tables to 
generate all the Database Tables in the Application. 

All of the following instructions apply. 

11b Core Database Creation (original Enigma) 
Database creation uses the number of Core Data Characters, the Data Type, the number of 
Decimal Places and the Initial Value entered into the Data Definition to create the Schema 
definitions for the Core Database tables.  Once the definition is created, it is used to create 
the Core Database table. 

 

One Table (select from the displayed list) or the whole Database can be created.   Re-
creation of a Database Table that exists will destroy any data recorded in the table.  Note 
the warning given under the list. 

 

If the data should be preserved, use Update Schema(s) instead. 

12 Core Database Changes – Enigma-2020 
Table generation is a destructive process.  If the Data recorded in the table is to be 
preserved use Generation > Schema > Select Schema to access the list of Database 
Tables defined for the Application or use Generation > Schema > All Schema to 
generate all the Database Tables in the Application. 

All of the following instructions apply. 

12 Core Database Changes (original Enigma) 
The Core Database can be updated with changes to the Tables.  Typically one Table would 
be changed at a time but you can update the whole database if you want. 
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Select a Table from the displayed list and note the warning given under the list. 

 

The process – 

• Drops any existing Table named {TableName}Old 
• Renames the table being updated to {TableName}Orig 
• Creates the new Table {TableName} 
• Copies the Data from {TableName}Orig into {TableName} 
• Renames {TableName}Orig as {TableName}Old 

The Data copy is done using the defined Column Names for both the new and the original 
table.  Thus – 

• The order of the columns can be changed; 
• The content of the Primary Key can be changed; 
• The update(s) to the Schema can be placed anywhere within the Table definition; 
• The type of the Data in a column can also be changed BUT the change must be 

compatible or the “SQL INSERT INTO” will fail.  Changing Integer to Numeric or 
Integer to String would be OK.  Changing String to Integer would probably create 
errors; 

• New columns will take the Default Value defined in the Initial Value for the Data; 
• Data in Columns that have been excluded from the Table definition will be lost. 

If the process fails you need to recover the original table by renaming {TableName}Old back 
to {TableName}.  Use a utility like CompactView to execute the necessary SQL statement. 

There is no provision for moving data from one table to another.  If that has to be done, 
then use CompactView to execute the required SQL. 

13 Core Program Creation 
Similarly to Net Program generation, Core Program generation is a two stage process.  This 
allows the addition of Custom Code to cover situations that cannot be generated before the 
code is committed to the compiler. 

Extract Templates – Enigma-2020 
With Enigma-2020 use Generation > DA to generate the program for Database access in 
the Application.. 

All of the following instructions apply. 
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Extract Templates (original Enigma) 

 

‘Extract Templates” requires no selections.  There is only one Core Program and a screen is 
displayed to show that the program is operating.  If the generation completes then there is 
a message displayed “Core System Generated”. 

This message may be preceded by other information indicating potential problems arising 
from the generation.  The messages may be corrected by changing the Database Table, 
and/or the Transaction, definitions.  Otherwise they may need compensation by having 
Custom Code added to the generated Core System. 

There is a complex interaction between the Transactions and the Database Tables to 
generate code that will cause the User View of the processing (the Transactions) to be 
applied to the Core System view of the information (the Database Tables and Structure or 
“Technical” View).  This interaction can be reviewed by use of several #1a  Reports – 
Enigma-2020 

Not all reports are directly accessible from Enigma-2020.  To access some then select 
Classic View from the ribbon menu and then follow the instructions below.  Where 
Enigma-2020 does provide direct access, the instructions will be modified. 

1b  Reports.  These are covered later. 

Create Program – Enigma-2020 
With Enigma-2020 use Installation > Data Access to generate the Data Access program 
for the Application. 

All of the following instructions apply 

Create Program (original Enigma) 
Selection of the Instal Visual Basic entry in the Generate Core menu allows either a VB6 
Module or the code for the whole Core System to be created, or re-created. 

 

Creation of the Module or Application will copy all the extracted code into a VB6 structure 
that can then be compiled and deployed. 
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14 Deploying the Core System (Enigma-2020 and original Enigma) 
The Core System has to be a compiled .exe program to operate within the structure created 
by Enigma. 

The VB6 language is used as the base for the Core System.  VB6 provides a most efficient 
compiler which is desirable since the Core System will be a stand-alone .exe when the 
Application is completed. 

Installing the VB6 Suite 
VB6 was released in 1998 but it is still freely available through the Internet and can be 
downloaded if you do not have a copy. 

Access https://masonacm.org\vb6\  Follow the instructions and install the three .msi 
packages downloaded from the site.  This has been installed into Windows 7 and into 
Windows 10 successfully. 

The VB6 suite will be installed into C:\Program Files (x86)\Microsoft Visual Studio\*   
VB6 can be executed by running VB98\VB6.exe from the Visual Studio install.  

Using the Microsoft VB6 suite 
The Enigma generated code is placed into the “C:\ Enigma Systems\{Short Name}\VB6 
{Short Name}” folder. 

Start the VB6 application and then OPEN an EXISTING project with the Short Name of your 
new Application.  The Short Name was defined when your Application was Added through 
#2a Add the Application (Enigma-2020). 

  

(Note: These screens may vary depending on the source of the VB6 application.)   

 

VB6 will provide access to the five modules that make up the Core System. 

https://masonacm.org/vb6/


Version: 1.6 P a g e  | 71  Released: 19th April 2020 

 

The code in these modules can be inspected and altered.  However any alterations will only 
persist until the next generation of the Core System is done. 

The generated code needs to be compiled  before it can be used.  Select “Make 
{ShortName}.exe” from the File menu to compile the code. 

 

Progress on the compilation can be observed at the top of the VB6 main screen. 
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Compiling Re-Generated VB6 Code 
It is most likely that the Core System will require several re-generations before the 
Application operates correctly. 

Once the Application is known to VB6 it can be selected from the “Existing” or “Recent” tab 
and the re-generated code will be opened.  However this does not cause the VB6 suite to 
access the new code.  Use “Open Project” in the File menu to access the new code. 

 

The opportunity is provided to save changes.  This has little effect if you do save or don’t 
save. 

 

Select the project from the Open Project screen to load the new code. 
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The changed Core System can now be compiled and retested. 

Testing the Core System 
Development of an Application in Enigma is done using three modes to control the process – 
see #Appendix 1 – Add Application & Modify Application for details on the “devl”, “test” and 
“live” modes. 

Testing the Core System is started by changing the Development mode to “test” using the 
Modify Application facility.  In this mode the Core System is set to report any errors to your 
work station.  These will show as an Icon appearing in the task bar and can be viewed by 
selecting it.  There may be several errors reported in sequence. 

Use the Core Code Review facilities: 

 

The amount of generated Core code can be quite large and Enigma can take several 
seconds to load the code relative to your selection. 

The loaded code can be searched.  Use the error message details to guide you to the 
appropriate section.  Use the #1a  Reports – Enigma-2020 
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Not all reports are directly accessible from Enigma-2020.  To access some then select 
Classic View from the ribbon menu and then follow the instructions below.  Where 
Enigma-2020 does provide direct access, the instructions will be modified. 

1b  Reports facilities as well to get more information on why any errors occurred. 

Packaging the Core System 
The VB6 .exe file created by the VB6 Suite will run in your development environment but will 
have to be packaged into a .msi file for distribution with your Application if it is to be run on 
Windows 7 or above. 

In a Folder C:\Program Files (x86)\Microsoft Visual Studio\Common IDE\IDE98 may be the 
Microsoft Application Installer you require to create the .msi file.  Run DEVENV.exe   

Point the software at the {short name}.vbp (project) file created by Enigma and then create 
the required .msi file.  You will need to resolve any missing files or dependencies before the 
Core program can be distributed. 

If you do not have DEVENV.exe installed in any Visual Studio XXX package then you can 
unpack C:\EnigmaFiles\Enigma\App_Data\MSInstaller.zip into a temporary library.  Run both 
of the SetUp.exe programs.  These will unpack the necessary files for the Microsoft Software 
Installer.  Run the SetUp.exe in the unpacked files.  This will install DEVENV into the 
C:\Program Files (x86)\Microsoft Visual Studio\Common IDE\IDE98 folder. 
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Part Three A – ENIGMA-2020 SCREEN 
FORMATS 

The basic Enigma-2020 interface has been shown (see #2a Add the Application (Enigma-
2020)). 

This interface is modified depending upon the Action selected for inclusion in the Program.  
For Find, Display, Provide, Record, Change, Remove, Show, Export and Import Actions the 
fields following the Action are formatted thus – 

 

There are two parts to this format – 

 
and 

 
which correspond to the two Transactions created by each of these Actions: (see #4a
 Define the Actions in the Program – Enigma-2020). 

The Content field is used to collect the data that will be  
• accessed from the Core Database (Provide, Display, Show) or External program 

(Import), or, 
• transferred to the Core Database (Record, Change, Remove) or External program 

(Export). 
It is also used to collect the data that is specified in a Find Action which does not transfer to 
the Core Database but only allows a user program to accept Information entered by the 
User. 

The Content field can be used to select Data Names already defined to the Application or to 
enter new Data Names.  Use the   to accept new Data Names. Where new Data Names 
are entered, the attributes for the Data must be specified in the DATA DEFINITION panel 
that will be displayed. 
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This panel is not shown in its entirety.  There are pop-up fields for Decimal Places, Selection 
Lists, Option Buttons, Image Display and Date Edit controls that will be present when 
required.  This panel is the Enigma-2020 equivalent of #Detailed Data Definition for the 
original Enigma. 

The Const. (constant) field is the equivalent of #3 Static Values in the original Enigma.  
Please refer to those notes. 

Data selected for Content is listed on the screen in order of its selection – 

 

The up and down arrows can be used to reorder the Content. The  control can be used to 
remove selected Data from the content. 

The Control field is used to collect the Data required to 

• control access from the Core Database (Provide, Show) or External program 
(Import). 
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It is also used to specify the Data Returned from  

•  the Core Database (Record, Change, Remove) or External program (Export). 
 
The Control field can be used to add already specified Data or to add new Data to the 
control information.  New Data will access the Data Definition panel as already described. 
 
The fields following the Control field are used to refine the location (search for) the 
Information to be returned in the specified Content.  The first allows documentation of the 
Source of this control information.  The second allows a condition to be specified.  The third 
allows a value, or collection of values, to be specified.  The second and third fields are the 
Enigma-2020 equivalent of specifying #2 Search Criteria in the original Enigma.  Please 
refer to those notes for a more detailed explanation. 

When the Control specification is complete the control is used to record the specification. 

Data included in the Control/Returns list is shown in the following list. 

 

The controls operate as described for Content. 

In either list an entry can be double clicked to show the Data Description for that entry. 

 

Double click the display to remove it from the screen. 

The Rules Action is used to specify the Decision Table that defines the conditions for the 
Rule.  This has a different format which is described later when #1a Applying Business 
Rules - Enigma-2020 is covered. 

 

Similarly the Logic Action which is used to specify the use made of a Rule has a different 
format.  It is also described later when #1a Applying Business Rules - Enigma-2020 is 
covered. 

 

This format may also include a requirement to specify a Base Date below the Value field. 

For both of these formats any Data field will allow new Data to be specified or existing Data 
to be selected. 
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Enigma-2020 contains a built-in Help facility.  Double click on any field or control to access 

the relevant help.   
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Part Four – TYPICAL APPLICATION 
OPERATION 

Part Three – QUICK START GUIDE has covered the mechanics of Data Definition, 
Transaction Definition, Program Definition, Screen Mapping, Program Generation, Menu 
Creation and Database Definition.  The method of applying these has mainly been ignored 
so far.  This part looks at a typical Application definition requiring several programs 

USING A PROGRAM 

1 Program Access and Operation 
Programs are defined by the Transactions that are included in the program and the User 
Interface required. 

Application Operation 
We will start this description by selecting from the Application menu.  A screen displays 
allowing the User to enter some information.   

Initiating a process 
Typically this screen will be in a program containing ONE transaction: an INIT transaction.  
(In Enigma-2020 this is a Find Action.) This doesn’t always have to be so: but it is a good 
way to start.  The program allows the User to enter some values into the fields and then ask 
the Application to accept them.  These values will remain within the Application for use by 
the next program accessed by the Control Button. 

A Typical Program 
The next program is more complex and typically contains FOUR Transactions: a request 
(REQ) or enquiry (ENQ) transaction; a provide (PROV) Transaction; an action (ADD, MOD, 
DEL) Transaction and a result (RES) Transaction. (Enigma-2020 uses two Actions: a Provide 
Action and a Record, Change or Cancel Action.)  Typically – 

• The REQ transaction takes the values entered into the previous program INIT 
transaction and SENDS them to the Core System.  Generation of the Core System 
has created a specific path for the REQ transaction processing.  At the same time the 
Core Generation has recognised that the PROV transaction comes next and will do its 
best to fill all the data values in that transaction.  Where the REQ transaction values 
define information that exists on the database, and can be located, that information 
will be provided.  Otherwise the default of empty information will be provided. 

• The PROV transaction is returned to the program which then fills the fields on the 
screen with the values returned: empty or not. 

• The User now does whatever this program is meant to allow within the Application 
design.  This may be to enter new information into a blank screen, or to observe the 
information supplied and make changes.  Once “whatever” is completed the User can 
signal the program to action the entered values. 

• Typically an ADD transaction takes new values and requests the Core System to 
apply them to the database.  Being new values there would not be any keys 
available and the Core System would create the next sequential key for any 
COUNTER defined Primary Key data and would check that a value has been supplied 
for any non-COUNTER Primary Key data.  The ADD transaction can cause new 
records to be added to many database Tables.  Note that the PROV transaction can 
return empty values which can become the trigger for the Primary Key to be created. 
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• Typically, a MOD transaction takes the values supplied and requests the Core System 
to update the database Tables.  All Primary Key values need to be supplied.  The 
MOD transaction can cause records to be updated in many database Tables.  The 
PROV transaction would supply the Primary Key values for the records to be 
modified.  (See also #7 Core Database Operation for variations brought about 
by the type of the database.) 

• Typically a DEL transaction takes the values supplied and requests the Core System 
to delete the record(s) from the database Tables.  All Primary Key values should be 
supplied.  If not then many records containing the values supplied will be deleted.  
Non-Primary Key values can also be supplied to control the deletion.   The DEL 
transaction can cause records to be deleted from many database Tables.  The PROV 
transaction would supply the Primary Key values for the records to be deleted.    
(See also #7 Core Database Operation for variations brought about by the type of 
the database.) 

• The Core System returns a result (RES) transaction to show if the processing was 
successful or if some error was encountered.  Any error will be displayed on the User 
Screen and the processing sequence will be interrupted.  If there is no error then the 
RES transaction can be used to return values to the program.  Typically these are 
any CREATED Primary Key values which makes the created Key value available to 
subsequent Programs. 

• The processing sequence will continue as requested by the control button used to 
action the transaction in the Core System.  This can either be – 

o A return to the initiating program 
o A return to the program that initiated the initiating program; which can 

cascade back through many programs 
o Access to the next program in the sequence required by the Application: refer 

to #Navigation Controls. 

There are other variations of the typical program structure that allow for more complex 
scenarios.  These encompass LIST, LOAD, local (LOCL) and tabulate (TABL) transactions 
and will be covered later (see #LISTS AND TABLES).   

What Happens to the Values 
As a consequence of processing the transactions, the Application has gained knowledge of 
the values entered into, or assigned to, Data.  This knowledge persists until the program 
hierarchy returns to a level prior to when the value first became available.  The diagram 
overleaf explains – 
  



Version: 1.6 P a g e  | 81  Released: 19th April 2020 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 
 

 

Diagram 2 – Data Persistence in Enigma  

2 Program Structures 
As an Application is documented it will become apparent that much of the definition required 
by Enigma is repetitive.  In a typical addition of some new information, or modification of 
some recorded information, then the two programs required will share the request, the 
provide and the result transactions.  The only difference between the programs will be that 
the addition needs an ADD transaction and the modification needs a MOD transaction. 

If this is extended to include deleting recorded information then a DEL transaction is 
required.  The provide transaction may be different to that wanted for the addition and 
modify programs, but does not have to be.  The screen display can be tailored to suit the 
delete requirements by just NOT displaying all the Data provided.  

Reuse of transactions requires some planning.  Enigma contains three facilities to make 
reuse easier which are selected from the Net Definition menu.  (Enigma-2020 selection is via 
the ribbon menu.) 

ReplicateTransactions – Enigma-2020 
Select Replication > Action from the ribbon. 

The following notes apply. 

NOTES:Net 

Net Program One  

Data A = Value 1 
Data B = Value 2 

Net Program Two 

Data C = Value 3 
Data D = Value 4 
Data E = Empty 
Data F = Empty 

Core System 

Send Data (ADD) 

Data A, B, C, D, E, F 

Receive Data (RES) 

Data E = Value 5 
Data F = Value 6 

Net Program Three 

Data G = Value 7 
Data H = Value 8 

Data C = Value 3 
Data D = Value 4 
 
Application Processes 
so  that 
Data E = Value 5 
Data F = Value 6 

 

Send Data (ADD) 

Data C, F, G, H 

Receive Data (RES) 

No Data Returned 

Data C = Value 3 
Data F = Value 6 
Data G = Value 7 
Data H = Value 8 

 

Net Program Two 
cannot ever get Data G 
or Data H. 

Net Program Two has 
values for Data E and 
Data F after the return 
to Program Two 

Net Program Three can 
get Data D and Data E 
but doesn’t use them. 
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Replicate Transactions (Original Enigma) 

. 

The Type allocated to a transaction dictates the Core System processing for that transaction.  
The content of some transactions (ADD, MOD and PROV particularly) is often the same. 

Once one of these is defined, the others can be replicated. 

 

When a Transaction is highlighted, the display changes to show the Data in the Transaction.   
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If this is what is wanted, or is something that can be edited into what is wanted, then enter 
the new Transaction name and Type and click record. 

The program returns to the Menu. 

Any Transaction can be replicated into any other Transaction. However the following 
Transactions are similar and make good candidates for replication –  

• ADD , MOD, PROV and perhaps DEL  (Enigma-2020 – Record, Change, Provide and 
perhaps Remove Actions) 

• TABL and LOAD (see #LOGIC)  (Enigma-2020 – Rules and Logic Actions) 

• INIT, LOCL and LIST (see #LISTS AND TABLES)  (Enigma-2020 – Find, Display and 
Show Actions) 

Replicate Program – Enigma-2020 
Select Replication > Program from the Ribbon Menu. 

The following notes apply. 

Replicate Program (Original Enigma) 
Programs are often very similar in an Enigma system.  Addition and modification have been 
mentioned.  There are also similarities between those programs and typical enquiry 
programs; the latter just displaying the information without allowing any change to be 
made. 

The screen (following) allows an existing program to be selected for replication.  It must 
have a new Program Name and Screen Title defined.  It can then be replicated which causes  

• The new Program to be created, and 
• All of the existing Program’s transactions to be attached to the new Program. 

The new Program can now be accessed through the Program Transactions entry on the 
menu and have the Program Type altered (if necessary) and have Transactions replaced by 
more relevant ones: e.g. an ADD transaction could be replaced by a MOD transaction or for 
an Enquiry the ADD and RES could be excluded so that the program only contains a request 
(REQ) and a provision of data (PROV) for display. 
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Replication is also used with initiating programs (INIT transaction) to allow the same input 
data to access different following programs depending upon the Application requirement.  
Replication for Lists and Tables is covered later when those Transactions are documented. 

Replicate Screen Map – Enigma-2020 
Select Replication > U/I from the ribbon menu. 

The following Notes apply. 

Replicate Screen Map (Original Enigma) 
A replicated program exists exactly the same as a defined program.  To be useful it requires 
a screen to be mapped so that the User can interface with the Application.  The Replicate 
Screen Map screen controls this. 
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From the Mapped Programs listed on the left, the program that forms the template for the 
mapping is selected.  On the right are listed the Programs that are not yet mapped.  The 
centre section shows what will happen if the Replicate Now button is clicked. 

In all probability there will be some tailoring required for the new program’s Screen map.  
This can be changing anything on the screen that can be defined.  Most often the change 
will be to the program navigation sequence.  This can be done through the Map Screen 
Content facility wherever access to the next program (if any) is specified. 

Enigma Internal Structure 
The internal record structure in Enigma allows this reuse of Transactions.  But this can 
create problems later in the development process if poorly considered changes are made. 

Transactions that have Data added to the definition will display that data wherever the 
Transaction is used.  This is not too much of a problem since the added Data will be ignored 
unless positive action is taken to include it on screens.  

Transactions that have Data excluded from the definition will leave screen maps with 
mapped Data that can no longer be accessed by the developer. The excluded definition has 
to be undone BEFORE the field can be excluded.  The only solution to this is to put the data 
back into the transaction and then remove it from the screen.  After which it can be 
removed from the Transaction 

As was stated at the start of the Quick Start Guide, get the Analysis and Design sorted out 
before you begin with Enigma.  That really will save development effort in the long term. 
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Part Five – COMPLEX FACILITIES 

The QUICK START GUIDE detailed the fundamental structures used within Enigma.  The 
basics of Data, Transactions, Programs and Controls are always the way of defining the 
behaviour within an Application. But an Application requires more than just record storage in 
a database.  An Application is of little use unless those records can be interrogated and 
decisions made based on the content of the record. 

The Complex Facilities provide for this. 

LISTS AND TABLES 

1 The List Transaction (original Enigma) or Show Action (Enigma-2020) 
List transactions are defined in the same way as the other Transactions (Actions) already 
considered.  Enigma-2020: Use Classic View to access the original Enigma screens or 
select the Program and the Action from the Enigma-2020 main interface.  However, it is 
easier to access this formatting by selecting Design>User Interface>Current Program 
or Design>User Interface>Select Program and then use the Format button. 

 

This shows the definition of a Person List as specified: see #Table 3 - List of Transaction 
Types .  The transaction has been specified to provide the names of a person (FNm, GNm, 
MNm), the Date of Birth (DOB), the Gender (Gndr) and the Type of Name (NTyp10).  All of 
this data has been flagged to be displayed. 

There are also two pieces of data marked as not displayed.  These are typically the 
identifiers (primary keys) of the records in which the data is located.  In Enigma-2020 these 
fields have to be marked as not visible using the Column Settings. 

The Person Identifier (PPID) identifies the source of personal data (DOB and Gndr).  These 
will always be unique for any one person.  The Name Identifier (NNo) can vary for a person 

 
10 The Type of Name could cover Current Name, Name at Birth, Other Name (Alias), etc.  



Version: 1.6 P a g e  | 87  Released: 19th April 2020 

who has several names recorded and identifies the source of the name data (FNm, GNm, 
MMn and NTyp). 

Because this has been specified as a “LIST” Transaction the control buttons are different to 
those supplied for a basic transaction.  The “Set List” button allows the details of the list to 
be defined.  If the Transaction was specified as a “TABL” transaction then a “Set Table” 
button would be displayed. 

2 Special List Definitions 
There are some reserved words that control special List formatting and selection. 

“List” 
This can be included in the Request Transaction as the ONLY Data being requested.  The 
result is that the Data specified in the List transaction will have NO selection applied to it.  It 
should all be accessed from one Table in the Database. 

“Score” 
Score should be included in the List Transaction as the first column to be shown in the 
display.  Score causes the records that are located for the list to be ranked in descending 
order of probable relevance to the Data and Search Values that are supplied in the Request 
Transaction. 

Score should be used when the records accessed for the list have been found using the 
“LIKE” comparator, or the IN and EQUAL comparators, and (optionally) can have “Rotation” 
applied to the SQL used for the Search: see #Using Search Using and #Search Rotation.  

3 Basic List Formatting 

 
The central section of the above screen has a close resemblance to the lists that have been 
shown within Enigma to list Data, Transactions, Programs, etc. 

• The “Table/List Heading” is an optional entry.  If specified it will be displayed centred 
across the list, in bold text, underlined and in the colour specified in the Add 
Application screen for “Screen Title 1”11 

• “Instructions” allow for the User to be instructed on the use of the list.  This is also 
optional and can contain as many lines as are necessary.  The “Instruction Lines” 
field controls how many lines will be include in the formatted list for the Instructions 
which will display Left justified in the default font. 

• “Table/List Name” is a mandatory requirement that displays centred across the width 
of the table. 

 
11 This may change since the Add Application facility should really allow much more specification than 

currently provided. 
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• The “Table/List Columns” shows the displayed data as specified in the List 
transaction definition.  The Column headings are the Captions specified when the 
Data was specified. 

The central section shows three rows of blank fields to imitate the List.  They are never filled 
when doing a List specification.  The central section can be shifted to the left to show the 
definitions for columns that will not fit within the displayed definition. 

 

The coloured columns (on the right) are the three non-displayed key fields for each record. 

4 Detailed Column Formatting 

 

When the cursor hovers over a column, the column is highlighted and can be selected (click 
the mouse).  The current details for the column are shown in the right hand pane. 

• “Caption” (original Enigma) shows as the column heading and can be changed.  It 
always displays centred on the column width and will determine the column width if 
the width required for the Caption exceeds the specified Column Width; 

• “Caption” (Enigma-2020) shows as the column heading and can be changed.  For 
“Show” it is used as in the original Enigma.  But for “Rules” it contains the X-Axis 
values to be used from Dataname2 to locate the column in the Decision Table.  
Change the Captions as required. 
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• “Visible Column” is a Yes/No flag that allows a column to be suppressed in one list 
while still displayed in another (see #APPLICATION & PROGRAM  STRUCTURE ) 

• “Wrap Text” allows long data, or data including line feeds, to be formatted with the 
row height being automatically adjusted when the data is displayed.  If No is 
specified then the displayed data will be truncated; 

• “Column Width” will adjust the width of the column and hence the list width and 
heading widths.  Use this to balance the columns against the data expected to be 
displayed, the Caption you require, and the available width on the Application 
screen. 

• “Sort Order” affects the SQL Statements used to access the data for the list.  It can 
have values – 

o Alphabetic 
o Numeric 
o No Sort 
o No Value 

Where Alphabetic or Numeric is specified then this column will be used to sort the 
information displayed.  There will also be a “Go To” field included in the list definition 
once Indexed Characters has a value. 

• “Indexed Characters” define the number of leading characters that will be used to 
provide an index to the displayed data.  This is meaningless if there is no sort 
specified for the column.  The “Go To” field will accept the number of characters 
specified to locate the first row satisfying that specification. The “Go To” field does 
NOT display the character(s) keyed - 

o For a One Indexed character specification, “C” would access the first row 
starting with “C” and then keying “H” would access the first row starting with 
“H”; 

o For a Two Indexed character specification, “C” would access the first row 
starting with C and a following “H” would access the first row starting with 
“CH”.  The next character keyed (say “S”) would access the first row starting 
with “S”; 

o The Escape key (Esc) can be used to force a restart of the selection with the 
next character keyed being a first character; 

o Selection of a row from the list also forces a restart of the selection with the 
next character keyed being a first character; 

• “Highlight Value” allows the specification of a value which will cause the row to be 
highlighted.  This can be used to emphasise some characteristic within the 
information shown:  e.g. that regeneration of the program is required.  The value 
must exist in this column and usually the column is defined as Not Visible; 

• “Primary Key” is used to define this column as containing the primary key for the 
data being displayed.  Refer to #Mapping a Typical Search screen 

• “Shift Column” allows the columns to be moved to the left, or the right, to reorder 
the display when in Screen Mapping.  Otherwise the control clears the column data 
being displayed.  To reorder the columns when defining a List use the Up and Down 
controls to reorder the #6 Adding Data to the Transactions content. 

The “Clear” button clears the data from the right hand pane.  The settings entered for the 
column are stored in memory until the Apply or Record is used.  Most of these changes do 
not have an immediate effect on the display.  
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5 List Types, Data Sources and Selections 

List Types 
Enigma allows for two types of List – 

• Dynamic Lists are constructed from data held in the Core System.  So far this Part 
has only considered a Dynamic List situation.   

• Static Lists are constructed in a similar manner but reside in the Net System.  They 
usually provide a selection of settings based upon some key factor. 

For clarity, from here on when a “List” is mentioned it will normally, but not always, contain 
Core System information and when a “Table” is mentioned it will always contain Net System 
settings.  Both are defined as detailed in this part of the manual. 

The left hand Pane in the display is used to specify information for each type. 

 
• “Standard Buttons” allow a “Table” to have the New, Delete, Change, Remove, 

Reinstate, Clear and Close functions automatically generated when Enigma 
references the Table.  This cannot be set for “Lists”. (See #LOGIC for more detail.) 

Selection List Sources 
• “Automatic Transfer” causes the selection of a row in this List to transfer from the 

program where the list is displayed to another program.  The selection list that is 
displayed contains all the programs already specified through the - 
o 7a Defining a Program – Enigma-2020 

or the 
o 7b Defining a Program (original Enigma) facility.  If the required program is not 

yet available leave this selection blank.  It can be added later.  There can be no 
Automatic Transfer attached to “Table” definitions. 

• “Data Source” – This will be “Transaction” for “Lists” that come from the Core 
database or “Net DB Table” for “Lists” that come from the Net database.  For 
“Tables” the Data Source will always be “Net DB Table”. 

• “Data Base Table” – When defining a “List” using “Transaction” as the Data Source 
this will always have no selections available. When defining a “Table” this will contain 
the database Table names created for Tables that have been generated while 
generating the Table maintenance programs.  For access to other Tables held in the 
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“C:\EnigmaData\Enigma-Systems.sdf” Database, a record has to be added to the 
DBTables Table.  This situation will be addressed in a later release. 

List Selection 
Selection of a row from a “List” can have varying effects depending upon the situation found 
during processing. 

The normal effect is to have the Application transfer to the program selected for Automatic 
Transfer.  However, this can be varied by requesting a Process Loop. 

Note: Enigma-2020 does not support Process Loop in the ENIGMA Version 2 release. 

• “Process Loop” causes the redisplay of the “List” after a row has been selected.  A 
“Yes” entry implies that there will be some Process applied to the selected row and 
then the program will restart reflecting the result of the process.  (E.G. – if a 
program shows two lists, the selection of a row on one, may cause that row to be 
moved to the other.  The redisplay would confirm that action.) 

• The action required on selection is defined in the Program definition by including 
another Transaction following the LIST transaction.  This is the only situation where 
a LIST transaction is followed in the Program definition by another transaction.   At 
the present time the ENIGMA application assumes that the LIST transaction will be 
sandwiched between the REQ transaction used to load the list and the following 
transaction. 

• Consequently the only exit from the Program will be via the actions specified for the 

Button controls included on the screen. 

There is another alternative that is automatically applied by Enigma and occurs when an 
Automatic Transfer is requested and a row is selected. 

Let us suppose that an INIT transaction specifies some search criteria to be applied to the 
Core database.  Then a list of information that has been located is going to be displayed 
using a LIST transaction.  (Enigma-2020 – the Show Action.)  This List may contain – 

• NO records – the search criteria returned no information, 

• ONE record – This all the search criteria could find, or 
• MANY records. 

If there are NO records then the Application could define that the search criteria requires a 
NEW set of information to be created.  There is no point in displaying the list so the LIST 
program could be by-passed.  Set “Show Message?” to No to cause this. 

Alternatively, the Application could define that the search criteria MUST provide a list of 
records.  In this case a message is displayed and the program returns to have amended 
search criteria entered.  Set “Show Message?” to Yes to cause this. 

If there are MANY records then the User can be invited to select the information they want, 
or to use the search criteria to create a new set of information. 

If there is ONE record returned that perfectly matches the search criteria then we can 
automatically use it as if it had been selected by the User. 

Depending upon the circumstances, information selected by the User maybe information to 
be updated OR maybe information that should not be updated.   Consider a tradesman 
already connected to a number of clients.  If a new Client is entered into the Application and 
then the Tradesman is selected, we would not want to change the Tradesman’s information, 
but we may well want to display a lot more detail than is in the “List” to confirm the 
selection. 
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Logically there are four paths that can be taken and Enigma can create the appropriate 
code.   

The diagrams illustrates the logic –  

 

 

 

 

 

 

 

 

Diagram 3 – List Selection where the Selected Information should be protected 

Program 3 would be the transfer attached to a Button control from Program 2 and Program 
4 would be the transfer attached to an Automatic Transfer in the List specification.  

 

 

 

 

 

 

 

 

Diagram 4 – List Selection where the Selected Information should be protected and the 
Search Criteria MUST return Information 

If the Application requirement does not need selected data to be protected from change 
then make both the Button and the Automatic Transfer reference Program 3; as shown 
below. 

 

 

 

 

 

 

 
 

Diagram 5 – List Selection where the Selected Information does not need protection 
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If the search criteria MUST return information AND the information does not need protection 
from change make both the Button and the Automatic Transfer reference Program 3, and 
request a message in the List specification. 

 

 

 

 

 

 

 
 

Diagram 6 – List Selection where the Selected Information does not need protection AND 
the Search Criteria MUST return Selected Information 

Exit from the List Definition 
Changes that have been applied while formatting the list are not recorded by Enigma until 
the “Record” button is clicked.  Once that has been done the screen map will show the 
change when the List is reselected on the Mapping screen. 

Using the “Close” button will abandon any changes made to the List format and leave it as it 
was when the screen map was first displayed. 

List Replication 
In most Applications there will be Lists that are required many times but where each List is 
required to provide access to different Programs.   This is done by Replicating the List 
Program and then Replicating the screen map to provide the base to which the changes can 
be applied. 

To get the different Program access the relevant Button control can be changed as well as 
the access due to selection of a record from the List. 

Since an Enigma developed Application operates by giving a User one Net program at a 
time, the duplication is not a complication.  The duplication also preserves the 
predominantly “black box” structure that applies to ALL programs in the New Application.  

Altering Lists and Tables 
Changes can be made to the Transaction definition of a List or a Table even after it has 
been mapped to a screen. 

Add or Exclude data in the Data and Transactions facility.  Use the Up and Down keys to 
shift the data to where it belongs in the column sequence. 
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Mapping a Typical Search screen 
 

 

The screen map shows two transactions when selected for mapping.  The “LOCL” 
transaction displays the information entered into a previous screen.  Typically this was done 
through an INIT transaction.  It has been mapped so that the information is protected and 
has been given two control buttons.  When the transaction is selected these can be 
changed. 

  

   

The thick line below the Search Criteria display is drawn as an empty text area.  Selection of 
it from the text list allows it to be altered in size and location. 
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Note that the Height has been set to zero, the Border has been set to one and the text has 
been set to bold to create the thick line.  These settings will over-ride any settings made in 
Embellishments for the “Box Outline”.  For vertical lines set Text Width to zero instead of 
Height. 

Mapping a screen for a List or a Table is different to mapping a screen for a single set of 
data.  When the List transaction is selected a Location Details screen is displayed. 

 

This allows the list to be placed on the screen and to have a number of Rows specified.  
This number is the amount that will display at any one time, NOT a limit on the total Rows 
to be selected for the list. 

There is also a “Format” button available which allows the List format to be changed as has 
already been discussed (see #LISTS AND TABLES).  This allows the width of the columns in 
the list to be fine-tuned to suit the screen display, or Programs to be selected for Automatic 
Transfer, or the Database Table to be specified for TABL transactions. 

Any changes made using Format will not be displayed until the List transaction is reselected 
in the Screen Mapper. 
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SEARCH PARAMETERS and STATIC VALUES 
 

While Enigma provides controlled navigation between programs, it does not automatically 
provide for variation within a program.  Variances in screen format are limited to allowing, 
or suppressing, displays of Forms within a Program.  Similarly, the default comparator when 
listing records is equality, or whatever was chosen when the Data was defined.  This may 
not be suitable all the time. 

Searches for records for inclusion in Lists can be influenced by defining the required search 
specifications.  Changes to screen formats and/or content can be influenced by simple “If 
Then Else” #LOGIC. 

1 Searching for List content 
The Data specified for a List transaction can be gathered from one, or more, database 
tables.  Enigma will sort out the requirement and create the necessary SQL statement to 
conduct the interrogation. 

There are three distinct parts to the generated SQL – 

• The data to be returned for the list 
• The WHERE clause search criteria for the primary, or only, database table 
• The INNER JOIN clauses to connect the selected Primary Table to Secondary Tables 

containing other data required for the list. 

The data to be returned for the List is defined in the LIST transaction (in Enigma-2020 the 
Show Action). 

Lists can be of three general arrangements - 

• The first is a list from one table containing one column only.  This would typically 
cover a set of actions that are relevant to some criteria.  The list might show which 
had been done or which had not been done.  This requirement is requested by using 
a data name of “List” as the first data in the REQ transaction; 

• The second is a list from one table that contains several columns.  This will be 
generated without any SQL Join conditions being generated; 

• The third is the more usual list where the data will be sourced from many Tables.  
This will be generated using SQL Join conditions to link the various tables required to 
access the data. 

The WHERE clause data and parts of the INNER JOIN clause data are defined in the REQ 
transaction.  (In Enigma-2020 the Control definition of the Show Action.) How that data is 
used is important to controlling the search. 

The WHERE clause will only use the Data specified.  Additionally that Data will be searched 
for using the Value supplied by the Net System to the Core System.  This applies even if the 
value is empty, space or zero: refer to later discussion on this. 

In contrast the INNER JOIN clause will use the Data that is common within the Primary and 
Secondary Tables to link records together.  By definition this is Key data.  This clause may 
also use values specified in the REQ transaction to limit the returned list records.  However, 
if Data is not specified in the REQ transaction, that Key will not be used within the INNER 
JOIN clause.  Enigma decides this as the SQL statements are constructed. 

Values for Data come from three sources in an Enigma Application – 

• From the database as a result of a request (REQ) transaction, 
• Input by the User into a program,  
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• Specification by the developer of Static values which are relevant to the request 
being made. 

While the Value limits a search, the way the Value is compared also affects the resultant 
selection of records for a List.  This can also be specified by the developer. 

2 Search Criteria 
When the Program Definition was documented there were two controls that were bypassed 
at that point.  The screen below shows both control buttons and it is the “Search Using” 
control that will be documented first. 

 

 

In the SelectRelation Program there are three Transactions.  The LOCL transaction is used 
to display the User entered values that will be used while searching for the list content. 

The REQ transaction specifies the data that will be used while searching for the list content.  
By default the User entered values will be used for this data.  But there may not be values 
entered for all the data that should be used. 

Similarly having all the values compared on an equal basis may not satisfy the criteria on 
which the search should be based. 

The Search Using control allows compensation to be specified within Enigma. (In Enigma-
2020 use the Condition and Value fields when specifying the Control Data.) 
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Using Search Using 
When the Search Using button is selected the data defined for the REQ transaction is 
displayed. 

 

The screen shows the Data Name, the comparator (Comp.) and the Value to be applied.  
This Transaction has been specified for testing purposes and is not typical of the usual 
situation. 

There is no value shown for DOB (Date of Birth).  This shows that whatever the Enigma 
Application knows about DOB will be used.  Typically this would also apply to the next four 
Data names in the list but values are shown for illustrative purposes.  The last Data name 
(Role) is shown with three values in sequence.  It specifies that if Role has any of these 
three values, the record should be selected. 

Both Comp. and Value can be changed by selecting a Data Name from this list.  Role is used 
as an example: 

 

The Screen shows – 

• The comparator chosen, and, 
• The data description entered for the chosen data 

The Comparator can have one of a defined list of values (shown below) and affects the way 
the search will be done.   
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Most of the selections are self-evident and would either use a Static value or a value already 
known to the Application.  The others cause the SQL query to be modified - 

• IN would usually have a list of Values (as shown in the example); 
• BETWEEN would have two Values; lower first and higher second; 
• LIKE would have a single value which has to exist within any data being selected.  

Typically this would be a User entered value; 
• PARTDATE would cause the Date supplied to be extended to include all possible 

Dates if the Date supplied is a Partial Date.  Otherwise the whole date is used with 
an equal comparator; 

• ROTATE indicates that the Search value will be used by other Data in the Request 
Transaction when constructing the SQL to locate the List Information. 

Note: SQL syntax is not required around the values.  Enigma sets that as required 
for use with VB6. 

Where a value is left blank then any value already known into the Application will be used 
with the comparator.  Conversely, where a value is entered, it will override any value known 
to the New Application.  Where a value is not known and is not supplied, that Data in the 
REQ Transaction is not used in the WHERE clause for record selection.  This can have 
unexpected consequences when retrieving data.  Consider the WHERE and INNER JOIN 
clause notes above. 

Enigma also protects the Core program when there is no specification of a Search value and 
hence no specification of the comparator for Data included in in the REQ transaction.  The 
comparator defaults to “=” and the value to be found defaults to space or zero depending 
upon the data type of the Key.  This may adversely affect the records returned compared to 
the records expected to be returned. 

There is a special case covered internally in Enigma; data retrieval specified as PARTDATE.  
That state is only known at the time of executing the program so Enigma applies some 
rules.12 

Partial dates can have the format yyyymm00, yyyy00dd or yyyy0000.  Retrieval is done 
using either the BETWEEN predicate where the days are unspecified, or uses the IN 
predicate where the days are specified and the month is not. 

 
12 Enigma applies many rules based upon your definition of the Analysis and Design for the 
Application.  These will be covered as the Enigma method is documented.  This is one of the few 

rules where the data being supplied requires a Late Binding rule to be applied. 
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The Partial date is the lower bound of the BETWEEN clause.  The upper bound will be the 
Partial date with 12 inserted as the month if the month is 00, and with 31 inserted as the 
day if the day is 00.   

Where only the month is unspecified, the Partial date is used 12 times in the values 
associated with an IN clause.  Thus the values are yyyy01dd  yyyy02dd  …….  yyyy11dd  
yyyy12dd.  

Enigma sets these if a Partial date is used as a Search value in a request for multiple sets of 
data. 

Search Rotation 
Search Rotation can be specified to apply to Data with LIKE comparators OR to Data with IN 
and Equal comparators. These cannot be combined and only one set of rotated Data can be 
specified for any List REQ Transaction. 

The generation of the SQL to search the Application database will create OR clauses for 
inclusion in the WHERE clause defining the access to records from the primary table.  These 
OR clauses will include all of the Search values associated with the Rotated Data for each of 
the Rotated Data in the REQ Transaction if a value is available to the Core Program. 

Rotated Data is signified in the #Sample Check Data Selection Report (Composite) where 
Rotated Data will show a comparator prefixed with “R”: e.g. “RIN”. 

Rotation cannot be applied to the Data using the other comparators. 

Static Value Search Criteria 
While the IN clause allows selection of records if the data contains any one of the values in 
the IN list, it is also possible to specify single values using an Equal comparator.  For 
example: specifying Gender = F will limit selections to Females only. 

The Search Criteria Scope 
Search Criteria specified for a Program only affect the operation of that program. 

The criteria will be applied in either the WHERE or INNER JOIN clauses of the SQL 
statement as appropriate. 

The selection criteria specified for a LIST transaction can be reviewed using the #  
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Check Data Selection – Enigma-2020 

Select Bench Test Operation > Show to access the report. 

The Application must be selected before the report will display.  The following notes apply. 

Check Data Selection report. 

3 Static Values 
Static values or Constants can be created using the Static Values button.  (In Enigma-2020 
enter the value in the “Const.” field of the Content definition.) These are useful to record 
values that are dependent upon the process being done, rather than upon a value entered 
during the Process.  For example: a person could be recorded as an Applicant and another 
person could be recorded as an Agent of the applicant.  Most probably this situation would 
be defined by the processing for each person, rather than by a User entry.  The former is 
controlled and reliable where the latter is prone to User error.  Therefore it is better to use a 
Static value to signify the difference which would be defined in each of the Applicant, and 
Agent, data entry programs. 

Creating Static Values 
The screen below displays if the Static Values button is clicked.  It shows the Data included 
in the selected transaction.  While the transaction is fixed in its data content, its use in a 
program is not fixed.  Transactions can be reused.  Any values specified will only be applied 
within this use of the transaction, in this program. 

 

 

The Static Values button can only be used with Transactions that move Data from the Net 
System to the Core System. 

The “Data Name” column shows the name in the Core System that has been allocated to a 
piece of Data.  The Core name is used here because any Static values that are specified will 
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become the value of the Core data.  The “Value(s)” column shows the Constant value that 
will be recorded in the Core Database record. 

If a Data name is selected (click on the row) then the Constant Values screen is displayed. 

 

The Data Name, Transaction and Program are all specified from the selections already made 
and are detailed in the top text.   

The Data Description is the Description entered when the data was defined.  In this case it 
shows the abbreviations used when a relationship between two persons is selected from a 
selection list. 

One of these values can be entered into the Values area.  That value will be recorded in the 
Core database.  The short value will be translated if the record is displayed in the Net 
System. Any Static values that need to be displayed to the User should have a selection list 
defined so that the Static Value can be translated to show its meaning to the User. 

Static Values are usually specified for “Add”, “Mod” or “Del” transactions and the Value will 
usually be recorded on the Database.  Their application can be checked by reviewing an 
appropriate report. 

ADD transactions should be checked using the #Check Add Records – Enigma-2020 

Select Bench Test Operation > Update > Record to access the report. 

The Application must be selected before the report will display.  The following notes apply. 

Check Add Records report. 

MOD transactions should be checked using the #Sample Check Change Records Report 
(MOD) report 

DEL transactions should be checked using the #Check Delete Records (original Enigma) 
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The sample report for #Check Delete Records shows the report that results from the 
Transactions required to Delete a Next of Kin record.  It is almost identical to the report 
already considered for adding information. 

The most notable difference is that all the “linking” Database tables are not shown.  Since 
the intent is to change a record that exists, none of the links should be altered. 

This list shows exactly the same detail as will be generated within the Core System to 
process the Transactions specified for the NextOfKinDisc program.  The Core System 
maintains a History mode database. 
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Check Data Selection – Enigma-2020 
Select Bench Test Operation > Show to access the report. 

The Application must be selected before the report will display.  The following notes apply. 

Check Data Selectionreport. 

DEL transactions can also have Static values defined for the data.  However the effect is 
totally different. 

Specification of a Static value for use by a DEL transaction will provide an extra limit on the 
records deleted by the transaction.  Thus both Key and Static value will determine the 
extent of the deletion from the database.   

These transactions were discussed at some length in #The Change Class (DEL) section.   
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LOGIC 
 

Within Enigma, logic is primarily applied in the Net System using Tables.  The Tables reflect 
the structure of a Decision Table and can be used to – 

• Change displayed values, 
• Change the displayed screen, or, 
• Change the Program sequence 

depending upon some condition.  Tables are defined using the Tabulate (TABL) transaction 
(Rules Action) and the Tables are accessed using the LOAD transaction (Logic Action). 

Enigma is built upon the premise that the products of Analysis and Design should be 
sufficient to create most of a working program and that working programs can be connected 
to create a working Application. 

1a Applying Business Rules - Enigma-2020 
A major addition to Enigma was made in the Enigma-2020 release.  It allowed the 
automation of the Business Rules required by an Application in a similar manner to the way 
Data and Transactions are automated. 

The Business Rule is considered in two distinct parts: the actual rule is defined by a Rules 
Action and use of the Rule is defined by a Logic Action.  Considering the Business Rule in 
this way allowed one Business Rule to be applied in many programs (if that is necessary for 
the Application. 

As with the original Enigma, specification of a Business Rule is effectively the definition, and 
use, of a Decision Table.  The model is pictured in the following diagram – 

 

DataName1 will contain the value to be examined to locate an entry in the Y-Axis of the 
Decision Table.  DataName2 will contain the value to be examined to locate an entry in the 
X-Axis of the Decision Table.  The intersection of the row and column will contain the result 
that is dependent upon the X and Y Axis values.  This Result will be applied to DataName3. 



Version: 1.6 P a g e  | 106  Released: 19th April 2020 

In Enigma-2020 there are nine examination methods available.  Not all apply to both Axes.  
The following decision table shows the application of the nine methods.   These will be 
expanded in future Enigma releases. 

 

Business Rules - Specification 
The specification of a rule is started by selecting a Rules Action.  This provides the following 
screen format - 

 

The following details are required- 

• Y-Data – Select an existing, or enter a new, Data Name.  For new Data Names the 
Data Definition panel will be displayed; 

• Find By – This allows selection of the Y-Axis evaluation method to be selected; 
• X-Data – Select an existing, or enter a new, Data Name.  For new Data Names the 

Data Definition panel will be displayed; 
• Find By – This allows selection of the X-Axis evaluation method to be selected; 

• Action – This allows the action to be taken when the Result is located to be selected; 
• The number of X-Axis alternatives is required when this cannot be deduced from the 

X-Data selection. 

The X-Data Find By selection of “Default” will provide a single X-Axis column and effectively 
allows a translation of one DataName value into another.  The X-Data DataName and the 
Find By method of Default are linked so that one will always specify the other. 

The Y-Data Find By methods of Before, Greater and Permitted will always create an action 
of True/False and will display an error message to the User if a False result is obtained.  
These evaluations are documented in the original Enigma section (below). 
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Otherwise the actions of Decrement, Increment, Move Value or Work Days are applied and 
DataName3 is used to store the result. 

The Business Rule must be saved once it has been specified.  The specification is then 
displayed as – 

 

This display of a Business Rule will be shown when a saved Business Rule is selected for 
modification or for application. 

Business Rules must be specified in their own program so that the Result can be entered for 
each intersection using the New Application. 

Business Rules - Application 
The application of a Business Rule is included in a Program by inclusion of the Logic Action 
in the program. 

The Logic action provides a screen format allowing the rule to be selected, DataName3 to be 
selected or entered, any over-riding condition to be specified and the Data containing a 
“Base Date” to be selected or entered (if required). (The base date is not shown in the 
screen shot.) 

 

The Business Rule allows selection of one of the Business Rules already defined for the 
Application.  By convention the Business Rule name, the Table in the User database and the 
Menu entry in the Application Menu all take the name given to the Program in which the 
Business Rule was specified. 

When selected the Business Rule is displayed. 

 

The Receiving Data is DataName3 in the Business Rule model. 

The three fields Apply If, condition (not captioned) and Value allow application of the 
Business Rule to be suppressed if the condition, when applied to the Apply If data value and 
the specified value, evaluates to True.  Both the Apply If data and the Value must be greater 
than space otherwise the evaluation will default to Ture. 

The Base Date will be shown below Value when it is required for a Timeline Y-Axis 
evaluation or a Work Days action. 

Timeline Evaluation 
The value used to locate the Y-Axis row when using a timeline is the value in DataName1 
minus the value in the Base Date.  Both must be Dates represented in the yyyymmdd format 
(the Enigma default).  Subtraction will result in an eight digit integer that can then be 
compared to the alternatives specified for the Y-Axis.  The entry to be located is the first in 
a top-to-bottom evaluation that tests greater than the result of the subtraction. 
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Work Days Action 
The result obtained by locating the intersection of the Y-Axis row and the X-Axis column will 
be added to the Base Date.  That result will then be adjusted to allow for intervening non-
work days.  (A 5 day work week is assumed and weekends are covered but public holidays 
are not.)  The adjusted result will be placed into DataName3. 

Logic Inclusion 
The Business Rule application using a Logic Action is very flexible. 

Many Logic Actions can be included in a Program.  Each Action will be evaluated whenever 
the value in DataName1 or DataName2 change.  The Apply If evaluation (if specified) is 
checked first followed by DataName1 and DataName2 both of which must have value before 
the rule is applied. 

More than one Logic Action can be applied to one DataName3.  The result in DataName3 
will be the consequence of evaluating the first Logic Action that can be validated, followed 
by the second, and third, and so on.  These will be randomly included, depending upon 
when the evaluation above is successful.   

NOTE: The order in which Logic Actions are included in a Program has NO 
influence upon the order of application. 

The values in DataName1 and DataName2 can be changed by the User after the initial 
evaluation.  This will result in the Business Rule being re-applied.  Once re-applied, any 
Business Rules that were previous applied to DataName3 after this Business Rule will also be 
re-applied to DataName3. 

This is depicted in # 
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Appendix 9  –  Business Rules Application. 

1b Applying Logic (original Enigma) 
Most Analysis of Application requirements will contain one or more Logic Charts or Decision 
Tables (depending on how you wish the name them).  They all have the general structure –  

 

 

 

 

 

 

Diagram 7 – General Decision Table structure 

TABL transactions emulate the Decision Table structure and all are two-dimensional arrays. 

Where a higher dimensioned array is required (three, or four, dimensions etc.) it is 
necessary to create an “index” to the two dimensional table that is relative to a selected 
third or fourth dimension.  Selection from the index then allows selection relative to the 
correct lower dimension values. 

2 The Tabulate (TABL) Transaction (In Enigma-2020 the Rules Action) 

Table Definition and Access 
Tables are described using the “TABL” transaction.  TABL is almost the same as LIST which 
has already been covered 

There is nothing special about the transaction definition, or the connection of the transaction 
to the program, or the mapping of the data into a screen.  What is a bit special though is 
that the data will only be used in the Net environment and therefore does not need a Core 
Data name.  (Remember that when defining Data only the Net Data name was mandatory.)  
Also a program with a TABL transaction will only have that transaction: no others. 
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The generation of a Program to process a TABL transaction will create the database table in 
the Net System database and record the name of the Table in the “DBTable” table.  This 
provides the data for Database Table selection on the List definition screen but it will only be 
available after the initial Program generation since that Table is named after the program 
that creates it. 

“Standard Buttons” will create seven buttons in the pattern shown and program generation 
will provide all the code needed to perform the functions. 

• “New” provides blank fields for entry or selection of the required value 
• “Record” will commit a New record to the Database 
• “Remove” will logically remove a record from the Table by flagging the record as 

“Inactive” 
• “Reinstate” will logically restore an Inactive record to an “Active” state 

• “Change” will commit a Changed record to the Database 
• “Clear” will reset the screen to its original state 
• “Close” will close the screen without recording any changes. 

The following examples are NOT automated in the Enigma-2020 release.  They can still be 
created manually by using the original Enigma menu and facilities. 

 

The data for this Table all comes from Selection lists.  While the logical Yes/No maybe 
trivial, the Button selection is not.  The Button selection translates the Button Caption into 
the Button Element ID as shown below.  The Element ID can then be accessed for use in 
Javascript code to display or hide the button according to the logic defined in the Table. 
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Setting up a Selection list of this nature is a manual process.  Enigma does not provide any 
more than the program for the list maintenance, the screen layout and the definition of the 
Database table where the list can be stored.  Entering the content is part of the 
“programming” process using original Enigma. 

Table Data Storage 
The Table data is stored exactly as shown on the preceding Table screen.  Each row is a 
database record in the Table and each entry constitutes an entry in a Column.  Selection of 
a row from a “Table” places the data into fields where it can be maintained.  Otherwise the 
fields can be cleared and a new row of information entered into the “Table”. 

Data in the Table should always be displayed by ascending value in the left hand column.  If 
a “Go To” control is desired it should be set to reference (index) the first column. 

3 The LOAD Transaction (In Enigma-2020 the Logic Action) 
The values entered into a Table will be intended for use in one or more Programs. 

To access the details in the Table, a “LOAD” transaction is defined having the same 
structure as the “TABL” transaction.  The Load transaction is included in the Transaction List 
for any program that needs to use the Table logic, preferably at the start of the 
Transactions for the program. 

There can be many Tables loaded for one program. 

Each Load process will read all the rows in the Table and place each field in the row into an 
Array corresponding to the database column.  This provides the Enigma view of the Table – 
a structure of related arrays which contain the column values arranged by column sequence 
across the rows of the Table. 

The examples shown previously are complex.  Tables can be very simple. 

Simple Logic 
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The screen shows Parameter entries where the Priority Days value is dependent on, or a 
Parameter of, the Service Type.  (This is an Enigma-2020 “Default” table.) 
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Enigma has a standard Javascript routine which will search one column for a value and then 
return the associated parameter.  Call –  

getp(array-to-search, value-to-find, value-to-return) 

“getp” will return the value in any column in the selected row, so the table can be more 
expansive that the example above. 

Time Based Logic 
 

 

The parameters to be returned from the screen above are dependent upon the age of a 
person.  (This is an Enigma-2020 “Timeline” evaluation.)  The Age breaks are –  

• 3 or less years,  
• between 4 and 6 years and  
• between 7 and 17 years and  
• 18 years and over.   

Enigma contains a standard Javascript routine to search a timeline of this nature. Call –  

  timl(array-to-search, base-date, reference-date, value-name) 

The routine will take each of the “Age < ” values and add it to the base date.  If the base 
date is then greater than the reference date the correct parameter row has been located.  
The value in the entry in the column having value-name is returned. 
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Permitted Values (not automated in Enigma-2020) 
 

Permitted Values returns a true/false result from relating a key value to a set of values that 
could exist in another field.  The parameters form a Table like - 

 

Values Other Field Values 

Search Value Field 1 Field 2 Field 3 

O Y N Y 

D Y N N 

H Y Y Y 

U N N N 

 

Each cell in the Table should be set to Y or N depending upon the validity of having the two 
values existing at the same time.  To use the function call – 

if (pmit(search, value) == true) { 

   } else { 

   } 

 

Despite having some Javascript functions available to search the loaded Table, it is still 
necessary to access the functions; which introduces the concept of Custom Code, which is 
covered in the next Section.  However, first some notes on useful tests. 

4 Useful tests 
Two useful tests are built into Enigma: isGE(frm, fld1, fld2, txt1, txt2) and isB4(frm, fld1, 
fld2, txt1, txt2).  The quantity of these tests will probably increase as more situations arise 
from experience in using Enigma. 
 
isGE requires the following parameters and compares values– 

• frm – the form id where the values are defined 
• fld1 – the id of the first value 
• fld2 – the id of the second value 
• txt1 – a text reference to the first value; usually the caption 
• txt2 – a text reference to the second value; usually the caption 

If fld1 is greater or equal to fld2 the test returns a true result.  Otherwise an error message 
is displayed to the User and the focus is reset to fld1. 

isB4 requires the following parameters and compares dates – 

• frm – the form id where the dates are defined 
• fld1 – the id of the first date 
• fld2 – the id of the second date 
• txt1 – a text reference to the first date; usually the caption 
• txt2 – a text reference to the second date; usually the caption 

Dates are generated in Enigma as three related HTML Input controls.  The id of the controls 
are always xxxxndd, xxxxnmm and xxxxnyyyy.  The id required in the “isB4” call is the xxxxn 
part of the id. 
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If both fld1 and fld2 resolve to 8 digit dates AND if fld1 is greater or equal to fld2 the test 
returns a true result.  Otherwise an error message is displayed to the User and the focus is 
reset to fld1. 
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Part Six – CUSTOM CODE   

Enigma can generate the majority of each Program in an Application.  There may be a need 
for code to be added in both the Net and the Core Systems to increase the generated 
functionality.  

CUSTOM CODE IN THE NET SYSTEM 
 

 

Custom Code can be entered into any of the VB.Net, Javascript or HTML parts of a Net 
Program to provide for specialised functions.  It should only be added where there is a 
^*Ref=xxxxx*^ statement: see #General Notes on Traps for the Unwary later in this 
section.  Custom code added at any other place will lose its place in the generated program 
if any change is made that alters the section numbering: e.g. an added field or an added 
text. 

1 Javascript 
The following notes apply to entering Custom Code into the generated Javascript: 

• Enter large Javascript routines as a bundle toward the start of the generated 
Javascript 
 

 
 
Reference these routines from appropriate places in the generated Javascript or 
HTML 
 

• Reference Javascript routines in the “Body” section if they should process whenever 
the Program is loaded.  Add to the existing “OnLoad(…..)” statement 
 

 
 
(Here the chkCompany()  function call has been inserted before the call to the 
standard flagLoad() routine.) 

 
• Custom Javascript can also be added in the second Javascript section at the end of a 

generated program.  That code will function after the program is loaded and before 
the screen is displayed. 
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2 HTML 
• The generated HTML specification for screen display fields usually contains “onxxxxx” 

function calls to Javascript routines.  Primarily these routines control the default 
behaviour of the Backspace key [onkeydown] (see - #Backspace problems and 
control) and provide editing and formatting functions [onchange]. 
 

 
 

The “setAgent();” function call is actioned as a second function in the [onchange] 
event because the closing quote for that event has been generated prior to the end 
of the select HTML definition. 
 

• The following HTML definition is for a display only selection list value.  Again control 
of the Backspace defaults has been actioned through the “onkeydown” event which 
would normally be closed by the quote in line 01649440 02.  However, in this case 
there is an “onfocus” event inserted using the code on line 01649439 2003.  The 
closing quote for the “onkeydown” event starts the inserted code and the “onfocus” 
event does not have a closing quote included. 
 

 
 
Where closing quotes are generated in following sections of code, care has to be 
taken to get the syntax correct if “onxxxx” event calls need to be added to the 
generated code. 
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• Javascript routines can also be accessed after the generated “onclick” events for 
Button controls. 

3 VB.Net 
Within VB.Net the usual place for Custom Code is within the “Post” or “Get” sequences 

• Within the “Post” sequence the code is usually to over-ride, or add to, the transfer to 
the next program.  Additions might be placing a value into a Session Variable so that 
it can act as a parameter for the next program.  Note however that the use of #Static 
Values can supplant this need. 

• Within the “Get” sequence it may be that activation of this program is to be aborted 
under certain circumstances or that certain values have to be set before the program 
commences. 

• Sub or Function routines must be placed within the @Functions to @End Functions 

portion of the code. 

4 General Notes on Traps for the Unwary 
 

 

Custom Code can be placed anywhere within the generated program BUT should only be 
placed at the end of a section containing a comment “^*Ref=xxxxxx*^”.   

All of the generated code is sequenced using a variable numbering system.  As an example 
– 

• The HTML screen field definitions are ordered using numbers 
• If a new field is added to the screen which could be for input, selection or text 

display, the numbers of all fields following will change when the program is 
regenerated 

• Custom Code is protected from this change in numbers by being attached to its 
location by the reference.  The custom code will be renumbered appropriately during 
re-generation. 

You will also see that there are very large “gaps” in the numbering within generated 
programs.  These occur because the program being generated contains less of some feature 
than Enigma is coded to create.  Custom Code entered into these “gaps” is not guaranteed 
to be always available, and may inter-mingle with generated code giving very strange 
results. 

5a Entering Custom Code – Enigma-2020 
Select Custom Code > Program from the ribbon menu. 

The following notes apply. 

5b Entering Custom Code (original Enigma) 
Custom Code can only be entered after a Program has been extracted and before it is 
created.   

Select Review Program Extract from the menu  
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and then select the program from the list on the left.  This list will only contain programs 
that have been extracted and have NOT been flagged for re-extraction due to changes 
made to the underlying program structure: e.g. the screen contents and/or map. 

 

The program listing is shown on the right.  The time taken to extract and display this listing 
will vary according to the size of the program. 

 

The notes at the top of the listing detail the control keys available.  Particularly useful are – 

• Control + F – Adds a bar to the top of  the screen where the search text can be 
entered; allows next and previous searching; provides a count of the matches found; 
can get confused with the list on the left – Click inside the program list to attract its 
attention 

• BackSpace – If this is used immediately after some Custom Code has been entered 
and recorded the listing display should reset to the location as it was when the 
request for Custom Code addition was made.  (For unknown reasons this textbox 
facility sometimes fails.) 

A Section of Extracted Code 
Extracted code is sequenced by Section Numbers followed by Line numbers.  Line numbers 
are the sequence of the code within the section.  NOTE: Section numbers have been 
changed since this sample was inserted and are now 8 digits long. 
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This section of Generated VB.Net code shows a lot of importance: 

• Line 20031 06 contains a comment showing that we are looking at the code that will 
be processed if a Connect button is clicked.  The Connect comes from the caption on 
the button. 

• Lines 20031 10, 20032 03 and 20033 14 all contain a “^*Ref=xxxxx*^” comment 
and are contenders to have Custom Code added 

• Custom Code has been added to section 20033 after the 14th line which is the last 
line in the section.  Custom Code always is inserted after the last line in a section. 

Entering Custom Code 
If a section number (ignore the line number) is entered into the Section field and enter 
pressed, Enigma will display a screen where Custom Code can be added or edited. 
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The section selected already had Custom Code specified, so that code is displayed in the 
bottom pane.  If no Custom Code had been entered only the three comment lines would be 
displayed.  The upper pane contains the code generated for this section.   

Use the Delete, Save and Clear buttons as usual.  Save or Close will return to the listing 
screen.  Remember to use BackSpace to reposition the listing after return. 

The listing will not recreate at this point so any new Custom Code will not be apparent.  The 
listing only contains Extracted Code and previously entered Custom Code.  Many other 
routines are added when the program is created. 

Editing Custom Code 
Another access into editing Custom Code is to select from the menu. 

 

A list of programs containing Custom Code is shown top left of the screen and if one is 
selected the Sections containing Custom Code are listed below. 

 

Selecting section 20033 will display the Custom Code we have already considered.  Section 
34946 displays a Javascript function in the large pane.  This can be edited or deleted or just 
reviewed as appropriate – 
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CUSTOM CODE IN THE CORE SYSTEM 
This facility is provided but so far there has been no requirement to use it.  It was intended 
to allow compensation for deficiencies in the Core Code generation analysis of the 
Transactions and the Database structure. 

1a Reviewing the Core Code – Enigma-2020 
Select Custom Code > Data Access from the ribbon menu. 

The following notes apply.  

1b Reviewing the Core Code (original Enigma) 
The actual Core code that is generated can be reviewed by selecting Core Program Review 
from the Generate Core dropdown menu. 

 

Then select the section of the Core Code you wish to review. 

NOTE: The selections are listed in order of the VB6 Modules to be reviewed.  The more 
code, the longer the delay before the Code is displayed.  CTRL-F will allow entered text to 
be found after the display happens. 

For every Transaction there is a Custom Code routine that can be accessed and have code 
entered.  While Custom Code can be added within the main generated code, as opposed to 
the specific routines provided, that practice is strongly discouraged.  Use the Custom Code 
selection to access the generated routines. 
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The screen clipping shows the general section where large Custom Code routines can be 
entered.  These routines can be referenced from the specific Custom Code Function set for 
each Core-to-Net Transaction. 

 

The screen clipping shows the generated code where Custom Code could be added for a 
Transaction called Person:List.  Enter the eight digit number that starts the Custom Code for 
the Transaction into the Section field.  Your first Custom Code line will be line number 2000 
which is automatically allocated. 

2 Entry of Custom Code 
The Core System is generated in VB6 and any Custom Code must conform to the VB6 
standard. 

Any Subroutines or Functions should be placed at the start of the Custom module.  These 
can then be referenced from within the Custom function created for the Transaction.  Minor 
or unique code can also be placed into the Custom function. 

3 Edit Custom Code 
Custom Code can be edited by re-selection from the Core Program Review display or by 
selection of the Edit Custom Code entry in the dropdown menu. 

Operation of this edit facility is similar to the Edit Custom Code facility provided for the Net 
Program Code except that only sections within the Core System are displayed. 

4 Custom Code Considerations 
The access to the Custom Code routines is referenced in the generated code at a point 
where Data moved from the Net System into the Core System is available to the Custom 
Code if required.    

There is also a reference that allows the manipulation of Core Data before it is transmitted 
to the Net System. 
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Part Seven – THE APPLICATION MODEL 
(Revisited) 

APPLICATION & PROGRAM  STRUCTURE 
 

Having covered most of the requirements for creating an Application in Enigma, it is now 
beneficial to re-visit the structure into which the Application will be placed. 

Some of this has been mentioned while detailing the requirements.  That is repeated here to 
place the whole Enigma approach and consequences together. 

1 Application Structure 
 Applications created using Enigma have the structure shown below: 

 

This structure suits the Internet since each User has a unique path to process information 
relative to the database.  Having Applications created according to this model has a large 
influence upon the way Enigma should be used. 

The structure is also used to create Applications designed to run using an intranet, a local 
area network, or locally upon a PC.  There is a great flexibility in the way even one 
Application can be installed and utilised. 

The best way to use this flexibility is very specific to the requirements of each Application.  
The Core Database does not need to be installed on the same computer as the Core System.  
Nor does the Core System need to be installed on the same computer as the Net System.   
The Net Database does not need to be on the same computer as either of the Net or Core 
Systems.  The Users can access their own copy of the Net System or a common copy of the 
Net System.  The latter can be accessed either through the Internet, a Wide Area Network 
or a Local Area Network. 

Utilising this flexibility, when installing an Enigma created Application, is not a subject for 
this manual but #Appendix 10  –  Application Implementation is included which considers 
this in more detail.  It is very Application and Installation specific and should be considered 
carefully.  What is important is that a developed Application can be installed in any of the 
above scenarios without alteration. 
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2 The Program Structure 
So far the User Guide has covered a way to get a Quick Start, a way to handle more 
Complex situations and how to create Programs and Applications.  By now the lack of 
detailed Logic and Instruction statements is probably becoming apparent.  They are not 
available because the model does not require them. 

Custom Code has been covered.  It is not intended that it will, or should be, a way of 
compensation.  Custom Code should be used to tailor one Program to the Application 
requirements. 

The Enigma program structure derives from the characteristics of the Internet model.  

As with One User having their unique path within the Internet for a process, so one program 
will have one unique function in an Enigma created Application.  Consequently, if we need to 
maintain a set of records, there should be – 

• A program to Add (ADD) a record 
• A program to Modify (MOD) a record 
• A program to Delete (DEL) a record. 

If a record is to be Added, then there should be something to enquire if the record already 
exists. 

If a record is to be Modified or Deleted, then there should be something to locate the 
appropriate record. 

So Modification and Deletion both require a method of record location.  The difference only 
applies after the record is located. 

Supplying programs to get a located record having two outcomes (Modify or Delete) cannot 
be done by Enigma.  Instead two distinct record location programs have to be created each 
of which will access a program to perform one of the requirements. 

This does not cover the record location to check that there are no records; as required by 
the Add record situation.  This could be a third record location program or it could be a 
decision covered by the fact that LIST processing has two exit possibilities.  Thus we could 
either ADD a new record if nothing is found or use an existing record if one is found.  Which 
is best depends upon the Application Design (see: #List Selection). 

Backspace problems and control 
The default actions within the Internet consequent upon pressing the Backspace key can 
cause havoc within an Enigma generated application but can also cause some beneficial 
behaviour when used in different situations. 

The default actions arising within the Internet from use of the Backspace key are – 

• Within an input control;  
o remove the character preceding the cursor location, OR, 
o if there are no characters in the field, no action occurs. 

• Within a selection list control; 
o Immediately exits the program and reverts to the previous program. 

• Within a button control; 
o Immediately exits the program and reverts to the previous program. 

• Within a program where a transfer has been forced to another program using 
Custom Code; 

o Reverts the focus to the field which caused the transfer on return from the 
other program. 
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It is the immediate exit action that Enigma controls by suppressing the default backspace 
actions.   

All button controls have this suppression built-in to the generated definition.   

Selection list controls have this suppression built-in except if the selection list control is the 
first control in the Tab sequence for the program.  Providing this exception allows the 
default backspace action on return from a forced program transfer to occur if the selection 
list control happens to be the first control accessible by the program.   

3 The Transaction Structure 
Similar programs that essentially dictate the sequence of programs within the Application 
allow the reuse of the Transactions required for each program.  This is intentional. 

The Request (REQ) transaction will have the same data included for all of the Lists just 
considered, so it might as well have the same Transaction name. 

The List (LIST) transaction supplying the information for record location will be the same but 
the Navigation for each List will be different. 

Add (ADD) and Modify (MOD) transactions are essentially the same.  It is what happens in 
the Core System that makes the difference. 

It was recommended earlier that transactions should be carefully named so that transactions 
affecting similar entities are grouped together as in the example below. 

 

The transactions in this list come from an operational Application.  They all relate to an 
Agent acting on behalf of someone else.  They are used in sequence through several 
programs: 

• Agent:Init – Input the Search parameters; 
• AgentList:Req – pass the search parameters to the Core System; 
• Agent:Locl – Display the Search parameters; 
• Agent:List – Display the information located by the Core System; 
• Agent:Req – Request information on a specific Agent; 

• Agent:Prov – Provide information on a Specific Agent which can have content, or no 
content: either way it is still providing the information available from the Database; 

• Agent:Add – Add a new Agent; 
• Agent:Mod – Modify an existing Agent; 

• Agent:Del – Delete an existing Agent; 
• Agent:Res – Provide a status on the result of processing the preceding Transaction.  

This can also provide details of the key values allocated during ADD transaction 
processing. 
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If it is desired that existing Agents should be attached to more than base record (e.g. 
Clients) then – 

• AgentConn:Prov – A different Provide transaction to handle the different information 
needed to verify the attachment of the Agent to an additional base record; 

• AgentConn:Add – A different Add transaction so that an Existing Agent can be 
attached to another base record. 

The following Diagram illustrates this reuse. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Diagram 8 – Reuse of Transactions 

This is a very typical sequence of transactions required to control a group of related 
functions within an Application.  The repetition is obvious.  Also obvious is the number of 
programs required to provide for maintenance and use of one entity in an Application. 

On the other hand: Each program is effectively a “Black Box”.  Each has one function and 
only one function.  Enigma will not allow more. And replication drastically reduces the time 
required to create the eight programs shown. 

4 The Data Structure 
Ultimately the Core System provides the database processing for the new Application.  It is 
controlled by the data contained in each of the transactions and by the sequence of those 
transactions. 

Thus a REQ transaction will be followed by a PROV or a LIST transaction.  Both PROV, or 
LIST, define the Data that the Core System should return to the Net System.  The REQ 
transaction provides the parameters, or controlling values, which dictate how the returned 
data should be found.  (The Enigma-2020 Actions of Provide and Show include both the REQ 
and PROV, or LIST, as appropriate.) 

ADD transactions cause the Core System to create a new rows in the database.  Where the 
key values for a row are not supplied then 

• If it is a numeric key the Core System will create it.  More than one key can be 
created by a transaction 

• If it is a character key then the Net System must supply it or an error eventuates. 

Search 1 
Agent:Locl 
AgentList:Req 
Agent:List 

Search 2 
Agent:Locl 
AgentList:Req 
Agent:List 

Search 3 
Agent:Locl 
AgentList:Req 
Agent:List 

New Record 
Agent:Req 
Agent:Prov 
Agent:Add 
Agent:Res 

Modify Record 
Agent:Req 
Agent:Prov 
Agent:Mod 
Agent:Res 

Delete Record 
Agent:Req 
Agent:Prov 
Agent:Del 
Agent:Res 

Connect Record 
Agent:Req 
AgentConn:Prov 
AgentConn:Add 
Agent:Res 

Initiation 
Agent:Init 
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ADD, MOD and DEL transactions will fail if the REQ transaction parameters do not result in 
access to a unique record. (The Enigma-2020 action of Provide will fail if the access is not to 
a unique record.)  

The RES transaction can return the key values used by the Core System during the process, 
the result of the process, and error messages.  Getting the key values created during the 
process is most important if later in the program sequence various records should reference 
the one just recorded. 

Data Definition 
Very early in the User Guide, data was defined by having a Net Data Name and a Core Data 
Name.  Attached to these are a lot of details to describe the data.  Some of these relate to 
the way the Net System will use the data and some relate to the way the Core System will 
use the data. 

It is necessary that a Net Data Name exists for every data definition made for the new 
Application.  It is not necessary that a Core Data Name exists but if it does not then the 
Core System will not recognise the data. 

Mention has also been made that the Net System should provide for the User view of the 
Application and that the Core System should provide for the Technical data storage and 
retrieval.  It has been recommended that the database design should be very strictly 
normalised.  If there is any ambiguity in the design, then the Core System will fail to provide 
consistent information. 

Thus there is a Net System view of names as they relate to the various people who may be 
processed within the new Application: i.e. a Client name is different to an Agent name as far 
as the User view is concerned.  The Core System should see both as a “Name” if the 
normalisation is achieved.  The Core System should attach a tag to the name to indicate its 
“role”: i.e. Client or Agent.  In the future this will allow for the Agent to become a Client of 
the current Client who would then also become an Agent.  The point being, that in the 
database each Name retains its integrity despite its use being varied, and despite the User 
thinking of the Client and the Agent as different “roles”.  They are different roles; but they 
can have the same name. 

This can cause immense problems in the Net System.  Both of the Client and the Agent will 
be identified uniquely as they are recorded by the Core System.  If the identifications are 
returned to the Net System then they can be confused, one with the other, if they do not 
have unique Net Data Names.  Consequently Enigma can translate the Core System data 
name into one of many Net System data names.  So we have – 

• Core System Name translated to Agent Net System Name 
• Core System Name translated to Client Net System Name 

The Net System can process both but cannot pass both to the Core System in the same 
transaction.  Nor should the Net System want to do that since each program has one 
function which should not affect both a Client Name and an Agent Name at the same time.  
However, the Application may want to display both Client and Agent at the same time.  This 
can be done by requesting the provision of multiple sets of information for use by the one 
program. 

Data persistence was covered in #What Happens to the Values and a review of that is 
recommended. 
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5 Core Database Structure 
The Core Database is defined using the Define Table facility in Enigma.  The definition is 
deceptively simple but there are rules that have to be strictly observed. 

Every Core data definition used by a Transaction has to occur in a database.  Data contained 
in the Database Tables will either – 

• be contained in one table only, or 
• be Key data that uniquely identifies a record in a table which can therefore require 

the data to be repeated in several tables. 

Key data that repeats creates relationships between one table and another as shown in the 
small relationship sample below: 

 

(Diagram courtesy of Microsoft ACCESS relationships facility.) 

Careful consideration of the Key data and the non-Key data is required. 

The Key fields of PID, Name_No and Appl_No each identify a table record that only contains 
data that is pertinent to the Key. 

The Tables ApplPeople and NameLink contain two Keys and Join the data in each keyed 
table together.  They allow many Person records to be attached to one ApplDetl record or 
many ApplDetl records to be attached to one Person record.  Similarly NameLink allows for 
attachment of Names and Person records though in this case it is unlikely that one Names 
record would be attached to many Person records. 

The NameType table is different.  It allows for recording of what is essentially a repeating 
group of data since one Name can have different types at different times. 

6 Activity Recording 
Within Enigma there are logging facilities to track the operation of the New Application.  
These are optional in the sense that they do not have to be activated.  However the facilities 
to allow for them will always exist. (In Enigma-2020 use the Y/N selections to specify which 
logs are required.) 
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Change Data Log 
The Change Data log is held in the Change_Log table.  It can be activated by request in the 
Add Application or Modify Application facilities.  It records – 

• A Timestamp for the change; 
• A sequence number within the Timestamp for the change; 
• The Operator Id of the operator making the database change; 
• The Transaction followed by the generated SQL statement. 

Only Request, Result, Add, Delete and Update statements are kept in the log. 

Its primary use is to aid in solving execution problems within the Core System. 

The Diary 
The Diary is held in the Diary table.  It can be activated by request in the Add Application or 
Modify Application facilities and requires that the Change Data Log also be activated.  It 
records – 

• A Timestamp for the change; 
• A sequence number within the Timestamp for the change; 
• The Operator Id of the operator making the database change; 
• The Transaction Name and Type being processed; 
• The Action being performed; Insert, Delete or Update; 
• The Table Name being changed; 
• The Net Program Name requesting the Core System action. 

Only changes to the database are kept in the Diary. 

Its primary use is to aid in solving execution problems within the Core System. 

By combining the Diary with the Change_Log using the Timestamp and Operator ID a clear 
view of the User processing can be obtained. 

7 Core Database Operation 
The Core Database can operate in one of two modes; 

• Snapshot, or 
• History 

Snapshot shows details of the records at the time when a request is made for information.  
So if a modification is made to the data in a table record only the end result of the 
modification is known.  There is no record of what was in the data prior to the modification.  
The actions taken to get the data to that point are recorded but not correlated and are 
primarily for tracing application malfunctions. 

History, on the other hand, does correlate the actions and the sequence of changes made to 
the records can be interrogated.  To get a History The Diary has to be selected in the Add 
Application or Modify Application facilities and the data base has to have certain fields 
included in the Tables. 

Specific Table Requirements for History  
Enigma can cause the update of many Tables when one Transaction is processed.  To 
correlate these updates a timestamp field has to be included in every Table.  This field is 
specified to be “TRecd”: for Time recorded.  Enigma will set this field content and keep the 
same value for all tables that are changed by one Transaction. 

Enigma will also use TRecd to ensure that information returned to the Net System will 
contain the most recent information from the Core database. 
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Two further fields that are specified are required in every link table.  These are 
{Table13}Conn and {Table}Disc.  {Table}Conn records a Timestamp when the Link was 
Connected and {Table}Disc records a Timestamp if the link is Disconnected. 

Disconnected links are not used by the Core Processing when joining tables to provide 
composite information in response to a request. 

An Enigma Timestamp is constructed using the Date and Time down to milliseconds.  Disc 
and Conn may, or may not, have the same value as TRecd.  This is not important to the 
Enigma process. 

Design Considerations implicit in History 
Having a History style database does cause some different processes to be required.  Every 
change to the database is an “addition” of a new record into a Table.  We want to be able to 
see what changed, so modifications are treated as additions by Enigma. 

Similarly if we wish to sever a connection between two records, we cannot just delete the 
link.  The link has to be retained so that the History can be traced.  The link would be 
severed by use of an addition causing the Disc field to be set.  

Similarly, records cannot be culled from the Database.  Once they are recorded they have to 
be retained in case they are connected by some now disconnected link.  Enigma DOES NOT 
evaluate the consequences for delete transactions when in a History mode.  The monitoring 
has to be done by the developer. 

History is also going to have an impact on the growth of the Core Database.  It will be much 
larger than the same database used for a Snapshot view of the information. 

  

 
13 {Table} = Table name in the Database design. 
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Part Eight – MONITORING TOOLS  

1a  Reports – Enigma-2020 
Not all reports are directly accessible from Enigma-2020.  To access some then select 
Classic View from the ribbon menu and then follow the instructions below.  Where 
Enigma-2020 does provide direct access, the instructions will be modified. 

1b  Reports (original Enigma)  
The reports available within Enigma are designed to allow monitoring of the end-to-end 
definition of the New Application being developed in Enigma.  Select from the Reports 
dropdown menu. 

 

 

Detail contents for all reports are shown in Appendix 3.  

Net to Core Trace 
This report requires a large amount of SQL interrogation of the Enigma database and takes 
a long time to generate.  A warning message is displayed and the time starts when you use 
the report button. 

 

 

The left side shows information from the Net System.  The right side shows information 
from the Core System. 

Blocks are colour coded as described at the base of the screen.   

In general, for a program there will be at least one green section and one blue section.  In 
the print, the ActnList program is only showing a blue section.  This should cause 
investigation to explain how the Core System is triggered to provide the Data to the Net 
System. 

There are also two Cream entries.  These signify that the data is supplied by the Net System 
but is not recorded in the Core System database.  There is nothing intrinsically wrong with 
this.  The highlight just allows the situation to be brought to attention. 
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Purple sections signify that the data is supplied from within the Net System. 

Brown sections show that the data is completely unknown to the Core System.  There is no 
recording in the Core database and no Transaction moving the data from the Net System to 
the Core System.  These should be reviewed and corrected. 

Program Chart 
The Program Chart report shows the Menu Structure on the left and the Program Navigation 
on the right.  It should be used to verify that the navigation corresponds to the Application 
Design. 

The Program Navigation can be extended to 20 levels.  Programs repeat where they are 
reused within the New Application. 

Data Chart 
The #Sample Data Chart Report shows the data being requested in the transaction sequence 
for individual programs. 

This report requires a lot of generation and is now limited to showing details for one Menu 
Item at a time to avoid a timeout during generation.  Select from the list to start the 
generation 

 

The Menu Item heads the report which is then broken into the programs used by the Menu 
Item.  The program name heads each section.  In brackets after the name is the source that 
starts the program.  This can either be a Menu Entry (as in Record Actions in the example) 
or a Program (as in ActnSrch in the example).   Generally the programs start to process 
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from a Menu Entry and then through the sequence of programs that form the hierarchy 
commenced by the Menu Entry. 

The Transactions list from left to right.  For each Transaction the Data in the Transaction is 
listed.  Where a Transaction to the left has already listed the Data, the next Transaction 
using the Data lists the data in the same row.  The second Data Chart screen in the 
examples shows this clearly across the six Transactions. 

Where a Program has been previously detailed in the report, only the Program entry is 
shown.  Search (Ctrl-F) for the Program name to locate the detail.   This summarisation 
reduces the size of the report and prevents looping if program A calls program B which calls 
program A (either directly or with other programs intervening within the sequence). 

Program List 
The program list allows a Program to be identified from the program number.   

 

The program Number is shown in the top right of the User Interface 
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and is included in screen displays to aid the User of the New Application in identifying the 
program in which a problem occurred. 

The SQL Check Reports 
To follow the SQL Checking reports it is necessary to have knowledge of a Core System 
database structure within which the SQL has to operate. 

The following is the structure covering the persons associated with an application for 
something; which is irrelevant to the discussion, except that the Key “Appl_No” will exist so 
that the Persons can be associated with the application (see table ApplPeople). 

 

(Diagram courtesy of Microsoft ACCESS relationships facility.) 

PID (Personal IDentifier) is a unique numeric identifier created by Enigma to identify each 
person attached to the Application. 

Name_No is a unique numeric identifier created by Enigma to identify each Name associated 
with the person.  This allows for name change by deed poll, marriage, divorce, etc. 
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Name_Type is an alphabetic indicator of the type of the Name: e.g. Current Name, Name at 
Birth, etc.  A Name can be of more than one type.  This key must be supplied by the Net 
System (refer: #SEARCH PARAMETERS and STATIC VALUES). 

Role is an alphabetic indicator of the role the person plays in the application: e.g. Applicant, 
Spouse, Relation, Third Party, etc.  One person can have many roles in different 
applications. 

The “Identity” table defines the person.  Its contents are immutable facts about the person.  
Many other tables hang off it via the PID. 

The small keys indicate the primary keys defined for each table. 

The interconnecting lines show the relationships defined between tables.  They are shown 
for graphic purposes only since Enigma does not contain any relationship information.  
Instead Enigma creates the relationships, as required, for each Transaction.  This allows the 
database structure to be changed easily.  All that is required to install a changed structure is 
re-creation of the changed tables or changed schemas and then regeneration of the Core 
System. 

Check Add Records – Enigma-2020 
Select Bench Test Operation > Update > Record to access the report. 

The Application must be selected before the report will display.  The following notes apply. 

Check Add Records (Original Enigma) 
The sample report for #Check Add Records – Enigma-2020 

Select Bench Test Operation > Update > Record to access the report. 

The Application must be selected before the report will display.  The following notes apply. 

Check Add Records shows the Data that will be manipulated when executing the ChildAdd 
program.  This is a typical structure for adding information to a database. 

The “Child:Req” transaction shows the data being provided to the Core System.  This should 
contain an existing “Appl_No” since the Child is being added to the Family associated with 
the application for something.  However, the “PID” and the “Name_No” should not contain 
meaningful data (for both that will be Zero or Null).  Since those key values are not 
supplied, and since this is a New record, the values will be created within the Core System. 

The next columns in the report show details of the Database tables that will be affected by 
processing this Add transaction.  As can be seen the Tables extend across the database.   

Identity contains data that is basically immutable for a person (ignoring gender 
change); 

Name Type contains data that defines the type of the name being recorded; 

Names contains details of the actual name; 

Family links the Child to the relevant Family group associated with the application; 

NameLink attaches the details of the Names to the Person (effectively to the Identity 
record). 

For each Table the whole data recorded in the Table is listed.  Alongside the Data is an 
indicator if the Data is part of the Key to the Table and if the Data can be created 
automatically when a record is added. 

The next columns show details of the Transaction FROM the Core System that will be sent to 
the ChildAdd program.  This Data is organised according to the database table from which 
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the Data is (or could be) derived.  Data is listed in common rows according to the Database 
Tables list. 

The final columns show details of the Transaction TO the Core System that will contain the 
details that define the new Chid within the Application. 

Generally the Transactions FROM and TO the Core System will be identical for an addition of 
new information.  This is not always the case.  It is the interaction between the Data 
required for these Transactions and the initial “REQ” Transaction and the Database Table 
definitions that determine the list shown. 

This list shows exactly the same detail as will be generated within the Core System to 
process the Transactions specified for the ChildAdd program. .  The Core System maintains 
a Snapshot mode database. 

Check Change Records – Enigma-2020 
Select Bench Test Operation > Update > Changes to access the report. 

The Application must be selected before the report will display.  The following notes apply. 

Check Change Records 
The sample report for #Check Change Records – Enigma-2020 

Select Bench Test Operation > Update > Changes to access the report. 

The Application must be selected before the report will display.  The following notes apply. 

Check Change Records shows the report that results from the Transactions required to 
Change an Agent record.  It is almost identical to the report already considered for adding 
information. 

The most notable difference is that all the “linking” Database tables are not shown.  Since 
the intent is to change a record that exists, none of the links should be altered. 

This list shows exactly the same detail as will be generated within the Core System to 
process the Transactions specified for the AgentMod program. .  The Core System maintains 
a History mode database. 

Check Delete Records – Enigma-2020 
Select Bench Test Operation > Cancel to access the report. 

The Application must be selected before the report will display.  The following notes apply. 

Check Delete Records (original Enigma) 
The sample report for #Check Delete Records shows the report that results from the 
Transactions required to Delete a Next of Kin record.  It is almost identical to the report 
already considered for adding information. 

The most notable difference is that all the “linking” Database tables are not shown.  Since 
the intent is to change a record that exists, none of the links should be altered. 

This list shows exactly the same detail as will be generated within the Core System to 
process the Transactions specified for the NextOfKinDisc program.  The Core System 
maintains a History mode database. 
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Check Data Selection – Enigma-2020 
Select Bench Test Operation > Show to access the report. 

The Application must be selected before the report will display.  The following notes apply. 

Check Data Selection (original Enigma) 
The Sample report for #  
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Check Data Selection – Enigma-2020 

Select Bench Test Operation > Show to access the report. 

The Application must be selected before the report will display.  The following notes apply. 

Check Data Selection shows details of the derivation of the Lists specified in the New 
Application in this case the derivation for the SelectRelation program.  This program should 
list all the Relations attached to any Applicant for something.   

The actual requirement shown is to – 

SELECT all people in the database 
WHERE the Family Name contains “Davis” 
AND the Given Name contains “David” 
AND the Middle Name(s) contain “Miles” 
AND the Date of Birth is specified by as much as is known 
AND the Person’s Gender is Male 
AND the Person’s Relationship is Child, OR Next of Kin, OR Other Relation. 

 
To provide a list of information to satisfy the “REQ” Transaction for the program it may be 
necessary for the Core System to get information from several Tables within the Core 
database.  Getting this information may require the “joining” of various tables and may 
require the “joining” through tables that do not provide any data to the list. 

The left side of the report shows that the initial request (transaction RelationList:Req) will 
provide a specification for this List comprising the Names, Date of Birth, Gender, and Role of 
records required for the list.  Details of the specified #2 Search Criteria are shown 
alongside each field.  (Note: This report shows much more specification of criteria than 
would normally be required.  This is for demonstration purposes and it uses the specification 
shown earlier in the #2 Search Criteria.) 

The data to be selected is listed on the right side of the report (transaction Relation:List).  
Below is also shown what data is going to be derived from which table.  In this case four 
tables are involved: “Names”, “Person”, “NameType” and “ApplPeople”. 

On the left side, below the request data, are details of the selection logic that will be applied 
by the SQL statement to be generated to provide information for the list.  The “WHERE” 
clause will be applied to the Table shown and will require three fields to comply with the 
search predicate and value and specified in the “REQ” Transaction.  The result derived from 
the “WHERE” clause will then be applied to “NameType” to provide data for the list and to 
“NameLink” to provide the “PID” required to access the “Person” table.  “NameLink” does 
not provide any data for the List but is necessary to provide a value to locate “Person” table 
records.  The “Person” Table is joined on the “PID” field (as derived from the “NameLink” 
join) and the “DOB” and “Gender” fields (as specified in the request) and to “ApplPeople” on 
the “PID” and the “Role” (as specified in the request) to provide other data for the List. 

The report should be used to check that the combination of the “REQ” data, the “WHERE” 
specification, the “JOIN” specification(s) and the Core Database design will produce the data 
required for the List. 

This list shows exactly the same detail as will be generated within the Core System to 
process the selection of information for the RelationList program. 
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APPENDICES  

Appendix 1 – Add Application & Modify Application 
 

The Add Application and Modify Application functions set values that will be used throughout 
the Application as it is created.  They are also used to set default values for folders and file 
names. 

The screen for adding a new Application or for modifying an existing Application, are 
virtually identical.  The new Application screen is shown below. 

 

At the top of the screen there is an un-named block that sets the defaults for the 
Application.   

The Application Name and the Short Name must be set in the Add function.  Once set the 
Short Name cannot be altered because it is used to name folders and databases created by 
Enigma as the Application is defined.  

The Logos display in each corner of the Application screens.  The height of the logos is fixed 
but the width can be altered.  Typically the header logo would reflect the client and the 
footer logo the developer. 

Piracy Protection is a purchasable option.  Refer to the Parametric Systems Web Site for 
details. 

The Development Mode allows an Application to be developed in three stages – 

• devl mode is for Net System development.  In this mode the Core System is ignored 
and the Net System formats and navigation can be tested.  Core System data is 
replaced by “?” characters in most fields. 

• test mode allows the Core System to be tested through the Net System.  In this 
mode errors arising in the Core System are reported to the desktop. 

https://parametricsystems.com.au/
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• live mode suppresses the Core System error reporting.  Any errors arising in the Core 
System while in live mode are reported via the Net System.  When in live mode the 
Core System should be compiled for “unattended operation” by VB6.  See 
Project>Properties to request the setting. 

The Net Database Details block contains controlling information for the Net Database.  The 
Net Database Location defaults to the requirements while an Application is being developed 
in Enigma.  When the Development Mode is set to “live” the default can be changed to 
reflect the installation you desire for the New Application.  Log Changes can be set to Y or 
N.  If set to Y then a record will be kept of all Insert, Update or Delete actions affecting the 
Net Database records.  Since these records are changed during Application Development 
this is usually set to N. 

The Core Database Details block contains controlling information for the Core Database.  
The Core Database Location defaults to the requirements while an Application is being 
developed in Enigma.  When the Development Mode is set to “live” the default can be 
changed to reflect the installation you desire for the Application.  Diary and Log Changes 
(refer #6 Activity Recording) can be set to Y or N.  If set to Y then a record will be kept 
of all Insert, Update, Delete , Request and Result actions affecting the Core Database 
records.  This is useful for tracing problems in a running Application. 

The Net System, Screen Defaults allow the setting of the Application screen defaults.  Most 
changes made in this block will be shown in this screen immediately.  The Copyright fields 
change the copyright message shown at the base of all Application screens.  The changed 
message should be shown when mapping the screens. 

The Net System, Field Defaults allow the setting of field colours, button colours, background 
colours, fonts, and so on.  This block will expand as more CSS settings are included in 
Enigma.  Changes made in this block will be shown on this screen immediately. 

The Field Colours and Background Colours are made available in Javascript variables for use 
by Custom Code in ALL Application Programs.  Reference variable - 

• mandColor to get the Mandatory Colour for a field 
• optnColor to get the Optional Colour for a field 
• dispColor to get the Display Only Colour for a field 
• BgrColor1 to get the Background Colour 1 for a field 
• BgrColor2 to get the Background Colour 2 for a field 
• BgrColor3 to get the Background Colour 3 for a field. 

Changes made to the Application settings will be spread automatically to all default 
programs: e.g. Selection List maintenance programs.  After this is done the Application has 
to be reselected before the settings can be re-extracted into the Net System programs or re-
generated into the Net System.   

Similarly the Core System has to be re-extracted and re-installed to apply any changes made 
in the Core Database Details block. 

Screen Formatting note:  

1. The block outlines are created as blank text entries of appropriate height and width.  
Each is formatted as specified in the Embellishments input for “Outline”. 

2. The text apparently displayed over the block delimiter, is a text area with 
“Background” set to Yes.  The background colour defaults to the screen colour and 
masks the block outline. 
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Embellishment 
 

 

After the basic formats are selected, the screen above can be used to provide embellishment 
to the fields within an application.  There are seven columns (at present) each of which 
provides the control settings for the field heading the column. 

Changes within a column will change the heading field immediately.  This allows for 
experimentation since some of the available embellishment is not desirable for some fields.  
The Apply button in each column will apply the settings to all applicable fields in the whole 
application defaults screen. 

• “Shapes: Radius: Absolute” allows the corners of the field to be adjusted to a fixed 
amount.  A value entered into All will set all four corners to the same amount.   

• A value entered into Top will set the top corners and a value in Base will set the 
bottom corners.   

• A value entered into Side will be combined with the All, Top or Base value to provide 
an elliptic corner. 

“Shapes: Radius: Relative” has the same controls to apply to the field but these are a 
percentage of the Top, Left, Bottom or Right side rather than a fixed amount.  This creates 
some very interesting shapes.   

• For example: a field defined as a square will become a circle if All is set to 50.  A 
field defined as a rectangle can become an ellipse. 

• The value for Side in the Absolute or the Relative sections can be combined with Top 
and/or Base values from the other section to provide more variations. 

“Borders: Default” allows the Style of the border, the thickness of the Border, and the 
Borders to be shown to be defined.   

• The thickness of the border can be overridden where a border of zero can be defined 
during screen definition.  If overridden, then no Border will be shown for that data. 

“Border: Colours” allows the Border colour and the Shadow colour to be selected.   

• Note that the Colour selected can affect the displayed Style.   
• The shadow colour can be set to show only when the cursor hovers over it or as a 

static embellishment to the field. 
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“Fields: Hover: Transition” allows the shadow effect to be controlled.   

• The Borders on which to show the shadow can be selected.  If a transition Time is 
specified changing the Shadow Borders will show the transition effect from as the 
field is changed from one border to another.  

• The Time specifies in seconds how long the transition should take before it comes 
into full effect.  Note a time of zero provides the static embellishment.   

• The Size specifies how large the shadow should be.  A Size of Zero will suppress the 
shadow effect and no shadow will be shown.   

• Blur specifies how the shadow should look.  A blur of zero gives a shadow having a 

constant display.  A value in Blur will cause the shadow to fade toward the edges. 

“Opacity?” allows the field to be sharpened or dimmed during Transition.  It works in 
conjunction with the Opacity applied as a default to all fields. 

Embellishment Examples 
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Appendix 2 –An Added Example Application 
 

When Add Application details are recorded, (in Enigma-2020 when a new Application is 
saved) Enigma sets up the basic Application folder containing the skeleton libraries and 
default CSS and programs for the Application. 

When Modify Application details are recorded Enigma recreates the default CSS and 
programs for the Application so that any changes are spread throughout the application. 

This is an early version of the ADD screen for an Example application so that an embryonic 
Application can be described. 

1 Application Defaults (original Enigma and Enigma-2020) 

Folders 
Using the Record button causes Enigma to create a New Application which contains the 
following folders and contents – 

App_Data\Example.sdf is the Net System Database 

Data\Example.sdf is the Core System Database 

Images contains the Logo images that can be displayed in the Header and the Footer 

Shared contains the screen Header and Footer HTML markup. 

The Packages and Bin libraries contain application code that is required to run the New 
Application. 
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Programs and Files 
The Following files are created to start the New Application – 

maintMenu and maintScreen are programs to record the values necessary to display the 
Application Menu and the Application Net System programs when they have been 
generated. 

MenuStyles, ScreenStyles and TableStyles contain the CSS required for standard HTML 
markup in the new Application. 

menuScreen is the default Menu display program. 

selAuthority allows the New Application to apply various levels of access into its programs..   

 

Timeout is the default display if the New Application is open but not used for a period of 15 
minutes. 

index.vbhtml and web.config are files required for Internet access to the New Application.  
They should not be edited.

Databases 
The databases required for the New Application are created by the Add Application function.  
All the Tables are defined and where necessary the Tables are populated with data to suit 
the default programs. 
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Net System Database 

 
AccessLevel: This holds the Security Authorisation levels 

Change_Log: This holds the trace of all Net database changes (if requested) 

Counters: This holds the next values to be used by various Net Database records as Key 
Values.  It should not be edited. 

DBTable: This holds the Table names for TABL definitions 

Location: This holds control information to correlate the Net and the Core Systems 

Menus: This holds the menu structure and text for the New Application 

Parameters: This holds transient data required by the Net System 

ProcessReq: This holds the Net-to-Core transaction that is to be processed 

ProcResult: This holds the Core-to-Net result of processing the transaction 

Screens: This holds the Screen location information for the New Application programs.  

Core System Database

 

Change_Log: This holds the trace of all Core database changes (if requested) 

Counters: This holds the next values to be used by various records as Key Values in the 
Core Database 

Diary: This holds more trace details (if requested)

2 New Application Menu (original Enigma and Enigma-2020) 
 

The New Application has a Menu which can be used to access the Screen and Menu 
maintenance programs and the Authority Level program. 
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The menu entries are – 

• File Contains Exit to close the New Application 
• Application Contains Settings to control the New Application 

o Menus  A program to maintain the Menu table in the Net System 
  database 

o Screens A program to maintain the Screen location for the generated 
Net Application programs 

o Compact and Repair  Maintenance for the Net and/or Core System Databases 
• Access Levels  A program to allow the setting of different Authority levels 
• Selection Lists  This will become a dropdown menu for the programs that 

maintain any Selection Lists defined for the New Application 
• Option Groups  This will become a dropdown menu for the programs that 

maintain any Option Groups defined for the New Application 

3 The Access Levels program (original Enigma and Enigma-2020) 
 

 

The screen displays the three default access levels that are included in the New Application. 
More levels can be added by clicking the New Item button.  This displays blank fields to 
allow new information to be recorded. 
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Use Record to add a new entry to the list or Clear to ignore any entry details you have made 
but not recorded. 

If an entry is selected from the list the fields are filled and can be altered 

 

Use Record to save any changes back into the List.  Cancel will not remove the entry but will 
make it InActive14: i.e. no longer selectable as an Access level.  Inactive entries in the List 
are highlighted and can be Restored to an Active state. 

 

Use Restore to make the entry Active again. 

 

Access Levels can be set for entries in the Main Menu and for Operators.  An Operator with 
a specific Access Level will be able to see Menu entries for that Access Level and all Levels 
lower than that level. 

  

 
14 Within the New Application NO entries within Selection Lists or Option Groups can be physically 
deleted because they may have been used at some point and the value that was recorded at that 

time always has to be translated for display along with the other recorded details. 
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4 The Menu Maintenance program (original Enigma and Enigma-2020) 
 

 

The Menu Maintenance screen displays the menu Entry Levels, the Text to be displayed in 
the Menu, the Authority level assigned to the entry, the Program that will be started if the 
Menu entry is selected and any Control Values that should be passed to the program. 

Menu Levels 
The menu allows for three levels of access – 

• Level 1 runs across the screen 
• Level 2 is a drop down list that is available if Level 1 is clicked or the cursor hovers 

below the Level 1 entry 
• Level 3 is a level that is available sometimes if a Level two entry is clicked or the 

cursor hovers over the Level 2 entry 

Accessing these levels when creating a New Application is described in #Setting the New 
Application Menu Entry  

Menu Text 
The menu text displays on the screen.  If there are errors in the text as entered when 
creating a new Application program it will have to be edited through this facility. 

Authority 
Authority defaults to “Default” when the menu entry is defined.  Use this program to create 
the hierarchy of programs that are accessible to a particular User’s Access Level. 

Program 
This is automatically assigned as the program being created when the Menu entry is defined 
or as “#” if the Menu Entry is intended to provide access to the next higher Menu Level. 

Control Values 
Control Values will be passed to the Program if they are present.  Access “Session(“Parms”)” 
in Custom Code to get the Control Values attached to the Menu Entry.  



Version: 1.6 P a g e  | 151  Released: 19th April 2020 

 

New entries should not need to be made directly into this screen.  However this is the only 
way to connect Control Values or to correct, or rearrange, the New Application menu. 

The Authority selection comes from the Access Levels selection list. 

If an entry is selected it can be edited similarly to the Access Levels.  However in this case if 
Remove is clicked the entry will be DELETED. 
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5 The Screens Maintenance program (original Enigma and Enigma-2020) 
 

 

Screen Maintenance can be used to re-position User Interfaces on the terminal.  However it 
is often better to position the screen using the Screen Mapping facility. 

There are three types of positioning available in Enigma – 

• Screens for Menu selected programs; 

• Screens for Sub-Program programs; 
• Screens for In-Line frame programs. 

Enigma uses the values in Screen Size to allocate space for the Program to display its User 
Interface.  Each program type has its own characteristic defaults and operation. 

• Menu selections will default to location zero, zero on the Menu screen.  This can be 
changed by setting the Display Offset to move the screen horizontally or vertically.  
These programs can have a screen that is larger than the Menu screen 

• Sub-Programs will attempt to display at location zero, zero of a frame which is the 
default screen size.  This can be changed by using the Display Offset.  These screens 
cannot be larger than the Parent Screen.  If they are, then display will be lost from 
the excess dimension.  These screens will mask all screen details in the Parent 
Screen.  

• In-line Frame programs will display at location zero, zero of the Parent Screen.  This 
can be changed by using the Display Offset.  These screens cannot be larger than 
the Parent Screen.  If they are then display will be lost from the excess dimension.  
These screens will mask only the screen display they overwrite in the Parent Program 
and also make all displayed detail in the Parent screen disabled. 

The Display Offset can be positive or negative as suits the requirement. 

The Change Authority is provision for the future and not yet implemented.  It reflects the 
Access Level assigned to an operator and will allow all operators to access all programs but 
will limit data entry to Operators with an Access Level equal or greater than the Change 
Authority set for the program. 
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6 Compact & Repair (original Enigma and Enigma-2020) 
This function allows the Net and Core databases to be maintained.  It will be generated for a 
New Application and will allow either database to – 

• be verified,  
• be repaired,  
• have a new password allocated,  
• have an existing password removed, or,  
• be compacted. 

A similar function is supplied with an installed Enigma system.  This installation will be used 
for explanation of the function.  The difference between installations is that the Enigma 
application has two databases: one containing the data required by Enigma to generate a 
New Application and the other containing the data for Enigma Applications.  Respectively 
these are Enigma Data and Enigma Systems, which correspond to the Core database and 
the Net database. 

The Enigma Data database is a proprietary database that is used by the Enigma system.  It 
is not accessible to the developer except through the Enigma programs.  It has a pre-set 
password that cannot be modified.  The Core System Database for a New Application will be 
created with NO password.  This can be set by the developer or by the end User of a New 
Application using Compact & Repair in the New Application. 

The Enigma Systems Database will contain the data needed by the Enigma System.  To it 
will be added all the data required to generate a New Application.  This database is 
distributed with NO password.  However, a developer can set a password if they wish using 
Compact & Repair. 

The Net System Database for a New Application will be created with NO password.  This can 
be set by the developer or by the end User of a New Application by using Compact & Repair 
in the New Application. 

When Compact & Repair is selected from the Application menu the following screen 
displays: 

 

The first step is to backup the database before any action is taken on it.  Either database 
can be selected, and, when the process for one is complete, the other can be processed if 
necessary.   
 
The backup is stored in the C:\EnigmaSystems\Backup folder or the Enigma Files\Enigma 
\Backup folder with the name “DBNameyyyymmddHHMMss”:  
 e. g. Enigma20180809153324 or Enigma Systems20180810092545. 

Selecting either database will follow the sequence allowing – 

• Backup, 
• Verification of the database, and then. 
• Compaction. 
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If the Verification fails there is a step to cause Repair to be attempted.  If that succeeds, the 
database is backed up again before compaction can be selected. 

The screen will show the progress.  The Enigma Systems side is used for example.  Enigma 
Data would show the same up to this point 

 

A Failed Verification will show: 

 

A Failed Repair will show: 

 

and 

 

However, if all is well, selecting Compact Now provides the fields for Password setting or 
changing. 
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Selecting Yes will show the fields as above.  The Current Password can be left blank if no 
password has been previously set for the Enigma Systems database.  Otherwise the correct 
password must be entered and it cannot be more than 19 characters long. 

The New password must be entered twice and the program will check they are the same.  
The Verify Change button causes the editing to occur. 

If all is correct the database is compacted and the password reset.  If there are errors they 
will be reported and must be corrected before the database can be compacted.  The Close 
button can be used at any point to abandon the process. 

If the No button is selected the password fields do not display and the compaction is done 
immediately. 

If the compaction fails there is a message and Compact & Repair will retrieve the last 
backup made for the database. 

With Enigma Data there is no provision for Password Change and a complete sequence 
shows: 
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Appendix 3 – Generated Programs (original Enigma and Enigma-2020) 
Enigma automatically generates programs to allow maintenance on Selection Lists and 
Option Groups when appropriate selections are made on the Detailed Data Definition screen. 

These programs are very similar to the Access Levels maintenance already described. 

Selection Lists 
The contents of a Selection List have to be entered into the list within the New Application.  
Selecting New Item will provide blank fields into which the information can be entered. 

 

 

The xxxx Name field in the list will be displayed to the User.  On this value the User will 
select from the list when it is included on a mapped screen.  The xxxx Abbreviation is the 
value that will be stored in the Core System database.  The Selection list table always exists 
in the Net System database. 

If a row in the list is selected then a Change Item button becomes available.  Clicking it 
places the data into fields where it can be altered or logically removed from the list. 

Any alteration or addition made to the list will become available immediately after it is 
recorded.   

Any removal from the list will only make that selection hidden from the User.  It becomes 
“Inactive”.  The selection still remains as part of the Selection List so that it can be displayed 
if it has been selected before being removed. 

Records in the list that are Inactive are highlighted when displayed by the maintenance 
program.  They can be restored to “Active” status if the removal turns out to be incorrect. 
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Option Groups 
Option Groups are formed when data is defined to be “Radio Button” in the Detailed Data 
Definition screen. 

 

The Display Example shows the basic organisation of the Option Group.  It can be controlled 
as follows – 

• The colour coding applied due to the Input Status is shown in the Caption for an 
Option Group 

• The format of the options is controlled by the Display Size allocated to the Option 
Group.  If the Display Size is made smaller, then the options will show less in each 
row and more rows will be created.  A larger Display Size will display more in each 
row and perhaps less rows 
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The Options available in the Option Group are maintained by a program similar to the 
Selection List already described.  Options can be added, removed and restored in the same 
way. 

Screen Mapping an Option Group is a matter of trial and error mainly because the format of 
the Option Buttons is dependent upon the size of the text entered for each option.  The text 
will always display after the Option Button and it is the width allowed for the control that 
determines how many options are shown in each row.  To get the most controllable results 
the text for all options in the Option Group should be approximately the same length 

Warning 
Any change to an Option Group will be displayed immediately the change is recorded.  This 
can have unwanted affects within any program using the Option Group and can confuse a 
User considerably since the screen will reformat dynamically to accommodate the change to 
the group. 
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Appendix 4 – Data Definition Alternatives 
 

Selection Value Consequence 

HTML Input Checkbox Changes the Display Example 

  Suppresses the “Selection List” definition 

 Input Default HTML format 

 Radio Button Allows Yes/No selection of “Core Process Request”  

  Requires the definition of an “Option Name” 

  Definition creates a Program in the Application 
Library to maintain the Option List15 

  Definition creates a Table in the Application 
database to hold the Option List alternatives 

  Definition creates an entry in the Application Menu 
to access the maintenance. 

Core Process 
Request 

Yes Causes Core processing to be requested whenever 
the Radio Button alternatives are changed 

 No The Radio Button value can be recorded on the Core 
Database 

Data Type Counter Considered to be an Integer.  This Data will be used 
to provide a unique Key value for the Core System 
Database records. 

 Date (American) American format Date always displayed as 
mm/dd/yyyy.  Always stored as String with format 
yyyymmdd.  Validated to have valid Days and 
Months. 

  Always formatted as three fields with fixed, display 
only, “/” separator characters 

  Auto formatted so that entry of mm/dd/yy (or 
variations e.g. m/d/y) into the Month field will be 
split into three fields. 

  Entry of yy will default to 19yy if yy is greater than 
current year and 20yy otherwise.  Entry of yyyy is 
not reformatted.  Entry of yyy is invalid. 

  Allows the definition of “Date Edit” alternatives. 

 Date (European) European format Date always displayed as 
dd/mm/yyyy.  Always stored as String with format 
yyyymmdd.  Validated to have valid Days and 
Months. 

 
15 The Option alternatives have to be entered into the Net Application using the New Application 

Menu selection that is available after the data is recorded.  
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Selection Value Consequence 

Data Type (cont.)  Always formatted as three fields with fixed, display 
only, “/” separator characters 

  Auto formatted so that entry of dd/mm/yy (or 
variations e.g. d/m/y) into the Days field will be split 
into three fields. 

  Entry of yy will default to 19yy if yy is greater than 
current year and 20yy otherwise.  Entry of yyyy is 
not reformatted. Entry of yyy is invalid 

  Allows the definition of “Date Edit” alternatives. 

 email Edited text string – must contain @ and at least one 
full stop  

 Integer A number with no decimal places.  Do not confuse 
with Counter 

 Lowercase Input Data is always converted into lowercase 
characters. 

 Numeric A number with specified decimal places. 

 Password Protected alpha-numeric characters.  NO special 
characters allowed.   

 Phrase String data that will be formatted to have a leading 
UPPER case character as the first character 

 String Data containing any character – NOT reformatted 

 Text String data that may occupy several lines within a 
Data field. 

 Time Not available at present 

 Timestamp A Core System generated DateTime value as 
yyyymmddhhmmssff in String format 

 UPPER CASE Input data is always converted into Uppercase 
characters 

 Upper Lead Input data is converted into a Leading Uppercase 
format that allows for typical name prefixes such as 
Mc, O’, Hyphenated names. 

Date Edit Partial OK? No. Date cannot contain zero for Days and/or 
Months. 

  Yes. Date can contain zero for Days and/or Months.  
No other Date validation is done. 

 Historic OK? Yes. Date can be before the current date: e.g. a 
Date of Birth. 

  No. Date cannot be before the current date: e.g. an 
Appointment Date. 
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Selection Value Consequence 

Date Edit (cont.) Future OK? Yes. Date can be after the current date: e.g. 
Appointment Date. 

  No. Date cannot be after the current date: e.g. Date 
of Birth. 

Request 
Comparator 

SQL Conditions 
 
=, >, <, >=, 
<=, <> 

The type of comparison to be used if this Data is 
included in a Request (“Req”) transaction.  Can be 
modified when the Transaction is defined.  Contains 
all SQL condition values and most SQL predicate 
values.  Used to control the access of data from the 
Core Database. 

 IN Data must equal one of a list of values 

 LIKE Data must contain the string of characters 

 BETWEEN Data value must be >= lower value and <= higher 
value 

 PARTDATE If the Date can be a Partial Date and the Date 
supplied is a Partial Date then the comparison will be 
extended to include all possible Dates.  See Partial 
OK? Above. 

Data Selected? No The “Selection List” fields remain suppressed 

 Yes Requires a “Selection List” name to be defined 

  If the “Selection List” does not already exist, 
definition of the list creates a Program in the New 
Application Library to maintain the Selection List16 

  If the “Selection List” does not already exist, 
definition of the list creates a Table in the New 
Application Database to hold the Selection List 
alternatives 

  If the “Selection List” does not already exist, 
definition creates an entry in the New Application 
Menu to access the maintenance. 

Data Selected 
(cont.) 

 The Net Data is linked to the list. 

  Default value.  Caption shown for the Data: can 
have two words 

Caption Location Before Caption shown in front of the Data 

 After Caption shown after the Data.   

 Above Caption shown above the Data.  Caption and Data 
are aligned to the left margin. 

 
16 The Selection alternatives have to be entered into the Net Application using the New Application 

Menu selection that is available after the data is recorded. 
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Selection Value Consequence 

Input Status Display Only Data that is displayed to the User but cannot be 
changed and will not be sent to the Core System 

 Input Display Data that has been previously input by the User and 
cannot be changed during this later processing but 
may be sent to the Core System 

 Mandatory Data that must have an input before the Screen will 
be processed. Will be validated and/or formatted 
according to the “Data Type”. 

 Never Input Data that exists in the Core System but is never 
displayed to the User.  It may be made available to 
the Net System. 

 Optional Data that may be entered by the User.  Will be 
validated and/or formatted according to the “Data 
Type” if entered. 

 Password Alphanumeric characters only. No Special characters 
or punctuation is allowed.  Alphabetic characters are 
converted to upper case.  Data input is masked. 

 Sent Only Data that exists in the Net System but is never 
displayed to the User.   

Initial Value No Logic value stored as “N” - False 

 Null Initial value in the Core Database 

 Space Initial value in the Core Database 

 Yes Logic value stored as “Y” - True 

 Zero Initial value in the Core Database 
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Appendix 5 – Transaction Types and Operation 
 

Type Value Direction Purpose Followed By 

Add Add Net-to-Core Add NEW Data to the Core System 
Database 

Res 

Del Delete Net-to-Core Delete Data from the Core System 
Database 

Res 

Enq Enquiry Net-to-Core Enquire for Data from the Core System 
Database.  Identical to “Req” below 

Prov or List 

Expt External 
Access 

Net-to-
Program 

Provide Data to an External Program 
and Start its operation NOT 
IMPLEMENTED AT PRESENT  

Impt or Add, 
Mod, Del or 
End Program 

Init Initiate  Get Data input from the User for use in 
the next Program 

Next Program 

Impt External 
Access 

Program-to-
Net 

Get Data provided by an External 
Program NOT IMPLEMENTED AT 
PRESENT  

Add, Mod, Del 
or End Program 

List List Core-to-Net Get repetitive Data from the Core 
Database 

Nothing or Req 

Load Load  Load “Tabl” data from the Net 
Database for internal use by the Net 
System 

Nothing 

Locl Local  Display Data that is already known17 to 
the Net System 

Nothing 

Mod Modify Net-to-Core Change Data on the Core Database Res 

Proc Process Net-to-Core Get the Core Program to execute some 
Process based upon the supplied Data.  
NOT IMPLEMENTED AT PRESENT. 

Res 

Prov Provide Core-to-Net Get Data provided by the Core Program 
for use by the Net Program 

Add, Mod or 
Del 

Res Result Core-to-Net Result of the Core Program process End Program or 
Error Display 

Req Request Net-to-Core Request for Data to be supplied from 
the Core Database. Identical to “Enq” 
above 

Prov or List 

Tabl Tabulate  Record Data for use by the “Load” 
transaction 

End Program 

 
17 The concept of data being “known” to the Net Application is covered in section #USING A 
PROGRAM (What Happens to the Values) 
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Appendix 6– Sample Reports 
 

Sample Net to Core Trace Report 
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Sample Program Chart Report 
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Sample Data Chart Report 
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Sample Data Chart Report (Cont.) 
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Sample Check Add Records Report (composite) 
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This report is used to check that ADD transactions will process as expected. (For Enigma-2020 the Record Action is shown.) 

The first two lines of the report show the Program being documented and the Transactions in the Program.  There is no documentation of any 
Result (RES) transaction. 

The left hand column shows the Request transaction.  The Request should provide enough Key fields to allow Enigma to access the database.   
It also shows any Search details (Constants and Comparators) that have been recorded for this transaction in this program.  However, being 
an ADD process limiting the Search is illogical. 

The Database Table column shows complete details of all of the Tables that will be accessed while processing the Request.  The Key and 
Create details show what will happen when this ADD transaction is processed.  Since ADD is to create new records then every Table listed will 
have a new record inserted.  Where the Key is shown to be created Enigma will provide a unique numeric Key.  Where the key is shown as 
NOT created a value will have to be supplied in the ADD transaction: see NameType above. 

The Transaction FROM Core column shows the data that will be sent into the Net program.  This is the information that can be displayed to the 
User or otherwise processed by the Net Program.  Neither the NameType, nor NameLink, data is available to the Net program. 
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The Transaction TO Core column shows the data that will be recorded on the Database.  Any values that are being supplied as Constants in 
this transaction are shown in the Const. field.  Note that not all the data in some tables will be available for recording and that a Constant has 
been supplied to provide part of the Key for the NameType table and also for the Role in the ApplPeople table. 
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Sample Check Change Records Report (MOD) 
 

 
 

This is the Check Data Change report for a program called AgentMod. (For Enigma-2020 the Change Action is shown.) 

Note that although the Transaction FROM Core includes the link between the Agent and an Application, the link is not updated.  Only the data 
that is attached by the link is changed. 
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Sample Check Change Records Report (DEL) 
 

 

This is the Check Data Deletion report for a program called NextOfKinDisc. (For Enigma-2020 the Cancel Action is shown.) 

It comes from an Application that uses History mode for the database.  Consequently the information supplied in the Transaction TO Core 
limits the database change to disconnecting the ApplPeople link for this Next of Kin. 
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Sample Check Data Selection Report (Composite) 
 

 
 
This is the Check Data Selection report for a program called SelectRelation.  
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It shows the Request Transaction data and the List Transaction data.  (For Enigma-2020 the Show Action is shown.)  Following, on the left is a 
précis of the SQL select statement to access the required records.  It shows the comparators that will be applied and indicates the values to be 
used.   

• {net data value} – The data value contained in the request transaction 
• {link value} – The value accessed from the Link table 
• {missing value} – A value that cannot be located by Enigma 
• Text value – Constants that have been specified to apply to this search of the database. 

On the Right is a list showing which data is derived from which tables.  Also on the right is a note that “Score” is required but not available 
from the database.  Score is internally generated as part of the Data selection.  If anything else is listed here, it is data that cannot be located 
because the Request transaction is imprecise relative to the Database definition. 
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Appendix 7– Desktop Access to the New Application 
 

Testing of the New Application can be done using access from the Desktop.  Creation of this 
is similar to the access that had to be created to get desktop access to the Enigma system.  
These notes use Internet Explorer but other browsers can be substituted. 

1 Setting up the .bat file 
There is a technical problem in using the Control Panel to set the Site and Application Pool 
entries required for desktop access through a shortcut.  The Windows Control Panel sets 
these values in the IIS Express applicationHost.config file.  However Internet Explorer uses 
the IIS applicationHost.config file.  Consequently any changes made through the Control 
Panel are unavailable to Internet Explorer and probably to other browsers as well. 

To overcome this there are three .bat files and one VB6 program installed with Enigma in 
the C:\EnigmaFiles\Batch\ and C:\EnigmaFiles\LoadHost folder.  You will need Administrator 
access to run these procedures. 

UpdateHostConfig.bat 
This file should be run to include your application in the applicationHost.config file.  It runs 
the other .bat files and the .exe to make the addition required.  The instruction to run 
LoadHost.exe has to be edited to suit your application. 

Double click the entry to run the .bat file.  The .bat file does not notify its completion. 

GetConfig.bat 
This .bat file makes a backup copy and a working copy of applicationHost.config.  These 
copies are placed into C:\Enigma\backup\ and C:\Enigma\work\ respectively. 

LoadHost.exe 
This program will create an application pool for your application to operate in and a Web 
Site that can be located by Internet Explorer.  The control line for the program must contain 
{Name}, {Port} where Name is the Short Name you allocated to your development and Port 
is the Port Number you wish to use for access.  To avoid conflicts it is suggested that the 
Port Number should be above 10000.  It must be less than 65535.  Don’t forget to include 
the comma in the control line to separate the parameters. 

The Application Pool created by HostConfig.exe will refer to C:\EnigmaSystems\{Name}\ 
which is where Enigma has placed the generated Net programs for your application. 

StoreConfig.bat 
This .bat file moves the changed applicationHost.config file back to overwrite the original 
file. 

Malfunctions 
There should be no malfunctions when running UpdateHostConfig.bat.  However if any of 
the copies, or directory creations, do not succeed, an error screen will display.  If this should 
occur please respond with [ctrl]+C and then respond with Y to cancel the procedure. 
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2 Creating the Desktop Shortcut 
 

On the Desktop right click the background 

Select New and the Shortcut 

 

In the screen - 

• Type the location as C:\Program Files (x86)\Internet Explorer\iexplore.exe  
• Select next 

 

• Type a Name for the shortcut 
o The short name for the new Application would be suitable. 

• Select Finish 
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Right click the new Shortcut and select Properties 

 

At the end of the Target detail - 

• Enter space followed by “http://localhost:{port}/” where port is the number 
you assigned to the Web Site; 

• Change the Icon to suit yourself or stay with the default browser icon; 
• Select OK to record. 

 

  

http://localhost:%7bport%7d/
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Appendix 8 – Ranking List Results 
  

 
SCORE – LOGIC 

 

1. Score can be included in any LIST transaction.  It is a reserved word that causes the 
retrieved records to be ranked into order with the most likely candidate records 
being given the highest ranking. 
 

2. Score is calculated by - 
 

a. Counting the number of search data being used in the WHERE and JOIN 
clauses in the SQL used to extract the list.  

b. Dividing 100 by the count 
c. Converting the result into an integer 
d. Allocating the Integer to each search data 
e. Multiplying the integer by the count 
f. If the multiplication is not equal to 100 – 

i. Subtract the multiplication from 100 
ii. Allocate one more to as many search data as are required bring the 

subtraction result to zero 
g. This creates the Full Score that applies to all data retrieved by an un-rotated 

request 
 

3. Where rotation is requested – 
a. The Full Score is applied to the data retrieved by the search values 
b. Two thirds of the Full Score is applied to data retrieved by a rotated search 

value. This is the Rotated Score. 
c. Rotation will regularly cause an initial search value to be applied in 

conjunction with rotated search values.   
 

4. Compare the value retrieved to the value supplied as the search value for the data 
 

a. If the values are the same, add the Full Score for the search data to the 
score 

b. If value retrieved contains the value supplied, add one half of the Full Score 
or Rotated Score to the score 

c. If the values are completely different add zero to the score 
 

5. Defaults applied to Comparator values – 
 

a. Where the comparator causes SQL to locate specific values, treat all 
comparisons as equal. This applies to =, >=, <=, <>, >, <, IN(….), 
BETWEEN(x, y), PARTDATE 

b. Where the comparator causes SQL to locate approximate values add integer 
according to 4a and 4b.  This applies to LIKE 
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LIST RECORD RANKING - CALCULATION 

SEARCH 
CONDITION 

DATA VALUE COND. ROTATED SCORE 

Specified 

Not Equal 
Search Value 

Not LIKE 
Yes ((Full Score * 2) / 3) 

No Illogical – Zero Score 

LIKE 
Yes ((Full Score * 2) / 3) / 2 

No Full Score / 2 

Equal Search Value Full Score 

Default Full Score 

 

RANKING LOGIC 

1. The SQL search will only retrieve a record where a Data Value is NOT EQUAL to the 
Search value when the CONDITION controlling the search is LIKE. 
 

2. If the retrieved Data Value is NOT EQUAL to the Search Value AND the CONDITION 
is NOT EQUAL to  LIKE then the Data Value must have been retrieved by being 
EQUAL to one of the ROTATED Values used in an OR clause. 
 

ADD the Rotated Score. 
 

3. If the retrieved Data Value is NOT EQUAL to the Search Value AND the CONDITION 
is EQUAL to LIKE then the Search Value must be INCLUDED in the Data Value.   
 

ADD one half of the Rotated or Full score 
 

4. If the retrieved Data Value is EQUAL to the Search Value 
 

ADD the Full Score 

 

5. Since a retrieved record satisfying ALL the CONDITIONS generated for the SQL 
search must score 100 AND since there is no requirement for ALL the CONDITIONS 
to have a specified Search Value, ANY CONDITION that has a DEFAULT Search Value 
must score as satisfying the CONDITION. 
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RECORD SELECTION – SIMPLE WHERE CLAUSE 

TABLE REQUEST VALUE SOURCE VALUE SELECTION ORDER WHERE CLAUSE 

Column1 
Included 

Supplied 
By 

Designer Value 
Yes Always Used 

First Column 
with value 

WHERE Column1 {cond} Value1 
No Use User Input 

User Input 
Mandatory Used 

Optional Ignored if = Default 

Default Exclude from WHERE Clause 

Excluded 

Column2 
Included 

Supplied 
By 

Designer Value 
Yes Always Used 

Next Column 
with value 

AND Column2 {cond} Value2 
No Use User Input 

User Input 
Mandatory Used 

Optional Ignored if = Default 

Default Exclude from WHERE Clause 

Excluded 

Column3 
Included 

Supplied 
By 

Designer Value 
Yes Always Used 

Next Column 
with value 

AND Column3 {cond} Value3 
No Use User Input 

User Input 
Mandatory Used 

Optional Ignored if = Default 

Default Exclude from WHERE Clause 

Excluded 
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ColumnX 
Included 

Supplied 
By 

Designer Value 
Yes Always Used 

Last Column 
with value 

AND ColumnX {cond} ValueX 
No Use User Input 

User Input 
Mandatory Used 

Optional Ignored if = Default 

Default Exclude from WHERE Clause 

Excluded 
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RECORD SELECTION – ROTATED WHERE CLAUSE 

TABLE REQUEST VALUE SELECTION ORDER ROTATED WHERE CLAUSE 

Column1 Included 

Yes Always Used 
First 
Column 
with Value  

Yes 
WHERE Column1 
{cond} Value1 

OR Column3 {cond} Value1 
OR ColumnX{cond} Value1 

Mandatory Maybe Used 

Optional 
Value 

Default Exclude from WHERE Clause 

Column2 Included 

Yes Always Used 
Next 
Column 
with value 

No 
AND Column2 {cond} 
Value2 

 Mandatory Maybe Used 

Optional 
Value 

Default Exclude from WHERE Clause 

Column3 Included 

Yes Always Used 
Next 
Column 
with Value  

Yes 
AND Column3 {cond} 
Value3 

OR Column1{cond} Value3 
OR ColumnX{cond} Value3 

Mandatory Maybe Used 

Optional 
Value 

Default Exclude from WHERE Clause 

 

ColumnX Included 

Yes Always Used 
Last 
Column 
with Value 

Yes AND ColumnX {cond}  
ValueX 

OR Column1 {cond} ValueX 
OR Column3 {cond} ValueX 

Mandatory Maybe Used 

Optional 
Value 

Default Exclude from WHERE Clause 
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Appendix 9  –  Business Rules Application 
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Appendix 10  –  Application Implementation 
 

 

An Enigma created Application design is structured to provide the maximum security 
possible to protect the database content.   The design is called Net2Core. 

The diagram on the next page shows the structure and it follows the usual convention of left 
to right and up and down sequence.  However it is easier to describe if detailed in the 
reverse manner.  The security advantages of each part of the structure are described below 
starting with the target being protected.  Implementation of a new Application can take 
advantage of the security or ignore it. 

Application Server (lower right) 
 

This is the existing, or new, Application server and it remains totally isolated from the 
Minimum Internet Zone.  It does not have an internet IP Address and should not share an 
environment with any server that does have an internet IP Address. 

Net2Core Zone (top right) 
 

This is the heart of the Application Database protection.  It contains three parts and 
performs all the functions required to execute an Internet process. 

1. Net Process – This is the ONLY interface to the Internet used while using the 
application.  It must have a unique IP address. 

2. Core Process – This is the ONLY part of the application that accesses the Application 
Database.  It must not have an IP Address. 

3. Connection Database – This records the details of the request and the details of the 
answer provided (the process).  The request details are received by the Net Process 
from the Internet User and recorded on the Connection database.  The request is 
read by the Core Process and the answer then recorded on the Connection database.   

The Net Process then takes the answer and passes it back to the Internet User. The Net 
Process provides the control over the above sequence using the Synchronisation 
communication.  This synchronisation alerts the Core Process that there is a process to be 
actioned and alerts the Net Process when there is an answer waiting on the Communication 
database. 

Server 2 and Server 3 are both contained within the Net2Core Zone.  They can be combined 
but that is very strongly discouraged.  Similarly, the Core Process could exist within the 
Application Server and Server 3 be dispensed with completely.  In that case the Connection 
Database should exist within the Server 2 environment. 

Minimum Internet Zone (top left) 
 

This outline includes the absolute minimum inclusions to allow operation of the Application 
via the Internet.  Within it Server 1 and Server 2 must exist.  However Server 1 and Server 2 
can be combined, but this is not recommended. 
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The Access Cycle (middle left) 
 

This cycle is first level of Security actioned by the Application Design.  It operates as follows 
-  

• The Internet User accesses an Existing Webpage which is desirably publically 
accessible and commonly used to provided information on available services.  There 
is nothing special about this Webpage except that it provides the ONLY initial 
connection the Net Process.  This connection would be made by clicking on a button, 
or a text box, on the screen.  This would have to be added to the existing Webpage 
content.  This Webpage should have its own IP Address. 

• The click causes the Internet User to be redirected to the Net Process IP Address. 
• The Net Process “knows” the source (URL) of the transfer and any access not 

coming from that source is summarily rejected.  Acceptable access causes the Net 
Process to respond DIRECTLY to the Internet User with the Webpage containing the 
instructions and input areas for the Application to begin. 

• Because the Access Cycle accepts an empty request and validates its source, it 
frustrates attempts at “robot” (effectively, trial and error) access into the system.  
Nothing hurts a robot more than always getting a response and having to start again 
if the response shows an error has occurred. 

Other Security Features 
 

The Access Cycle is the first of many security features in the Possible Design.  The others 
are – 

• The total isolation of the Application Database and the Application from any Internet 
process; 

• The Net Process only containing code to record the necessary details for a process; 
• The Net Process having a unique IP Address; 
• All programs within the Internet Process are hidden from Search Engines such as 

Google or Bing.  The only Search Engine reference to the application should be to 
the Existing Webpage; 

• The need for synchronisation between the Net Process and the Core Process.  If a 
hacker gets into the Core Process to operate it, there has to be a record on the 
Connection Database along with a synchronised request to activate the Core Process; 

• The Core Process deletes requests from the Connection Database as soon as it has 
received them for processing.  This very short period makes a hacker’s job much 
harder since the record formats exist for a transient time; 

• The Core Process is not active in its server until it is called by a Synchronisation 
request from the Net Process.  The Core Process terminates (unloads) as soon as the 
Answer is recorded on the Communication Database and the message has been sent 
to the Net Process to notify the availability of the answer.  The Core process is 
available to the hacker for fractions of a second; 

• The Core Process is compiled code.  This is much harder to decipher than 
interpretive code; 

• The Core process ONLY responds to “well formed” requests.  It may produce 
technical error messages but more often does nothing if the request does not 
conform to the specified requirement; 
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• The various databases and communication paths can be supplied using – 
o Direct access – The Database resides as part of the same Server that 

contains the process.  Similarly the various processes may reside in the same 
Server but, as has been stated earlier, this is discouraged 

o LAN access  – Any part can be connected to any other this way 
o WAN access – Similarly any part may be connected to any other in this way; 

The use of LAN and WAN access is encouraged.  All that is required is that one part 
can reference the next part.  This also makes a hacker’s access more difficult since 
there are more boundaries to negotiate than is normally the case. 

Another Consideration (the Input requirement) 
 

Access through the Internet can be done by anyone at any time.   That creates a situation 
known as “Open Access”.  The requirements of the work to be done may preclude any 
registration of the Internet User and may preclude the use of IDs and Passwords as security 
features. 

The Application should not provide answers unless there is some certainty that the process 
being requested is legitimate.  Depending upon the Application requirements there may be 
registrations of IDs and passwords to legitimise access.  This access may be combined with 
open access to information.  This depends entirely on the requirements of the Application 
which is something that exists within the design 
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Screen Mapping ........................ 87, 92 
Search Criteria ................................ 95 
Search Rotation ............................... 98 
Search Using ................................... 96 
Search Values ................................. 97 
Searching for Content ...................... 94 
Selection Logic ................................ 89 

List Ranking 
Calculation .................................... 173 
Logic ............................................ 172 

Logic .............................. See also; Tables 
Application .................................... 104 
Comparator .............................. 29, 155 
Decision Table ............................... 104 
Definition ...................................... 105 
In Enigma ..................................... 101 
Javascript - getp() ......................... 107 
Javascript - pmit() ......................... 109 
Javascript - timl() .......................... 108 
Permitted Value ............................. 109 
Simple .......................................... 107 
Table Access ................................. 107 
Time Based ................................... 108 

Menu Maintenance ............................ 144 
Navigation 

List Selection ................................... 89 
Net Code Generation ........................... 16 
Net Database .................................... 135 
Net Program 

Creation ............................ 56, 58, 187 
Option Group 

Alternative ............................... 27, 153 
Formatting .............................. 31, 151 
Warning ...................................... 152 

Piracy Protection ............................... 134 
Program 

Code Sample ................................. 115 
Control Values ............................... 144 
Creation ..........................................16 
Definition .................................. 15, 41 
Reviewing ..................................... 113 
Structure .........................................79 

Replication 
Programs ........................................81 
Screen Maps ....................................82 
Similar Transactions .........................81 
Transactions ............................ 80, 187 

Reports 
Add/Record ................................... 162 
Check Add ........................ 40, 100, 131 
Check Change ....................... 100, 132 
Check Data Selection ...................... 133 
Data Chart ............................ 128, 160 
Data Selection ............................... 167 
Data Trace .................................... 158 
Delete/Remove .............................. 166 
Modify/Change .............................. 165 
Net to Core Trace .......................... 127 
Program Chart ....................... 128, 159 
Program List .................................. 129 
SQL Checking ................................ 130 

Request Comparator .................... 29, 155 
Reserved Words ..................................26 

{Table}xxx ......................................26 
Age.................................................26 
Chart ..............................................26 
Count..............................................26 
List ........................................... 26, 94 
Score ..............................................26 
TRecd ..................................... 26, 125 

Screen Definition .................................16 
Screen Display 

In-line Frame ................................. 146 
Menu selection .............................. 146 
Sub-Program ................................. 146 

Screen Mapping............................. 43, 56 
Data List .........................................47 
Data Mapping ..................................48 
Drag and Drop .................................55 
Fixed Text .......................................45 
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Custom Code 

Core Program ........................ 117 
Net Program .......................... 113 
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Report Selection ............................ 127 
Screen Definition .............................55 
Screen Mapping ......................... 43, 56 
Search Criteria 

Static (Fixed) Value ......................98 
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Revision List 

Version: 1.0:  Released: 27 July 2018 

Details: Initial Documentation 

Version: 1.1:  Released: 10 September, 2018 

Details: Added this Revision List 

 Added # to prefix Cross References 

 Expanded the discussion on #2 Search Criteria 

 Changed the method for the #Data Chart report 

 Added note on candidate Transactions for Replication: see #Replicate 
Transactions  Added details on #7 Core Database Operation 

 Expanded the Index to the User Guide 

 Added #6 Compact & Repair section 

 Added #Appendix 7– Desktop Access to the New Application 

Version: 1.2:  Released: 2nd April, 2019 

Details: Changed #The GoTo Control to show the number of indexing characters  

 Added Phrase Data Formatting to format phrase with leading uppercase 

 Added #Data Formatting to apply to email type data 

 Added #1 Javascript edit function 

 Added #1 Javascript edit function 

 Added Backspace protection to Button definitions 

 Added Backspace protection to Select statements 

 Added #Drag and Drop to Screen Mapping 

 Added #Installing the VB6 Suite on VB6 installation 

 Added #Packaging the Core System in Core Program packaging 

 Added #12 Core Database Changes – Enigma-2020 

Table generation is a destructive process.  If the Data recorded in the table is to 
be preserved use Generation > Schema > Select Schema to access the list of 
Database Tables defined for the Application or use Generation > Schema > All 
Schema to generate all the Database Tables in the Application. 

All of the following instructions apply. 

12 Core Database Changes to Schemas 

Version: 1.3:  Released: 23rd April, 2019 

Details: Removed Core Data Name duplication in #11a Core Database Creation – 
Enigma-2020 

With Enigma-2020 use Generation > Tables > Select Table to access the list 
of Database Tables defined for the Application or use Generation > Tables > 
All Tables to generate all the Database Tables in the Application. 

All of the following instructions apply. 

11b Core Database Creation  

 Added #Image Display and # 

Image Mapping  Added Data Entry Ruleswrapped Caption if the Caption contain a space – see 
#Data Entry Rules   Minor “bug” corrections 

 Balanced Application Generation overload monitoring 

Version: 1.4:  Released: 10th July, 2019 

Details: Added # 

Embellishment to the display of fields within the screens  Suppressed Decimal Places input except for the Numeric data type 

 Added Edit for number of Decimal Places 

 Added note on # 

Reserved Words 

Version: 1.5:  Released: 12th November, 2019 

 Added Optional Message if Search Criteria return NO records: see #List Selection 

 Added Scoring and Ranking of selected records: see #2 Special List Definitions 

 Added details on the Scoring and Ranking logic: see #Appendix 8 – Ranking List 
Results  Miscellaneous text corrections 

 Expanded details on #Reserved Words 

Reserved Words 

 Added notes on the AutoComplete function 

 Expanded notes on Transactions and their use: see # 

5 Transaction content 
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Version: 1.6:  Released 19th April, 2021 

 Manual revised to include Version 2 (ENIGMA-2020) information 

 Automation of Business Rules:see #1a Applying Business Rules - Enigma-
2020   

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

 


